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Introduction

Microsoft C/C++ includes a full set of development tools—editor, compiler, link-
er, debugger, and browser—for writing, compiling, and debugging your programs.
You can work within the Microsoft Programmer’s WorkBench (PWB) integrated
environment, or you can use the tools separately to develop your programs.

Environment and Tools describes the following development tools:

= The Programmer’s WorkBench (PWB). PWB is a comprehensive tool for appli-
cation development. Within its environment is everything you need to create,
build, browse, and debug your programs. Its macro language gives you control
over not only editing but also build operations and other PWB functions.

= The Microsoft CodeView debugger. This is a diagnostic tool for finding errors
in your programs. Two versions of CodeView are described: one for DOS pro-
grams and one for Microsoft Windows. Each CodeView version has specialized
commands for its operating environment, as well as other commands for exam-
ining code and data, setting breakpoints, and controlling your program’s
execution.

® CL, the Microsoft C/C++ Compiler. CL compiles and links your source code.

= LINK, the Microsoft Segmented Executable Linker. The linker combines object
files and libraries into an executable file, either an application or a dynamic-link
library (DLL).

= EXEHDR, the Microsoft EXE File Header Utility. EXEHDR displays and mod-
ifies the contents of an executable-file header.

= NMAKE, the Microsoft Program Maintenance Utility. NMAKE simplifies pro-
ject maintenance. Once you specify which project files depend on others, you
can use NMAKE to automatically execute the commands that will update your
project when any file has changed.

= LIB, the Microsoft Library Manager. LIB creates and maintains standard librar-
ies. With LIB, you can create a library file and add, delete, and replace modules.

= HELPMAKE, the Microsoft Help File Maintenance Utility. HELPMAKE
creates and maintains Help files. You can use HELPMAKE to create a Help file
or to customize the Microsoft Help files.

= BSCMAKE, the Microsoft Browser Database Maintenance Utility, and
SBRPACK, the Microsoft Browse Information Compactor. BSCMAKE creates
browser files for use with the PWB Source Browser. SBRPACK compresses
the files that are used by BSCMAKE.
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Environment and Tools also describes these special purpose utilities:

= CVPACK, the Microsoft Debugging Information Compactor. CVPACK com-
presses the size of debugging information in an executable file.

= IMPLIB, the Microsoft Import Library Manager. IMPLIB creates an import
library that resolves external references from a Windows application to a DLL.

= RM, the Microsoft File Removal Utility; UNDEL, the Microsoft File Undelete
Utility; and EXP, the Microsoft File Expunge Utility. These utilities manage,
delete, and recover backup files.

Scope and Organization of This Book

This book has five parts and five appendixes to give you complete information
about PWB, CodeView, CL, and the utilities included with C/C++.

Part 1 is a brief PWB tutorial and comprehensive reference. The first three chap-
ters introduce PWB and provide a tutorial that describes the features of the inte-
grated environment and how to use them. Chapters 4, 5, and 6 contain detailed
information on the interface, advanced PWB techniques, and customization. Chap-
ter 7 contains a complete reference to PWB’s default keys and all functions, prede-
fined macros, and switches.

Part 2 provides full information on the Microsoft CodeView debugger. Chapter 8
tells how to prepare programs for debugging, how to start CodeView, and how to
customize CodeView’s interface and memory usage. Chapter 9 describes the en-
vironment, including the CodeView menu commands and the format and use of
each CodeView window. Chapter 10 explains how to use expressions, including
the C and C++ expression evaluators. Chapter 11 describes techniques for debug-
ging Windows programs and p-code. Chapter 12 contains a complete reference to
CodeView commands.

The chapters in Parts 3 and 4 describe the compiler and utilities. These chapters
are principally for command-line users. Even if you’re using PWB, however, you
may find the detailed information in Parts 3 and 4 helpful for a better under-
standing of how each tool contributes to the program development process.

Part 3 provides information about compiling and linking your program. Chapter
13 describes the command-line syntax and options for the CL compiler. LINK
command-line syntax and options are covered in Chapter 14. Chapter 15 describes
how to overlay a DOS program. The contents and use of module-definition files
are explained in Chapter 16. Chapter 17 describes how to use EXEHDR to ex-
amine the file header of a program.

Part 4 presents the other utilities. NMAKE, the utility for automating project man-
agement, is described in Chapter 18. Chapter 19 covers LIB, the utility to use in
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managing standard libraries. Procedures for using HELPMAKE to create and
maintain Help files are in Chapter 20. The tools for creating a browser database
are discussed in Chapter 21. Finally, Chapter 22 describes how to use the follow-
ing special purpose utilities: CVPACK, IMPLIB, RM, UNDEL, and EXP.

Part 5 presents the Microsoft Advisor Help system and the QuickHelp program. It
describes the structure of the Help files, how to navigate through the Help system,
and how to manage Help files.

The appendixes provide supplementary information. Appendix A describes regu-
lar expressions for use in PWB and CodeView. Appendix B explains a procedure
for getting the decorated name of a C++ function. Appendix C lists United States
ASCII codes, Appendix D lists multilingual ASCII codes, and Appendix E lists
key codes.

Document Conventions

This book uses the following typographic conventions:

Examples Description
README.TXT, COPY, Uppercase (capital) letters indicate filenames, DOS com-
LINK, /CO mands, and the commands to run the tools. Uppercase is

also used for command-line options, unless the option
must be lowercase.

printf, IMPORT Bold letters indicate keywords, library functions, re-
served words, and CodeView commands. Keywords are
required unless enclosed in double brackets as explained

below.
expression Words in italic are placeholders for information that you
must supply (for example, a function argument).
[[option]| Items inside double square brackets are optional.
{choicel | choice2} Braces and a vertical bar indicate a choice between two

or more items. You must choose one of the items unless
all the items are also enclosed in double square brackets.

CL ONE.C TwO0.C This font is used for program examples, user input, pro-
gram output, and error messages within the text.
Repeating elements... Three horizontal dots following an item indicate that
more items having the same form may follow.
while( ) Three vertical dots following a line of code indicate that
{ part of the example program has intentionally been
omitted.
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F1, ALT+A

Arg Meta Delete
(ALT+A ALT+A SHIFT+DEL)

“defined term”

dynamic-link library (DLL)

Small capital letters indicate the names of keys and key
sequences, such as ENTER and CTRL+C. A plus (+) in-
dicates a combination of keys. For example, CTRL+E
means to hold down the CTRL key while pressing the

E key.

The cursor-movement keys on the numeric keypad are
called ARROW keys. Individual ARROW keys are referred
to by the direction of the arrow on the top of the key
(LEFT, RIGHT, UP, DOWN). Other keys are referred to by
the name on the top of the key (PGUP, PGDN).

A bold series of names followed by a series of keys indi-
cates a sequence of PWB functions that you can use in a
macro definition, type in a dialog box, or execute direct-
ly by pressing the sequence of keys. In this book, these
keys are the default keys for the corresponding func-
tions. Some functions are not assigned to a key, and the
word “Unassigned” appears in the place of a key. In
PWB Help, the current key that is assigned to the func-
tion is shown.

Quotation marks usually indicate a new term defined in
the text.

Acronyms are usually spelled out the first time they are
used.









Introducing the Programmer’s
WorkBench

The Microsoft Programmer’s WorkBench (PWB) is a powerful tool for applica-
tion development. PWB combines the following features:

= A full-featured programmer’s text editor.

®  An extensible “build engine” which allows you to compile and link your pro-
grams using the PWB environment. The build engine can be extended to sup-
port any programming tool.

»  Error-message browsing. Once a build completes, you can step through the
build messages, fixing errors in your source programs.

® A Source Browser. When working with large systems, it is often difficult to
remember where program symbols are accessed and defined. The Source
Browser maintains a database that allows you to go quickly to where a given
variable, function, type, class, or macro is defined or referenced.

®  An extensible Help system. The Microsoft Advisor Help system provides a
complete reference on using PWB, your programming language, and the other
components of Microsoft C/C++. You can also write new Help files and seam-
lessly integrate them into the Help system to document your own library
routines or naming conventions.

® A macro language that can control editing functions, program builds, and other
PWB operations.

For increased flexibility, you can write extensions to PWB. These extensions can
perform tasks that are inconvenient in the PWB macro language. For example, you
can write extensions to perform file translations, source-code formatting, text justi-
fication, and so on. As with the macro language, PWB extensions have full access
to most PWB capabilities. For information about how to write PWB extensions,
see the Microsoft Advisor Help system (choose “PWB Extensions” from the main
Help table of contents).
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1.1 What'’s in Part 1

This part of the book introduces you to the fundamentals of PWB. Chapter 2,
“Quick Start,” shows you how to use the PWB editor and build a simple single-
module program from PWB. Chapter 3, “Managing Multimodule Programs,” ex-
pands upon the information you learned in Chapter 2. It teaches you how to build
a more complicated program that consists of several modules. You should be able
to work through these two chapters in less than three hours.

As you work through these chapters, you may want to refer to Chapter 4, “User
Interface Details,” which explains options for starting PWB, briefly describes all
of the menu commands, and summarizes how menus and dialog boxes work. The
user interface information is presented in one chapter for easy access.

Chapter 5, “Advanced PWB Techniques,” shows how to use the PWB search
facilities (including searching with regular expressions), how to use the Source
Browser, how to execute functions and macros, and how to write PWB macros.

Chapter 6, “Customizing PWB,” describes how to redefine key assignments,
change PWB settings, add commands to the PWB menu, and use the TOOLS.INI
initialization file to store startup and configuration information for PWB.

Chapter 7, “PWB Reference,” contains an alphabetical reference to PWB menus,
keys, functions, predefined macros, and switches. It contains the essential informa-
tion you need to know to take the greatest advantage of PWB’s richly customiz-
able environment.

Chapters 4 and 5 are not as tutorial as Chapters 2 and 3. Chapters 6 and 7 describe
advanced features that you probably don’t need to learn right away. You may want
to come back to these chapters after you are comfortable with PWB.

1.2 Using the Tutorial

You probably want to get right to work with Microsoft C/C++. The tutorial chap-
ters 2 and 3 can help you become productive very quickly. To get the most out of
this material, here are a few recommendations:

= Follow the steps presented in the tutorial. It is always tempting to explore the
system and find out more about the product through independent research. How-
ever, just as programming requires an orderly sequence of steps, some aspects
of PWB also require sequenced actions.

= If you complete a step and something seems wrong—for example, if your
screen doesn’t match what is in the book—back up and try to find out what’s
wrong. Troubleshooting tips will help you take corrective actions.



Introducing the Programmer’s WorkBench 7

= When working through this tutorial, consider how you might use these tech-
niques in your own work. PWB is like a full tool chest. You probably won’t
learn (or even want to learn) all of PWB’s capabilities right away. But as time
goes on, you’ll have uses for many of the tools you don’t use immediately.

Conventions in the Tutorial

Tips like this
are useful tidbits of
information, such as
a keyboard shortcut.

To help you move through the tutorial quickly, there are two navigation aids: the
tip and the procedure heading.

Tips
Information that is handy but not essential is included in the left margin. Tips offer
additional information to help you make the most efficient use of PWB. They

should not be confused with margin summaries, which appear in other sections of
this book and are used to summarize information presented in the text.

Procedure Headings

Procedure headings are denoted by a triangular symbol. These headings always
precede a list of steps. For example:

To open a file:

1. From the File menu, choose Open.
PWB displays the Open File dialog box.
2. In the File List list box, select the file that you want to open.
3. Choose OK.
In procedures, the heading gives you a capsule summary of what the steps will

accomplish. Each numbered step is an action you take to complete the procedure.
Some steps are followed by an explanation, an illustration, or both.






Quick Start

This chapter gets you started with PWB. You’ll learn the basics by building and
debugging a program that calculates payments on a loan given the principal, inter-
est rate, and term.

To start PWB in Windows for this tutorial, click the PWB icon in the Microsoft
C/C++ Program Group.

In DOS, type
PWB

at the prompt.

» Toleave PWB at any time:

= From the File menu, choose Exit, or press ALT+F4.

2.1 The PWB Environment

If this is the first time you have used PWB, you see the menu bar, the status bar,
and an empty desktop. If you have used PWB before, it opens the file you last
worked with.

PWB uses a windowed environment to present information, get information from
you, and allow you to edit programs. The environment has the following com-
ponents:

= An editor for writing and revising programs

= A “build engine”—the part of PWB that helps you compile, link, and execute
your programs from within the environment

A source-code browser
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= Commands for program execution and debugging
= The Microsoft Advisor Help system

The browser and the Help system are dynamically loaded extensions to the PWB
platform. Microsoft languages and the utilities are also supported in PWB by
extensions. Other extensions are available, such as the Microsoft Source Profiler.
PWB presents all of these components through menus and dialog boxes.

Before continuing, look at the following figure, which introduces some parts of
the PWB interface.

File Edit Search Project Run Options Browse Help

New
Close Ctrl+F4
Untitled.001 Close All
Move Ctrl+F?
Size Ctrl1+F8
Restore Ctrl1+F5
Minimize Ctrl+F9
Maximize Ctrl1+F10
Cascade F5
Tile Shift+F5
Arrange Alt+F5
Untitled.001 Alt+1
Untitled.002 Alt+2

:
Bro¥ser Output

mtitled.002
Build Results P N 0OEO1.001

Figure 2.1 PWB Display

Chapter 4, “User Interface Details,” contains a thorough description of these ele-
ments and the rest of the PWB environment. Refer to this chapter when you need
specific information about an unfamiliar interface element.

The Microsoft Advisor

PWB makes programming easier by providing the Microsoft Advisor Help sys-
tem, which contains comprehensive information about:

= PWB editing functions
= PWB advanced features

= PWB menus and dialog boxes
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To get immediate
help on any subject,
point to the item in
question and press the
right mouse button.

= CodeView debugger

= C and C++ languages

® C and C++ compiler options

= Crun-time library

= P-code

= Microsoft utilities (such as NMAKE, LINK, and so on)
= Windows API (application programming interface)

= Microsoft class libraries

The Advisor provides context-sensitive Help and general Help. Context-sensitive
Help provides information about the menu, dialog box, or language element at the
cursor. To see context-sensitive Help, press the F1 key. PWB displays the Help
window to show the requested information. You can also get context-sensitive
Help and more general Help by using the Help menu.

To answer questions of a less specific nature, you can access the Contents screen
by choosing Contents from the Help menu or by pressing SHIFT+F1. From the
Advisor contents, you can access Help on any other subject in the database.

To get started using the Microsoft Advisor:

= From the Help menu, choose the Help on Help command.

Help on Help teaches you how to use the Microsoft Advisor Help system. For
more information on using Help, see Chapter 23.

» To close the Help window:

® Click the upper-left corner of the Help window (the Close box), press ESC,
choose Close from the File menu, or press CTRL+F4.

Note Click the Close box, choose Close from the File menu, or press CTRL+F4 to
close any open window in PWB.

The following sections explain basic editing procedures. If you’re already familiar
with these, you can skip to “Opening an Existing File” on page 18.
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Entering Text

Press the | 4
highlighted key in a

menu or command

name to open the

menu or execute the
command.

Press

CTRL+HOME to move
the cursor to the
beginning of a file.
Press CTRL+END to
move to the end of
the file.

In this section, you’ll learn basic PWB procedures by entering a simple C pro-
gram, ANNUITY.C.
To start a new file:

1. Move the mouse cursor (“point”) to the File menu on the menu bar and click
the left button.

PWB opens the File menu.
2. Point to the New command and click the left button.

You can also do this from the keyboard:

1. Press ALT+F to open the File menu.
2. Press N to choose New.

PWB opens a window with the title Untitled.@01.

Starting with your cursor in the upper-left corner of the edit window, type the fol-
lowing comments:

//
// annuity.c - Program to generate a simple annuity table
//

Your screen should appear as follows:

File Edit Search Project BRun Options Browse Window Help

=L 11 Untitled.001 1411
v
s amuity.c - Program to generate a simple annuity table
v

A :

<Gene;a1 Helpib(F1=Help> <Alt=Menu>
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Saving a File

Now that you’ve entered some of your program, save your work before
proceeding.

» To save a file:

= From the File menu, choose Save, or press SHIFT+F2.
PWRB displays the Save As dialog box.

FRRCIL USRIt i t 1ed . OO 1 [ 1

D :\C?ON\SOURCENSAMPLES\PWBTUTOR

File Qist: Orives # Dirs:

0K <Cancel> < Jelp >

This dialog box has several options that you use to pass information to PWB.
PWB indicates the active option—in this case, the File Name text box—by
highlighting the area in which you can enter text. For more information about
dialog boxes, see Chapter 4, “User Interface Details.”

Because you have not yet saved the file, it still has the name Untitled.001. Type
ANNUITY.C in the File Name text box. Then click OK or press ENTER to save the
file.

Note Now that you have named your file, choosing Save from the File menu
does not bring up a dialog box. Your file is immediately saved to disk.

Indenting Text with PWB

Type the following program fragment:

f#include <stdio.h>

#include <math.h>

main()

{
float pv, rate, pmt, fv, ratepct;
int nper, actnper;
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// get input from the user
printf( "Enter present value:\n" );
scanf( "%f", &pv );
printf( "Enter interest rate in percent:\n" );
scanf( "%f", &rate );
printf( "Enter number of periods in years:\n" );
scanf( "%i", &nper );
}

Often you will add several lines indented to the same column. PWB saves you
time by automatically indenting new lines when you press the ENTER key.

When the PWB C extension is loaded, PWB automatically indents new lines in C
and C++ source files as appropriate for the C and C++ languages. When the lan-
guage extension is not loaded (or the extension’s autoindentation is turned off),
PWRB uses its default indentation rules as follows:

» If there is no line or a blank line immediately below the new line, PWB
matches the indentation of the line above it.

= If there is a line immediately below the new line, PWB matches the indentation
of the line below it.

You’ll now type some text after the last scanf statement.

To insert space for a new line:

1. Position the mouse cursor anywhere past the end of the scanf statement. Precise
positioning of the cursor is not critical because (by default) PWB trims trailing
spaces from the end of your lines.

2. Click the left mouse button.
3. Press ENTER to make a new line.

If you are in overtype mode, change to insert mode by pressing the INS key.
Otherwise, pressing ENTER simply moves the cursor to the beginning of the next
line. PWB displays the letter O on the status bar and shows the cursor as an un-
derscore to signal that you are in overtype mode.

To insert the new line using the keyboard:

1. Move the cursor to the scanf statement just above the closing brace by pressing
the UP ARROW key.

2. Press END to move the cursor to the end of the line.

3. Press ENTER to make a new line.
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Type the following lines:

ratepct = rate / 1200.0;
actnper = nper * 12;
// calculate the payment amount
pmt = pv * (ratepct / (1.0- (1.0 /
(pow((1.0 + ratepct), actnper )))));
printf( "Principal: %f\n", pv );
printf( "Interest rate: %f\n", rate );

To move the When you enter the forward slash for the first comment line (the third line of this
cursor directly to the section), PWB’s automatic indentation feature positions the cursor in column 5.

first column, pressFo. T move the cursor to column 1, use the LEFT ARROW key or the BACKSPACE key.
HOME.

Copying, Pasting, and Deleting Text

The remainder of the program consists of the following printf statements. Don’t
type them in yet. You will copy and paste to enter these lines.

printf( "Number of years: %i\n", nper );

printf( "Monthly Payment: %f\n", pmt );

printf( "Total Payments: %f\n", pmt * nper * 12.0 );
printf( "Total Interest: %f\n", pmt * nper * 12.0 - pv );

Since these lines are similar, you can save time by typing only the first one, then
copying and pasting text using PWB’s clipboard (a temporary storage place for
text).

» To copy and paste text:

1. Place the cursor on the line:

printf( "Interest rate: %f\n", rate );

Youcanusethe 2. From the Edit menu, choose Copy. This action places the entire line on the clip-
keys cTRL+INs for Copy board for later reference.
and sHiFT+Ins for Paste. . . . .
. To insert the copied line, choose Paste from the Edit menu.
4. Paste the same line three more times to create enough printf statements for the
remainder of the program.
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Your screen should look like the following figure:

it Search

Project Run Options Browse Window
=l 1] D :\C70ON\SOURCENSAMPLESNPWBTUTORNammuity.c
ss get input from the user

printf ( "Enter present value:\n" );

scanf ( "zf", &pv ):

printf ( "Enter interest rate in percent:\n" ):

scanf ( "zf", &rate ):

printf ¢ "Enter number of periods in years:\n" );

scanf ¢ "zi", &nper ):

ratepct = rate / 1200.0;

actnper = nper = 12;

ss calculate the payment amount

pmt = pv = (ratepct » (1.0- (1.0 /
(pow((1.0 + ratepct), actnper )))));

printf( "Principal: «f\n", pv ):

printf ¢ "Interest rate: #f\n", rate );

printf ( "Interest rate: #f\n", rate ):

printf ( "Interest rate: #“f\n", rate ):

printf ( "Interest rate: #f\n", rate ):

printf ( "Interest rate: xf\n", rate ):

M e

<F1:Helb> <Alt=Menu> <Fb=Window>

There are now five copies of the same printf statement. Next, you’ll modify the
printf statements so that each corresponds to the preceding example. The cursor
should be on the first copy of the printf statement.

Before you modify the text, you must select what you are going to modify.

» To select text:

1. Point to the I in “Interest Rate” in the second printf statement.

2. While holding down the left mouse button, drag the mouse until it is over the
colon.
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Double-click
a word to select it.

File Edit Search Project Run Options Browse UWindow Help
p=[ 1]—————— D:\C?OO\S0URCENSAMPLES\PUBTUTORNannuity.c
s7 get input from the user

printf ( "Enter present value:\n" );

scanf ( “zf", &pu ):

printf ( "Enter interest rate in percent:\n" );

scanf ( “2f", &rate ):

printf ¢ "Enter number of periods in years:\n" J);

scanf ( "zi", &nper ):

ratepct = rate ~/ 1200.0;
actnper = nper = 12;
ss calculate the payment amount
pmt = pu = (ratepct » (1.6~ (1.0 ~
(pow((1.0 + ratepct), actnper 1))I):
printf ( "Principal: «f\n", pv ):
printf( "Interest rate: #f\n", rate ):
printf ( ST eRes: «f\n", rate );
printf ( "Interest rate: #“f\n"”, rate ):
printf( "Interest rate: «#f\n", rate );
printf ( "Interest rate: #f\n", rate ):

<F1;Help> (ﬂltiﬁenu> <F6=Window>

The text Interest Rate is now selected and highlighted on your screen.

» To select this text with the keyboard:

1. Move the cursor to the first character of text you want to select.

2. Press SHIFT+RIGHT ARROW until the cursor is on the colon.

Now that the text is selected, type: Number of Years. When you type the first char-

acter, you’ll notice that the selected text is deleted.

Important If you select an area of text and type, PWB replaces the selected text

and does not save it on the clipboard. You can recover the text by choosing Undo

from the Edit menu.

Now change the variable rate on the same line to nper, as follows:

1. Select the word rate and press DEL.

The word is removed from the file and placed on the clipboard. Pressing DEL is

a direct way to delete text.
2. Type the word nper

Use the techniques you’ve learned to make the rest of the corrections, and then

save the file by choosing Save from the File menu.
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Note You can turn on automatic file saving by setting the Autosave switch to
yes with the Editor Settings command on the Options menu. When Autosave is
turned on, PWB automatically saves your file before executing certain commands
such as running your program or switching to another file. For example, if you run
a program that is not yet stabilized, PWB ensures that your file is stored safely in
case you have to reboot.

Opening an Existing File

The remainder of this chapter uses another program, ANNUITY 1.C, which you
can now open in PWB. This program is a slightly different version of the program
you just entered. It has several errors you will correct as you follow the tutorial.

» To open ANNUITY1.C:

1. From the File menu, choose Open (press ALT+F, O).
PWB displays the Open File dialog box.

Open File

Jile Name: [QRRR----- - - - 1
D :\C7OONSODURCENSAMPLES\PWBTUTOR
File fist: Drives / Dirs:
ANNUITY.BAK  COUNT.C ..
ANNUITY.C COUNT .H [-A-1
ANNUITY1.C COUNTBUF .C [-B-1
CNT.MAK COUNTCH.C [-C-1

C

[ 1 Igseudofile
[X]1 Jew Window

[-D-1

B Ok J <cCancel> < Ielp >

If you know the PWB uses *.* as the default filename. This causes PWB to display all files in
name of the file, you the current directory in the File List box.

can type it into the File . .

Name text box. . If you are not in the directory where the sample programs are located, press

the TAB key twice to move to the Drives/Dirs box. The example files are in
\C700\SOURCE\SAMPLES\PWBTUTOR if you accepted the default direc-
tory suggested by SETUP.

You’ll notice that the cursor is a blinking underline. That means that although
you have activated the list box, you haven’t yet selected an item.
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Double-click
the drive or directory
to move to that
location.

Double-click
the filename to open
the file.

3. Use the arrow keys to move to the drive or directory where the files are located.

As you press the arrow keys, you’ll notice that the cursor changes to a bar that
highlights the whole selection. This is called the “selection cursor.” The text of
the selected item also appears in the File Name box.

4. When you have highlighted the drive or directory you want, press ENTER to
move there.

5. Use the TAB key to move to the File List box.
6. Use the arrow keys to move to ANNUITY1.C.

7. When you have highlighted ANNUITY1.C, press ENTER or click OK to accept
your selection and open the file.

PWB opens ANNUITY 1.C for editing.

2.2 Single-Module Builds

Now that you have opened your file, you probably want to compile and run it to
see if it works. Compiling the source files and linking them with the run-time li-
braries is called “building the project.” It results in an executable file. A project
build can also:

® Create and update the browser database.
® Create a Windows dynamic-link library (DLL).
= Build a library of routines.

Setting Build Options

Before you build a program, you must tell PWB what sort of file to create by using
the commands on the Options menu. Use the commands from the Options menu to

specify:

®  The run-time support for your program. This is important for mixed-language
program development, where you have some source files in C and some in
another language. With Basic, for example, the run-time support must be
Basic’s run-time support.

The run-time support you choose determines the run-time libraries that are used
and the types of target environments that can be supported.

= Project template. The template describes in detail how PWB is to build a pro-
ject for a specific type of file (EXE, .COM, .DLL, .LIB) and the operating en-
vironment for the target file (DOS, Windows, and so on).

= Either a debug or release build. Debug options normally specify low levels of
optimization and the inclusion of CodeView debugging information. Release
options specify higher levels of optimization and no CodeView information.
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® A build directory. PWB builds your object and executable files in your current
directory unless you specify otherwise. (This option is reserved for projects that
use explicit project files, which are described in Chapter 3.)

» To set the project template for ANNUITY1.C:

1. From the Options menu, choose Set Project Template from the Project
Templates cascaded menu.

Environment Variables...
Key Assignments...
Editor Settings...
Colors. ..

ild Options...

3et Project Template... o ject Templates

>
stomize Project Template... age Options >

3| Custom Project Template...

emo 0

ve Custom Project Templates... e Options...

Options...
NMAKE Options...
CodeView Options. ..

Note that the actual order of the menu items may differ from the illustration
because PWB’s extensions can be loaded in any order.

2. PWB displays the Set Project Template dialog box.

Set Project Template
Runtime Support:

%_i

Ces 1

Project femplates with Runtime Support for: None

Generic Options
DOS EXE

DOS Overlaid EXE
DOS p-code EXE
DOS COM

Current Runtime Support: None
Current Project Template:

B ok B <Cancel> < Jelp >
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5.
6.

This dialog box typically has the entries None, C, and C++ in the Runtime Sup-
port list box. If you have installed other languages, their names appear as well.

If the current run-time support is not C, you need to choose C as the run-time
support, and you must also select a project template.

Click c, or press the DOWN ARROW key until C is highlighted.

. Move to the Project Templates list box by clicking in the box, pressing the TAB

key the appropriate number of times, or by pressing ALT+T.
Select DOS EXE.
Choose OK to set the new project template.

To set the build options for ANNUITY1.C:

1.

3.

From the Options menu, choose Build Options.
PWB displays the Build Options dialog box.

Build Options

)
)

Use Debug Options
Use [jelease Options

C
(e

[ 1Build Directory: [----- - oo 1

0K <Cancel> < Jelp >

Turn on Use Debug Options by clicking the option button or by pressing ALT+D.

This option tells PWB that you are building a debugging version of the pro-
gram. PWB uses debug options when you build or rebuild until you use the
Build Options dialog box to choose Use Release Options.

Choose OK.

PWB saves all the options that you specify. You don’t have to respecify them each
time you work on your project.

Figure 2.2 shows the three sets of options that PWB maintains for each project.
Global options are used for every build. Debug options are used when Use Debug
Options is turned on in the Build Options dialog box. Release options are used
when Use Release Options is turned on.



22

Environment and Tools

Options Menu

Language Options

Project Options

Link Options

Global Debug Release
Options Options Options

Use Use

Debug Release Build Options

Options | s‘gﬁﬁtded <1 Options

Options
i
> Current Build Options

Figure 2.2 PWB Build Options

You can set compiler and linker options for both types of builds by using the Lan-
guage Options commands and the LINK Options command. These commands do
not determine which set of options are used when you build the project. Only the
Build Options command determines which set of options (debug or release) are
used when you build the project or compile a file in the project.

Global options typically include settings for warning level, memory model, and
language variant. These are options that do not change between debug and release
versions of a project. The debug and release sets control options that differ be-
tween the two types of builds, such as the level of optimization and the inclusion
of CodeView debugging information. Debug options normally specify low levels
of optimization and the inclusion of debugging information. Release options usu-
ally specify high levels of optimization and no debugging information.

Setting Other Options

The Options menu also contains commands that allow you to describe the desired
project build more completely. You don’t need to use any of these options to build
ANNUITY1.C because the default values supplied by the template are correct for
the type of program you choose.



Quick Start 23

The Options menu contains the following commands:

= C Compiler Options and C++ Compiler Options in the Language Options cas-
caded menu. These commands let you specify compiler options specific to
either debug or release builds and general options common to both types of
builds. Use the Compiler Options command to customize the options given by
your project template. You can specify memory model, warning level, proces-
sor type, and so on.

If you have more languages installed, their Compiler Options commands also
appear in the Languages Options cascaded menu.

= ] INK Options. This command parallels the Compiler Options commands. You
can specify options specific to debug or release builds and general options com-
mon to both debug and release builds.

Use LINK Options to specify items such as stack size and additional libraries.
You can also select different libraries for debug and release builds. This is
handy if you have special libraries for debugging and fast libraries for release
builds.

= NMAKE Options. This command lets you specify NMAKE command-line
options for all builds. This option is particularly useful if you have an existing
makefile that was not created by PWB or if you have modified your PWB pro-
ject makefile. For more information about these subjects, see “Using a Non-
PWB Makefile” on page 61.

® CodeView Options. This command allows you to set options for the CodeView
debugger.

Building the Program

Now that you’ve set your options, you can build the program. Note that the sample
program contains intentional errors that you will correct.
» To start the project build:

1. From the Project menu, choose Build.

PWB tells you that your build options have changed and asks if you want to
Rebuild AT1.
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2. Choose Yes to rebuild your entire project.

After the build is completed, PWB displays the following dialog box:

Build Operation Complete
Rebuild all

6 Errors/Warnings

liew Resultsf] <Run Program> <Debug Program> <Cancel> < Help >

You can choose one of several actions in this dialog box:

View the complete results of the build by opening the Build Results window.

Run the program if building in DOS. You can run a DOS program right away if
the build succeeds. If the build fails, you should fix the errors before you at-
tempt to run the program.

To run a successfully built Windows program, you must return to the Program
Manager and use the Run command on the File menu.

Debug the program if building in DOS. If the build succeeds but you already
know the program is not producing the intended results, you can debug your
DOS program using CodeView.

To debug a Windows program, you must return to the Program Manager and
start CodeView for Windows from the Microsoft C/C++ Program Group.

Get Help by choosing the Help button or by pressing F1 (as in every PWB
dialog box).

Cancel the dialog box. This returns you to normal editing.

Choose Cancel to dismiss the dialog box (press ESC). PWB keeps the results of the
build so that you can view the build messages later or step through them to view
the location of each error. The next section describes how to do this.

Fixing Build Errors

For each build, PWB keeps a complete list of build errors and messages in the
Build Results window. The ANNUITY 1.C program that you just built contains
several errors that you’ll identify and fix in this section.
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» To go to the first error:
® From the Project menu, choose Next Error, or press SHIFT+F3.
PWB positions the cursor on the location of the first error or warning in your pro-

gram; in this case, the keyword int is misspelled. The message from the compiler
is displayed on the last line of the window.

File Edit Search Project Run Options Browse Window Help
1=[  1]=—=————— D:\C70EAN\SOURCENSAMPLES\PWETUTORNANNUITY1.C 1
s

/s ANNUITY1.C - Generate annuity table.

/7 Contains intentional errors for use with the PUB Tutorial
2’

ttinclude <stdio.h>

ttinclude <math.h>

void main( wvoid )

float Principal, Rate, Pmt, RatePct, PerlInterest, PerPrin:
int Nper:

int ActNper:

ont Period:

Vs
/s Get input from the user.
s

printf ( "\nEnter Present Value: " ):

scanf ( "#f", &Principal );

ANNUITY1.C(13) : error C2065: ’ont’ undeclared identifier

Whenever a message is displayed on the bottom line of the window, you can
get Help on that message by clicking the Help button on the status bar or by
pressing Fi.

» To get Help on a message that is not currently displayed:

1. Press ALT+A. This executes the PWB function Arg to begin a text argument.

2. Type the error number with its alphabetic prefix. In this example it would be
c2065. For the C and C++ compiler, be sure to use the exact letter case of the
message number.

3. Press Fl.
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When you use one of these techniques to get Help on the message, PWB opens the
Help window and displays information about the error.

File Edit Search Project Run Options Browse Window Help
=[ 3] Help: C2065 [2861
4Up; <Contentst 4Index> ABackr' 1}

Compiler error C2065

*identifier’ : undeclared identifier

The spec1fled 1dent1fler was not declared

fluat Principal, Rate, Pmt, RatePct, Perlnterest PerPrin:
int Nper:

int ActNper:

ont Period:

V4
ss Get input from the user.
V4

printf ( "\nEnter Present Value: " ):
scanf ( "zf", &Principal ):
ANNUITY1.C(13) : error C2065: "ont’ : undeclared identifier

<F1=Help> <Error Help> <F6=Window> P N 00001.001

When you are finished reading the Help, close the Help window by clicking the
close box in the upper-left corner of the Help window, by pressing ESC, or by
pressing CTRL+F4.

Correct the first error by changing ont to int.

The compiler reports two additional errors that are side effects of the misspelling
of int. You could continue choosing Next Error to skip these additional messages,
but there is another way to go directly to a selected error in Build Results.

» To go to a selected error:

1. From the Window menu, open the PWB Windows cascaded menu and choose
Build Results.
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PWB opens the Build Results window, which contains the complete results of
the build.

File Edit Search Project Run Options Browse Window Help
—[ 11— D:\C?70E\SDURCENSAMPLESNPWBTUTORNANNUITY1.C
27
/s ANNUITY1.C - Generate annuity table.
/7 Contains intentional errors for use with the PWB Tutorial
V4
#include <stdio.h>
#include <math.h>

void main( void )

{
float Principal, Rate, Pmt, RatePct, PerInterest, PerPrin:
=[ 3] Build Results 11|
+++ PWB  [D:\C?0O\SOURCENSAMPLES\PWBTUTOR1 Rebuild all

NMAKE ra /f c:\temp\PWBOB993.mak all

Microsoft (R) Program Maintenance Utility VUersion 1.20.0053
Copyright (c) Microsoft Corp 1988-91. All rights reserved.

cl sc A2 /BATCH /qc ~Gi . NANNUITY1.mdt ~/Zr /Zi ~0d ,Fo.\ANNUITY1.obj ANNUI
Microsoft (R) C/C++ Optimizing Compiler Uersion 7.00.252
Copyright (c) Microsoft Corp 1984-1991. All rights reserved.

|

N

<Fi-Help> <Error Help> <F6=Wi) ' N 00001 .001

2. Find the next message that is not a side effect of the first error, and move the
cursor to that line in the Build Results window.

Move the cursor to the message:
error C2001: newline in constant.

3. From the Project menu, choose Goto Error.

PWB jumps to the location of the second error in the program.

Correct the second error in the program (an unterminated string) by adding the
missing double quotation mark ('') one space beyond the colon (:) in the prompt
string.

Running the Program

Now that all the errors are corrected, you can run the program.

» To run the program:

1. From the Run menu, choose Execute.

PWB detects that you’ve changed the source and displays a dialog box with the
following options:
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Dependent file(s) have changed?

Do you want to Build-/Rebuild current target?

Biuild Targetl <gebuild Al1> <Run Frogram> <Cancel> < Jelp >

Option Description

Build Target Build the program by compiling only the modified files. For more
information about building specific targets, see “Using Non-PWB
Makefiles” on page 61.

Rebuild All Build the program by compiling all program files. For this single-
module program, Build Target and Rebuild All are equivalent.

Run Program Run the program without rebuilding it.
Cancel Cancel the Execute command.

Since you’ve corrected errors, you want to build the target.
2. Choose Build Target to build the program.

When the build completes, PWB displays the following dialog box where you can
choose Run Program to run the finished program.

Build Operation Complete
Rebuild all

0 Errors/Warnings

<¥iew Results> <fun Program> <Qebug Program> [Cancelf < Jelp >

The following sections describe debugging with the Microsoft CodeView debug-
ger. If you’re already familiar with CodeView, you can skip ahead to “Formatting
Text” on page 34 or go directly to Chapter 3, “Managing a Multimodule Program.”

2.3 Debugging the Program

PWB integrates several Microsoft tools to produce a complete development en-
vironment. Among those tools are NMAKE, a program maintenance utility, and
CodeView, a symbolic debugger. You saw how PWB uses NMAKE to build pro-
grams; now you can use PWB as a gateway to CodeView.

Earlier, you chose Use Debug Options in the Build Options dialog box. A debug
build typically includes the compiler options that generate CodeView information.
Therefore, the program is ready to debug with the CodeView debugger.
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Using CodeView to Isolate an Error

You can always
return to PWB from
CodeView by choosing
Exit from CodeView’s
File menu.

In addition to the typographical errors that you just corrected, ANNUITY1.C con-
tains a logic error: when the program prints the annuity table, the year numbers
start at O instead of 1. You can use CodeView to isolate the errors in program logic.

This program calculates the payment on a loan, so you can use the following test
case:

Present Value: $14,500
Interest Rate: 14%
Period: 5 Years

The expected result is a monthly payment of $337.39.

» To start CodeView:

= From the Run menu, choose Debug.

It anything,1 in your program is out-of-date, PWB asks if you want to build or re-
build the current target. If you modified the source file to correct errors or change
text, PWB considers it out-of-date relative to the executable file that you built ear-
lier. If this happens, build the program and choose Debug from the Run menu.

CodeView starts, showing you the source line of the program’s starting point. In
this case, the starting point is the opening brace of the function main.

File Edit Search Run Data Options Calls Windows Help
—[11 local

[—[3} sourcel CS:IP ANNUITY1.C
4: V24

5: #include <stdio.h>

6:

?

8

tinclude <math.h>

: void main( void )
9: {

10: float Principal, Rate, Pmt, RatePct, PerInterest, PerPrin:
11: int Nper:

12: int ActNper:

13: int Period:

14:

F10=Step> <F5-Go> <F3=Srcl Fmt>
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The first step in debugging a program is to verify input values. You will know
what values have been supplied after the last scanf statement has executed, so run
the program up to that point as follows:

1. If the Source window (the window displaying your program) is not the active
window, press F6 until it is. You can tell that a window is active when the title
bar is highlighted and it has scroll bars.

Click the right 2. Move the cursor to line 32, RatePct = Rate / 1200.0
mouse button on line

32 ortype c.32 1o 3. Press F7 (continue execution to cursor).

continue execution to The program runs, asking for input. Supply the values you are using as a test
line 32. case:

Present Value: 14500

Interest: 14

Number of Periods: 5

CodeView stops your program at line 32.

i Edit Search Run Data Options Calls Windows Help
—_—— local
float PerPrin = 1.56184e-008
float Rate = 14.0000
float PerInterest = 4.05925e-038
short Period = -32557

short Nper = 5

float Pmt = 4.62134e-041
float Principal = 14500.0
float RatePct = 2.41561e+007

P = i

29: /s the monthly payment (Pmt).

30: 77

31:

3a: RatePct = Rate ~ 1200.0:

33: ActNper = Nper = 12:

34: Pmt = Principal = (RatePct ~» (1.0 - (1.0 ~

—I[91 command

>

<F8=Trace> <F10=Step> <F5=Go> <F3=Srcl Fmt> <ENTER=Expand> DEC]

You can resize 4. Resize the Local window until you can see all the variables:

the window with the . . . . . . . .
wintiow wi a. Press F6 until the Local window is active. (The active window is the window

mouse by dragging the .
lower-right corner to with the scroll bar.)
the desired location. b. From the Window menu, choose Size.

c. Use the DOWN ARROW key to enlarge the Local window.
When the window is the desired size, press ENTER to accept that size.
d. Press F6 to move back to the Source window.
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The CodeView
interface and menu
commands are similar
to PWB, so techniques
you use in PWB are
often useful in
CodeView.

You can type
p 3 inthe
Command window
to step three
statements.

>

Now you can verify that the initial data used by your program is correct by ex-
amining the values of Pv, Rate, and Nper. They should have the values 14500, 14,
and 5, respectively.

Note For case-insensitive languages such as Basic or FORTRAN, CodeView dis-
plays all variables, subroutine names, and function names in uppercase.

The next step is to execute the program until the initial calculations are done. The
calculations are complete prior to the for loop. If you let the program execute that
far, the program produces some screen output that’s useful for debugging.

To execute to the for loop:

1. From the Search menu, choose Find.

2. Type for in the Find Text box.

3. Press ENTER to move the cursor to the for statement.

Although your cursor is now on line 62, the program has not executed the state-
ments between where it stopped (on line 32) and the current cursor position.

4. Press F7 to execute all code up to but not including this location.

Your program has now displayed the summary information on the screen. To
switch to the output screen, press F4. To switch back to the CodeView screen,
press F4 again (or any key).

On the output screen, you should observe the following results:

Monthly Payment: 337.39
Total Payments: 20243.38
Total Interest: 5743.38

These results are correct. You know that the program works properly up to the
beginning of the for loop. Therefore, you can ignore all code up to this point and
focus on discovering why the year number is incorrect.

To step through one cycle of the loop and examine your data:

1. Press F10 three times to step three lines.

This calculates values for PerInterest (interest for the current period) and
PerPrin (contribution to principal for the current period).

2. Examine the values of PerlInterest and Prin in the Local window to see if
they are correct. The formula for simple interest is:

Interest = Outstanding Principal * Periodic Interest Rate
Similarly, the formula for the contribution principal is:

Contribution = Payment — Interest
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In the test case, the correct values for PerInterest and PerPrin are 169.167
and 168.223, respectively. These values should appear on your screen.

3. Press F10 again to step one more program statement—the printf statement.
4. Press F4 to examine the screen output. The year number is still incorrect.
You have reduced the problem to the arithmetic in the printf call itself. The ar-

gument list for printf contains the expression Period / 12. Integer truncation
causes all values of Period that are less than 12 to yield the result 0.

Now that you have identified the apparent bug, you can test the solution. The
proposed solution to this problem is to replace the expression Period / 12 with
Period / 12 + 1. You can test this solution by using the CodeView expression
evaluator.

» To test the new expression:

1. Activate the Command window.
2. Type the Display Expression (?) command with the test expression:

? Period / 12 + 1

CodeView evaluates the expression and prints 1, the correct result.

Testing Conditions in the Watch Window

You know the solution works for one iteration of the loop but not if it works for
other conditions. You can test a larger range of possible conditions by using break-
points and the Watch window—a window in which you can view the value of
selected data or expressions during a debugging session.

» To test conditions using the Watch window:

You can use 1. From the Data menu, choose Add Watch.
cTRL+w to add a watch .
expression quickly. 2. Type the proposed expression:

Period / 12 + 1

3. Choose OK to put this expression in the Watch window.

Add Watch

Bxpression: [Period ~ 12 + 1 1

0K <Cancel> < Jelp >
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Toseta

breakpoint on a line,
double-click the line.

The status bar
reminds you about
commonly used
actions and keys. You
can click the buttons
with the mouse to
carry out the actions.

Now you can see the results of the expression as your program executes, but you
have to stop the program at places where the results of this expression are informa-
tive. You do this by setting breakpoints. A breakpoint is a location to stop execu-
tion or a condition when you want your program to stop.

1. Move to the Source window by clicking it or by using the Fe key.

2. Move the cursor to the printf statement and press F9 to set a breakpoint there.

—[11

File Edit Search

Run Data

Options Calls Windows Help

1

[BP-0006]1 float PerPrin = 1.5618
[BP-000A] float Rate = 14.0000
[BP-GOGE] float PerInterest = 4.

=[21]

[ePer

== watch =—————=|
iod » 12 + 1 =1

|

—[31]
61:
62:
63:
64:
65:
66:
67:
68:
69:
70:
71:

sourcel C3:IP ANNUITY1.C
for( Period = 1; Period <= ActNper: Period++ )
{

PerInterest = Principal = RatePct:
PerPrin = Pmt - PerlInterest:
printf( "#6d »6d #9.2f »9.2f\n",
Period, Period ~ 12, PerPrin, Perinterest ):
Principal = Principal - PerPrin:
¥

—I[91

>

command

<F8=Trace> <F10=Step> <F5=Go> <F3=Srcl Fmt> <ENTER=Expand>

This breakpoint stops execution and returns control to CodeView each time the
printf statement is about to be executed. You can then examine the values of
the variables in the Local window and the results of your expression in the
Watch window.

3. Press F5 to run the program.

Now each time you press F5, the program executes all statements up to but not
including the printf statement. Repeat this until Period equals 12. At this point,
you are in the last month of the first year. Notice that the expression you specified
does not handle this boundary condition correctly. It changes from 1 to 2 one
period too early.

» To adjust for the boundary condition:

1. Add the following expression to the Watch window:

(Period - 1) / 12 + 1

2. Restart the program by choosing Restart from the Run menu.
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3. Press F5 to start execution.
The program asks for input again. These values are:

Present Value: 14500
Interest: 14
Number of Periods: 5

Your program stops at the breakpoint you set on the printf statement.

On the first iteration, you’ll notice that the watch expression from the last run,
Period / 12 + 1,1is still in the Watch window.

» To remove the incorrect expression:

CodeView 1. From the Data menu, choose Delete Watch.
numbers watch 2. Sel h . del
expressions starting . Select the expression you want to delete.

at zero. To remove 3. Press ENTER to delete the Watch expression from the window.
this expression, you

can type wce in the

’ Run your test; press Fs to step through the loop one iteration at a time. This time,
Command window.

you should get the correct results.

» To switch from CodeView back to PWB:

®  Choose Exit from the CodeView File menu.

Now that you’ve built and debugged your program, you may want to reformat
your code to make it easier to read. The following section describes how to do this
using PWB’s editing functions.

2.4 Formatting Text

Well-formatted code is more readable and easier to maintain. ANNUITY1.C is not
very well formatted, but PWB can help you indent blocks of code to make them
more readable. For example, the printf statement at line 41 is continued across
multiple lines. Indenting continued lines of a statement lends clarity to the code.
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Indenting Lines of Code

» To indent lines:

The line and

column of the cursor
appear in the status bar.

1. Go to the statement where you want to indent text (on line 41). Press ALT+A,

type 41, then press CTRL+M to jump to line 41.

This sequence of keystrokes is pronounced “Arg 41 Mark.” The PWB function

Arg begins an argument (41) that is passed to the Mark function. When you

pass a number to Mark, PWB moves the cursor to that line.

You can also do this from the menu by typing the line number in the Goto

Mark dialog box from the Search menu.

2. Move the cursor to the double quotation mark (") in column 5.

3. Hold down the SHIFT key and press the RIGHT ARROW key eight times so that the

cursor is in column 13, under the opening double quotation mark in the printf

statement.

Edit Search Project Run Options Browse Window Help
1=[ 1]=————— D:\C7ON\SOURCE\SAMPLES\PWBTUTORNANNUITY1.C
/7 Print a summary of the annuity

77

printf ¢ "\n\n"

["Princip 3B #13.20\n"

"Interest Rate: x13.2f\n"

“Number of Years: x13i\n"

“"Monthly Payment: »x13.2f\n"

"Total Payments: »x13.2f\n"

"Total Interest: ¥13.2f\n\n\n",

Principal, Rate, Mper, Pmt,

Pmt = (float)Nper = 12.0,

Pmt »= (float)Nper = 12.0 - Principal J):

77

s7 Print headings of the amortization table.
7/

printf( "Period Year Principal Interest\n"

AV TR H

Ve
/s Loop on the number of periods, printing the period, year,

e |

<General Help> <Fi=Help> <Alt=Menu>

4. Press SHIFT+DOWN eight times to select the rest of the statement.
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Edit Search Project Run Options Browse Window Help
D :\C7OONSOURCENSAMPLESNPWBTUTORNANNUITY1 .C
/7 Print a summary of the anmmuity
Vs
printf C "~n\n"
"Principal: 713.2f\n"
"Interest Rate:  #13.2f\n"
"Number of Years: x13i\n"
"Monthly Payment: »13.2f\n"
"Total Payments: x13.2f\n"
"Total Interest: #13.2f\n\n\n",
Principal, Rate, Nper, Pmt,
Pmt = (float)Nper = 12.0,
LSy loat)Nper * 12.0 - Principal ):

27
s/ Print headings of the amortization table.
Vs
printf ( "Period Year Principal Interest\n"

e g +

<KGeneral Help> <Fil=Help> <Alt Heﬁu

By default, the editor starts in stream selection mode. This mode allows selec-

tion to begin at any point and selects all characters in a stream between the

beginning and end of a selection, as shown above. You will need to change the

selection mode to perform the block indent.

The Edit menu lets you choose from three selection modes:
= Stream mode. The default, as explained previously.

= Line mode allows you to select complete lines of text.

Search Project Run Options Browse Window Help

D :\C7OONSOURCENSAMPLESN\PWBTUTORNANNUITYL.C
/7 Print a summary of the annuity
/7
printf ( "\n\n"
"Principal: #13.2f\n"
"Interest Rate: «13.2f\n"
“Number of Years: #13i\n"
“Monthly Payment: #13.2f\n"
“Total Payments: #13.2f\n"
"Total Interest: #13.2f\n\n\n",
Principal, Rate, Nper, Pmt,
Pmt »* (float)Nper = 12.0,
Pmt »* (float)Nper * 1Z2.0 - Principal J;

Ie4

/7 Print headings of the amortization table.
V4
printf( "Period Year Principal Interest\n"

" SV D H
V24
/7 Loop ¢ f peri 'nting the

e |

<General Hélp; <F1=Help> <Alt=Menu>
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To change

selection modes with the
mouse, click the right
button while holding
down the left button.

5.

= Box mode allows you to select a rectangular section of text.

Edit Search Brouwse

Project Bun Options Window Help

1=[ 1]=————— D:\C?70\SOURCENSAMPLES\PWBTUTORNANNUITY1.C
s Print a summary of the annuity

V24

printf ¢ "~n\n"

#13.2f\n"
»#13.2f\n"
#13i\n"
#13.2f\n"
#13.2f\n"
#13.2f\n\n\n",

Vo4
¢/ Print headings of the amortization table.
b
printf( "Period Year Principal Interest\n"
" SV N

7’
/7 Loop on the number of periods, printing the period, year,

<KGeneral Help> <Fi=Help> <Alt=Menu>

When the starting column of the selection is the same as the ending column,

PWB selects the range of lines, just as it does for line selection mode.

Choose Box Mode from the Edit menu. Your screen should look like the pre-

ceding picture.
Press CTRL+N to indent the lines.

Pressing CTRL+N executes the Linsert function. When you have a box selected,
Linsert inserts spaces into the selected area. With no selection, Linsert inserts

a line above the cursor.

Now the printf format string and arguments are neatly aligned.
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Edit Search

Project Run Options Browse

/¢ Print headings of the amortization table.
v’
printf( "Period Year Principal Interest\n"

" ' )

I

|

<Generéllﬁelp> <F1=Help> <Alt=Menu>

Window Help

1=[  1]=——————= D:\C7OON\SOURCENSAMPLESN\PWBTUTORNANNUITY1.C
s7 Print a summary of the anmuity
<4
printf ( "\nsn"
“Principal: 7#13.2f\n"
"Interest Rate:  »#13.2f\n"
"Number of Years: #13i\n"
"Monthly Payment: #13.2f\n"
"Total Payments: x13.2f\n"
"Total Interest: #13.2fn\n\n",
Principal, Rate, Nper, Pmt,
Pmt = (float)Nper = 12.0,
Pmt = (float)Nper = 12.0 — Principal J:
o

7’ Ppnp on the number of periods, printing the period, year,

Searching for Text

You can improve readability by indenting statements within loops.

PWB’s search menu to find a for loop and indent it.

» To find the for loop:

1. From the Search menu, choose Find.
PWB displays the Find dialog box.
2. Type for in the Find Text text box.

Find
Find Text: [FOr--------coovrmmmii i
[ 1 Jog Search Qirection
(+) Firward
[ 1 Match Hase € ) [Hackward
[ 1 fegular Expression (UNIX) € ) Find Q11
[ 1 Jrap Around
<Files...>
B OK B <Cancel> < Jelp >

3. Click OK or press ENTER to locate the for statement.

You’ll now use

4. You’re still in box selection mode, so select the area between the for and the

terminating brace. Make the selection four characters wide.

5. Indent the block by pressing CTRL+N to execute the Linsert function.
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For more information on searching, see “Searching with PWB,” on page 85.

You’ve now learned the basics of editing and reformatting text. PWB has
many more commands for manipulating text. See Chapter 7, “Programmer’s
WorkBench Reference,” for details on all PWB functions.

2.5 Where to Go from Here

Now that you’ve created, built, and debugged a simple program, you’ve begun to
discover the power of PWB. In Chapter 3, “Managing Multimodule Programs,”
you learn how to create and manage projects with more than one source file.
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Managing Multimodule Programs Y o

This chapter expands on the work you did in Chapter 2 and explains how to build
and maintain multimodule programs using PWB’s integrated project-management
facilities. PWB offers a new, more efficient way to manage complex projects. You
organize and build your project entirely within PWB, using convenient menus and
dialog boxes instead of makefiles or batch files.

PWB stores the information needed to build and manage your program in two
files, the project makefile and the project status file. These are called the “project.”
When you open the project, PWB automatically configures itself to build your pro-
gram. To move from one project to another, you close one project and open
another.

3.1 Multimodule Program Example

In this chapter, you’ll learn to set up a multimodule project in PWB by building
COUNT.EXE, a three-module program. The COUNT program analyzes text files
and produces a statistical profile of the text.

The following modules make up COUNT.EXE:

Module Function

COUNT.C Program driver; contains main and calls all other routines.
COUNTBUE.C Analyzes text in the input buffer.

COUNTCH.C Analyzes a character.

The program also contains a common header file COUNT.H in addition to these
three source modules. Figure 3.1 shows the components of COUNT and how they
combine to build the executable file. Later in the tutorial, you will add the
SETARGV.OBJ object file.
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~ | countH
(" countoss ) (countsuros) ( COUNTCH.08J)

- { SLIBCE.LIB )

________ 1
1

Figure 3.1 The COUNT Project

To build COUNT.EXE, you need to compile the three source files and link the cor-
rect libraries. You also need to specify various options, such as the target operat-
ing environment. All this information is contained in the COUNT project.

Creating the Project
Start by creating a new project for COUNT. (If you have not started PWB, do so

now.)
» To create a new project:

1. From the Project menu, choose New Project.
PWB displays the New Project dialog box.

New Project
Froject Name: [----- - oo 1

Current Runtime Support: None
Current Project Template: Generic Options

<get Project Template...>

0K <Cancel> < Jelp >

Theexecutable 2. Type COUNT in the Project Name text box.

::: x:::x;?::( :hseon 3. Choose Set Project Template.

project. PWB displays the Set Project Template dialog box.
4. Select the following options:

= Runtime Support: C.
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5.

= Project Template: DOS EXE.
At this point, the Set Project Template dialog box should appear as follows:

Set Project Template
Runtime Support:

e

None
[
C++

b«

Pro ject Eemplates with Runtime Support for: C

—

Generic Options
DOS EXE

DOS Overlaid EXE
DOS p-code EXE
DOS COM

Current Runtime Support: None
Current Project Template: Generic Options

B Ok § <Cancel> < Jelp >

This initial specification tells PWB what you intend to build and is saved as
part of the project.

Choose OK to return to the New Project dialog box, and then choose OK.
PWRB displays the Edit Project dialog box for adding files to your new project.

The next section describes the types of files that can be added to the project. The
tutorial then continues by listing the example files to add to the list.

Contents of a Project

A project file list can contain the following files:

Source code files (.C, .CPP).

Object files (.OBJ).

Library files (.LIB).
Module-definition files (. DEF).
Resource-compiler source files (.RC).

These file types are all that are needed to create most DOS and Windows applica-
tions. Include files, such as STDIO.H, are not put in a project because they are not
primary components of a program build. PWB automatically adds the necessary
include files to your project. For more information on include files, see “Depen-
dencies in a Project” on page 45.
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To add the

files in one step,
type co=.c inthe
File Name text box
and press ENTER.
Then choose Add All.

Double-click a

file to add or remove it

from the list.

When you select the type of run-time support, PWB automatically specifies stan-
dard library files such as SLIBCE.LIB. Therefore, you do not need to add standard
library files to the project list.

» To add the COUNT files to your project:

1. Choose the files you want to add to the project from the File List box. In this
case, you’ll add COUNT.C, COUNTBUEF.C, and COUNTCH.C. These files
are located in the \C700\SOURCE\SAMPLES\PWBTUTOR directory. If you
installed Microsoft C/C++ in a directory other than C700, adjust the path
accordingly.

Edit Project

File Name: [EMOEERE - - - - 1

File flist: D:\C?0G\SOURCENSAMPLES\PWBTUTOR DJives ~ Dirs:

COUNT.C

COUNTBUF .C [-A-1

COUNTCH.C [-B-1
[-C-1

= -~

groject: ...\SAMPLES\PWBTUTOR\count .mak

COUNT.C _dd s Delete
COUNTBUF .C < o Top of List >
COUNTCH.C < @¥lear List >

< Tafaan >

[X] S3t Include Dependencies [X]1 [lgnore System Include Files

<Zave List> <Cancel> < Jelp >

You can scroll the File List box by clicking the scroll bars or by pressing the
arrow keys. For more information about using list boxes and other elements of
the PWB interface, see Chapter 4, “User Interface Details.”

2. For each file, select it and choose Add / Delete to add the file to the Project list
box.

3. Choose Save List when you have added all three files.

PWB uses the rules in the project template along with the list of files that you
just specified to scan the sources for include dependencies and to create the pro-
ject makefile. This process is described in the next section.

Now your project completely describes what you want to build (the project tem-
plate), the component source files, and the commands used to build the project.
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Dependencies in a Project

When you save the project, PWB generates a makefile from the project template,
files, and options you specified. This file also contains a list of instructions that are
interpreted by NMAKE. In addition, PWB generates the project status file, which
saves the project template, the editor state, and the build environment for the pro-
ject. For more information on the project status file, see “Project Status Files” on
page 138.

When you build the project, NMAKE examines the build rules in the project make-
file. These are rules that specify targets (such as an object or an executable file)
and the commands required to build them. For example, a rule for making a .OBJ
file from a .C file can be expressed as follows:

.c.obj:
CL /c $<

To reduce the amount of time builds take, NMAKE compiles or links only the
targets that are out-of-date with respect to their corresponding source file. This
process is simple if there is a one-to-one correspondence between sources and
targets. However, most programs use the #include directive to include definitions
or other program text. The object files must be made dependent not only on the
source file but also on the files that are used by the source file.

In the preceding section, you learned that you don’t add include (.H) files to your
project. When you save the project, PWB scans your source files looking for
#include directives and builds dependencies on these files. Therefore, NMAKE
recompiles a source file if you change a file that it includes.

Scanning for include files can take some time, especially when using the Windows
include files. Because these system include files rarely change, you can turn on the
Ignore System Include Files check box in the Edit Project dialog box. This pre-
vents PWB from scanning these include files for dependencies.

Building a Multimodule Program

Now that the project files are complete, you can build the program in the same
way you built the single-module program.

» To build a multimodule program:

1. You are starting on a new project, so you will want to use debug options for
the initial builds. Turn on the Use Debug Options option button in the Build
Options dialog box, as you did in “Setting Build Options” on page 19.
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2. From the Project menu, choose Build.

PWB displays a dialog box to inform you that build information has changed
because you altered the build options.

3. Choose Yes to rebuild your entire project.

As the program is built, PWB shows status messages about the progress of the
build. When the build completes, a dialog box displays a summary of any errors
encountered during the build process.

Note The Next Error command on the Project menu works the same for a multi-
module build as for a single-module build. Because errors in a multimodule build
can occur in different files, PWB automatically switches to the file that contains
the error.

In some cases, you will want to force a complete rebuild of your project by choos-
ing Rebuild All from the Project menu. The difference between Build and Rebuild
All is that Build compiles and links only out-of-date targets and Rebuild All com-
piles all targets, regardless of whether they are current.

Running the Program

Now that your program is built, you can test it from inside PWB.

» Torun COUNT:

1. From the Run menu, choose Program Arguments.

2. Type the name of a text file to pass to the COUNT program. The COUNT.C
source file is a good file to use.

3. Choose OK to set the program arguments. PWB saves the arguments so that
you can run or debug the program many times with the same command line.

4. From the Run menu, choose Execute.
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The results look like this:

File statistics for extra.txt

Bytes: 1029
Characters: 770
Letters: 649
Vowels: 233
Consonants: 416
Words: 141
Lines: 45
Sentences: 13
Words per sentence: 10.8
Letters per word: 4.6
Estimated symbols per word: 1.8

Press ENTER to return to PWB.

You have successfully created a multimodule project, built the program, and run
it, all from within the Programmer’s WorkBench. You can now leave PWB.

» Toleave PWB:

®=  From the File menu, choose Exit or press ALT+F4.

PWB saves your project and returns to the operating-system prompt. If you ran
PWB from Windows, PWB returns to Windows.

Creating a PWB project is an important first step. However, most of the time you
will be maintaining projects. The next section provides an overview of project
maintenance. The tutorial then continues with the COUNT project.

Project Maintenance

Once you have created a project, you may have to change it to reflect the changes
in your project organization. You can:

®  Add new file-inclusion directives to your source files.
= Add new source, object, or library files.

= Delete obsolete files.

= Move modules within the list.

= Change compiler and linker options.

= Change options for individual modules.
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When you add a new include directive to a source file, you add a new dependency
between files. For the most accurate builds, you need to regenerate include depen-
dencies for the project.

To regenerate include dependencies:

1. From the Project menu, choose Edit Project.
2. Turn on the Set Include Dependencies check box.
3. Choose Save List.

PWB regenerates the include dependencies for the entire project and rewrites
the project makefile.

To add new files to an existing project:

1. From the Project menu, choose Edit Project.
2. For each file that you want to add to the project:

a. Select the file from the File List box, or type the name of the file in the File
Name text box.

b. Choose the Add / Delete button to add the file.

3. Choose Save List to rewrite the project makefile, set up the dependencies, and
add the commands for the new files.

To see how to add the SETARGV.OBJ file to the COUNT project, see “Adding a
File to the Project” on page 50.

To delete files from a project:

1. From the Project menu, choose Edit Project.
2. For each file that you want to remove from the project:

a. Select the file from the File List box, or type the name of the file in the File
Name text box.

b. Choose the Add / Delete button to remove the file from the list.
3. Choose Save List.

With most programming languages, you won’t need to move modules within a pro-
ject. However, some languages or custom projects require files to be in a specific
order. If you’re programming in Basic, for example, you must place the main mod-
ule of your program at the top of the list. Unlike other languages, Basic does not
define an explicit name where execution begins. Entry to a Basic program is de-
fined by the first file in the list.
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» To move a file to the top of the project file list:

1. From the Project menu, choose Edit Project.
2. Select the file you want to move to the top of the list.
3. Choose the To Top of List button.

Using Existing Projects

To automatically
reopen the last project
whenever you start PWB,
set the Lastproject switch
to yes.

You’ll now use the COUNT project that you just created for further work.

During a PWB session, the project you open remains open unless you explicitly
change it. If you have not already started PWB, you should do so now. In
Windows, click the PWB icon in the Microsoft C/C++ program group.

If you are not compiling from within Windows, you can start PWB and open the
COUNT project from the operating-system command line by typing the command:

PWB /PP COUNT

If the COUNT project is the last project you had open in PWB, type the following
command:

PWB /PL
If you have already started PWB, open the project now.

To open the project from within PWB:

1. From the Project menu, choose Open Project.

2. Choose COUNT.MAK from the File List box or type COUNT in the Project
Name text box.

Open Project
roject Name: [COUNT.MAK----------oooooi 1

D :\CPOENSOURCENSAMPLES\PWBTUTOR

File Jist:

CNT.MAK

COUNT .MAK

EXTRA .MAK
OTHER .MAK

[ 1 Ise as a Non-PWB Makefile
[X] jjestore Window Layout

0K <Cancel> < Jelp >
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3. Choose OK

When you open the project, PWB restores the project’s environment, including:

®= The window layout with the window style, size, and position for each window.

m The file history—a list of open files for each window and the last cursor posi-
tion in each file.

= The last find string.
= The last replace string.

= The options that you used for the last find or find-and-replace operation, such
as regular expressions. See “Using Regular Expressions” on page 90 for more
information about regular expressions.

® The project template (for example, D0S EXE) and any customizations you have
made to the template such as changing the build type or a compiler or linker op-
tion.

® The command-line arguments for your program.
® All environment variables, including PATH, INCLUDE, LIB, and HELPFILES.

Note that you can customize the way PWB handles environment variables by
changing the Envcursave and Envprojsave switches. For more information,
see “Environment Variables” on page 137.

Note When you turn off the Restore Window Layout option, PWB does not re-
store the window layout, the find strings and options, or the file history. PWB
opens the project but keeps the same editor state as it had before you opened the
project.

Adding a File to the Project

As you develop a project, you will occasionally add new modules. For example,
you can add the object file SETARGV.OBJ to the COUNT project so that the
COUNT program accepts wildcards on the command line.

» To add SETARGV.OBJ to your project:

1. From the Project menu, choose Edit Project.

The file and directory navigation lists in this dialog box work in exactly the
same way as those in the Open File dialog box. Choose the parent directory
symbol (. .) in the Drives / Dirs list box to move up the directory tree. To move
down the tree, choose the destination directory.



Managing Multimodule Programs

51

To specify a
directory listed in an
environment variable
such as L1s, type
sL18: in the File Name
text box and press
ENTER.

2. Change to the directory that contains your C libraries.

Edit Project

Jile Name: [D:\C?0GNLIBNSETARGU.OBJ-------------ooomoo oo ]
File @ist: D:\C70e\LIB DJives / Dirs:
1
LNOCRTW.LIB MOVE.LIB ROMAN .FON 1
MGRAPHFA.LIB MOVETR.LIB  SCRIPT.FON [-A-1 [ |
MGRAPHFP .L1B OLDNAMES.LIB SDLLCEW.LIB [-B-1 @
MODERN.FON  PGCHART.LIB [EINCYIC VT [-C-1 1
1>

ﬁroject .\SAMPLES\PWBTUTORNCOUNT . MAK
COUNT.C M4 / Delete
COUNTBUF .C < o Top of List >
COUNTCH.C < Q§lear List >
S| < A all >

[ 1 S3t Include Dependencies [X] Ignore System Include Files

<Save List> <Cancel> < Jelp >

Notice that the directory displayed after the label File List reflects the
directory change.

3. Make sure the File Name text box contains *.* or *.0BJ.
4. Select SETARGV.OBIJ in the File List box.
5. Choose the Add / Delete button to add the file to the project.

6. Since SETARGV.OBJ is not a source file and cannot have include dependen-
cies, you can turn off the Set Include Dependencies check box. If this check

box is left on, PWB regenerates the dependencies for all the files in the project.

7. Choose Save List.

SETARGV.OBJ is now part of the project. However, if you build the program
now, the linker displays the message:

error L2044: __setargv : symbol multiply defined, use /NOE

The linker produces this error because SETARGV.OBJ redefines entry points in
the standard run-time library. You must change linker options to disable extended
dictionary searching (that is, use the /NOE option).

To change the linker options:

1. From the Options menu, choose LINK Options.
2. Choose Additional Global Options.
3. Turn on the No Extended Dictionary Search in the Library check box.
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4. Choose OK to close the Additional Global LINK Options dialog box.
5. Choose OK to close the LINK Options dialog box and use the new options.

You are now ready to build COUNT with the new command-line processing.

» To build the modified project:

1. From the Project menu, choose Rebuild All.
PWB displays the message:

Current directory is not the project directory.
Change to project directory?

You received this message because you changed the current directory to the
directory with the C libraries when you added SETARGV.OBJ.
2. Choose OK to switch to the project directory and build the project.

You can run the COUNT program as before by choosing Execute from the Run
menu. To see how the program works with the new command-line processing, you
can specify *.C as the argument.

Changing Compiler Options

Up to this point, you have used PWB’s default build options for all the examples.
These options are sufficient for many cases, but occasionally you will want to ad-
just them.

Suppose you decide to optimize the COUNT program for size to get the smallest
code possible regardless of the execution speed. Ordinarily, you don’t consider op-
timizations until your code has stabilized and you are ready to try a release build.
(A release build is normally a build with optimizations turned on and debugging
information turned off.)

» To specify a release build:

1. From the Options menu, choose Build Options.
PWRB displays the Build Options dialog box.
2. Choose Use Release Options.
3. Choose OK to accept your choice.
When you specify a release build, PWB does not change your debug options. For

more information on global options, debug options, and release options, see “Set-
ting Build Options” on page 19.
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Now that you have chosen a release build, you can set specific options that PWB
uses to create a release version of the program.

» To change compiler options to optimize for space:

1. From the Language Options cascaded menu on the Options menu, choose C

Compiler Options.

The C Compiler Options dialog box displays the following options that are com-
mon to both the release and debug builds (Global Options):

= Memory model
= Processor (type of CPU)
= (Calling convention

= Warning level

C Compiler Options

Global Options

Memory Jodel {rocessor Salling Convention
[[ ------- u_| 86286 - - - - - ]I—l I_[c ----------------- u_l

Farning Level

[ 1 Make Warning Jrrors Fatal

Global Options: /W2 /GZ /BATCH

< Additional Flobal Options...>

() Jebug Dptions

(+) Jelease Options

Debug [information
|—[Hone .............. ]l—l

< Dptimizations... >

< Jditional Release Options... >
Release Options: /0t -01 /0y ~De -0i ~Gs

§ o g

<Cancel> < Jelp >

At the bottom of the dialog box is a panel that shows options that are specific to
the current type of build. In this case, release options are being used. The de-
fault settings for a build were determined when you chose the project template.

Note You can choose the Debug Options button to view and set the options for
debug builds. However, this does not change the type of build that is performed
when you build the project. To set the type of build, choose Build Options from

the Options menu.
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ITY Press aurio to 1. Choose Optimizations.

choose Optimizations. PWB displays a dialog box in which you can specify release optimizations.

Release Optimization Options
General ——

( ) Dptimize for fiime
(+) Optimize for $pace
)

Qisable Optimization ———— Specific
[X] Boop Code Optimization
Inlining ——— [X]1 Merge Elnbal Expressions
¢ ) Sfppress Inlining [ 1 Jerge Local Expressions
(+) Allow EZplicit Inlining [ 1 Improve [Jloat Consistency
€ ) Pllow Automatic Inlining [X]1 Global [jegister Allocation
[ 1 Generate [ntrinsic Functions

Aliasing
) Assume Fo Aliasing
) Aliasing Only Across Falls
) All%w Aliasing

(
(
(

0K <Cancel> < Jelp >

2. Turn on the Optimize for Space option. PWB automatically turns off the
Optimize for Time option.

3. Choose OK to return to the C Compiler Options dialog box.

4. Choose OK to set the new options that you have selected.

The procedure you have just completed causes PWB to build an executable file
that is optimized for space the next time you choose Build or Rebuild from the
Project menu.

Changing Options for Individual Modules

Most of the modules in your system use the same build options. However, you
will occasionally need to modify the options for a single module. For example, if
the code size is critical on most modules but one module needs to be optimized for
speed, you can set your compiler options to optimize for space, which handles the
predominant case. You can then modify the options for the module that you want
to optimize for speed.

The example that follows shows how to customize your project to change the com-
piler options to optimize only COUNTCH.C for speed.
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First, set the compiler options for the most general case. For COUNT in this ex-
ample, the most general case is to optimize for space. (If you have been following
the tutorial, you did this in the previous section.)

Once you have set the options for the general case, you have to customize the pro-
ject to compile only COUNTCH.C with optimizations for time. To do this, you
manually edit the instructions in the project makefile for compiling COUNTCH.C.

To open COUNT.MAK for editing:

1. If the COUNT project is open, choose Close Project from the Project menu.

This step is important because you cannot edit a PWB makefile for a project
that is currently open.

2. Choose the Open command from the File menu and open the COUNT.MAK
file in the editor.

Find the rule for compiling COUNTCH.C:

COUNTCH.obj : COUNTCH.C
!TF $(DEBUG)

$(CC) /c $(CFLAGS_G) $(CFLAGS_D) /FoCOUNTCH.obj COUNTCH.C
'ELSE

$(CC) /c $(CFLAGS_G) $(CFLAGS_R) /FoCOUNTCH.obj COUNTCH.C
VENDIF

This rule contains a conditional statement with two commands. The first command
is for debug builds, and the second command is for release builds. You will edit
the second (release) command. The release command uses the following macros
defined earlier in the makefile:

Macro Definition

CcC The name of the C compiler
CFLAGS_G Global options for C compiles
CFLAGS_R Release options for C compiles

To optimize only COUNTCH.C for time, place the /Ot compiler option after
$ (CFLAGS_R). The resulting command is:

$(CC) /c $(CFLAGS_G) $(CFLAGS_R) /0t /FoCOUNTCH.obj COUNTCH.C
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There is no way to predict if the C option macros contain the /Os option, which
would turn off /Ot, or if they contain any other option. To handle this potential
problem, the new option must be placed at the end because the option specified
last takes precedence. The compiler options, such as /Ot, and NMAKE macros,
such as CFLAGS_G, are case sensitive and must appear exactly as shown.

Warning After this modification, PWB can still understand this makefile as a
PWB makefile. However, if you make changes beyond adding options to in-
dividual command lines, PWB may no longer recognize the file as a PWB make-
file. If this happens, you can delete the makefile and re-create it, or you can use it
as a non-PWB makefile. For more information on using non-PWB makefiles, see
“Using a Non-PWB Makefile” on page 61.

Save your changes to the makefile by choosing Save from the File menu. You can
now reopen the project and rebuild COUNT with the custom options.

3.2 The Program Build Process

This section explains the correspondence between projects and makefiles. This
process is relatively automatic. If you do nothing out of the ordinary, you will
never have to modify its default operation.

Most programmers encounter situations that require customized build options.
Read this section to understand how the utilities work with PWB. You can return
to this material when you have special requirements that are not handled by
PWB’s default build rules.

Figure 3.2 illustrates the PWB build process.
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Figure 3.2 The PWB Build Process

When you save your project by choosing the Save button in the Edit Project dialog
box, PWB uses the list of files along with the rules in the selected project template
to scan for dependencies and write the project makefile.
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When you choose the Build or Rebuild All command from the Project menu,
PWRB releases as much memory as possible and passes the makefile to NMAKE,
which builds the project.

NMAKE stops at the end of the first build step that produces an error (as opposed
to a warning) or at the end of a successful build. In either case, NMAKE returns
the results of the build to PWB along with a log of any errors and warnings. For
more information about NMAKE, see Chapter 18, “Managing Projects with
NMAKE.”

PWB saves the output of the build for you to view in the Build Results window
or to step through when you choose the Next Error (SHIFT+F3), Previous Error
(SHIFT+F4), and Goto Error commands on the Project menu. You can run the pro-
gram, set program arguments, and debug the program by choosing commands in
the Run menu.

If you have turned on the generation of browser information, PWB builds the
browser database when you build the program. Once you have a browser database,
you can use the commands in the Browse menu to navigate your program’s source
files and examine the structure of your program. For more information, see “Using
the Source Browser” on page 96.

Extending a PWB Project

Makefiles that are not written by PWB often contain utility targets that are not
used in the process of building the project itself. These targets are used to clean
up intermediate files, perform backups, process documentation, or automate other
tasks related to the project. You can extend a PWB makefile to perform these
kinds of tasks by adding new rules. These additional rules must be placed in a
special section of the project makefile.

In the following example you will add a section that creates a file with information
about the project. This file has the same base name as the project and the extension
.LST. It lists the files in the project and the major options used for the build. This
example section can be used with any PWB project.

Use the COUNT project to see how to add a custom section. If you have been fol-
lowing the tutorial, this project is already open in PWB.

To add a custom section to the PWB makefile:

1. From the Project menu, choose Close Project.

This step is crucial because PWB disables modification of the project makefile
until the project is closed or a different project is opened. (This restriction does
not apply to non-PWB project makefiles.)
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You can copy this
line from help. Type
ALT+A USI F1, and then
copy and paste into the
makefile.

This section
is in the example file
EXTRA.TXT.

2. From the File menu, choose the Open command and open the COUNT.MAK
file in the editor.

3. Press CTRL+END to move the cursor to the end of the makefile.

4. Type this comment line exactly as shown:

# << User_supplied_information >>

You must put the number sign (#) in column one and type the contents of the
line exactly as shown, including capitalization. Failing to type this line accu-
rately will make the project unrecognizable to PWB or allow PWB to change
your custom build information in unexpected ways.

NMAKE requires space between rules. Therefore, you should separate this line
from the lines above it by one blank line. Similarly, you should leave at least
one line between the separator and your custom build rules. For more informa-
tion about NMAKE and the syntax of makefiles, see Chapter 18, “Managing
Projects with NMAKE.”

This comment line is used by PWB as a separator. Anything above this com-
ment is regarded as belonging to PWB, and you should not edit the information
there. The exception is to add options to individual command lines, as de-
scribed in “Changing Options for Individual Modules” on page 54. Anything in
the makefile after the separator is your information, and PWB ignores it.
NMAKE, however, processes the entire file.

Now that you have a separator to show PWB where your custom information
starts, you can add the custom information. The separator and custom section is in-
cluded in the following text:

# << User_supplied_information >>

# Example 'user section' for PWB project makefiles,

# used in the PWB Tutorial.

i#

# NOTE: This is not a standalone makefile.

# Append this file to makefiles created by PWB.

i#

# This user section adds a new target to build a project
# listing that shows the build type, options, and a list
# of files in the project.

#

ITFNDEF PROJ
'ERROR Not a standalone makefile.
TENDIF
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LIl If PWB fails to
recognize your
customized project,
you may have typed
the separator
comment incorrectly.

>

!IF $(DEBUG)
BUILD_TYPE = debug

TELSE
BUILD_TYPE = release
TENDIF
# Project files and information-1ist target
i#
$(PROJ).I1st : $(PROJFILE)
@echo < Project Name: $(PROJ)
Build Type: $(BUILD_TYPE)

Program Arguments: $(RUNFLAGS)
Project Files
$(FILES: =~
)
C Compiler Options
Global: $(CFLAGS_G)
Debug: $(CFLAGS_D)
Release: $(CFLAGS_R)
Link Options
Global: $(LFLAGS_G)
Debug: $(LFLAGS_D)
Release: $(LFLAGS_R)
Debug Libraries: $(LLIBS_D)
Release Libraries: $(LLIBS_R)
<<KEEP

The custom section of a PWB makefile can use any of the information defined by
PWB. This example takes advantage of many macros defined by PWB. For ex-
ample, the PROJFILE macro, which contains the name of the project makefile, is
used as the dependent of the listing file so that the listing is rebuilt whenever the
project makefile changes.

In addition, this custom section uses many features of NMAKE including macros,
macro substitution, preprocessing directives, and inline files. For more informa-
tion about NMAKE and makefiles, see Chapter 18, “Managing Projects with
NMAKE.”

To rebuild using the custom options:
1. Choose Open Project from the Project menu and reopen the COUNT project.
2. From the Project menu, choose Build Target.

3. Type the name of the new target COUNT.LST in the Target text box, and then
choose OK.

PWB informs you that the build options have changed and asks if you want to
rebuild everything.

4. Choose Yes to confirm that you want to rebuild everything.
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To open afile The project information file that is created shows the project name, indicates

from the list, put the whether the build is a debug or release build, lists the files in the project, and lists
cursor on the first the compiler and linker options used for the build.

character of the name

and type ALT+A F10.

Using a Non-PWB Makefile

PWB makefiles are highly structured and stylized makefiles that are generated
from the rules in the project template and a list of files that you supply. Many pro-
jects have existing makefiles that PWB can’t read because they do not have this
stylized structure. These makefiles are called non-PWB or “foreign” makefiles.

You can still take advantage of many of PWB’s project features with non-PWB
makefiles. The features that cannot be used are shown as unavailable menu items.
Note that a PWB makefile is not required to use the Source Browser—all you
need to have is a browser database. For information on building a browser
database, see “Building Databases for Non-PWB Projects” on page 104 and Chap-
ter 21.

Before continuing, consider the following makefile, which builds a version of the
COUNT project:

i#

# CNT.MAK - A simple non-PWB makefile for building

# the PWB tutorial example program COUNT.EXE .

#

# NOTE: The LIBS macro assumes the default

# library name. If you have installed with different
# names, you must change the LIBS macro.

i#

#

# Macros

#

CC = cl

CFLAGS = /0c /qc

LFLAGS = /NOD:SLIBCE.LIB /NOE /NOI /EXE /FAR /PACKC
LINKER = Tink

0BJS = COUNT.0BJ COUNTBUF.OBJ COUNTCH.OBJ
STDOBJS = SETARGV.0BJ

LIBS = SLIBCE

#

# The "all" target.

# Building "all' builds COUNT.EXE.
#

all: COUNT.EXE
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i#

# The file suffixes NMAKE needs to "know" about
# for this project.

#

.SUFFIXES:

.SUFFIXES: .obj .c

#
# An inference rule to make an object file from a
# C source file.
#
.c.obj :
$(CC) /c $(CFLAGS) /Fos@ $<

#
# The description block for building COUNT.EXE
# from the object files and libraries.
#
COUNT.exe : $(0BJS)
$(LINKER) $(LFLAGS) $(0BJS) $(STDOBJS),$@,,$(LIBS);

# The 'clean' target. Delete intermediate files
# that might be clutter after a release build

i#

clean :
-del *.0bj
-del =*.bak
-del *.tmp
-del *.map

This makefile is written for NMAKE. Even though PWB cannot read it as a PWB
makefile, you can use CNT.MAK as a project makefile in PWB without having to
change it.

CNT.MAK defines two primary targets, all and clean. By default, NMAKE
builds the first target in your makefile. The first target is commonly called a11
and is used to build the main targets of a project. Other targets in the makefile are
used to build the a11 targets or describe additional functionality. For example,
the clean target in this makefile deletes some intermediate files from disk.

To use CNT.MAK in PWB:

1. From the Project menu, choose Open Project.

2. Select CNT.MAK.

3. Turn on the Use as a Non-PWB Makefile check box.
The Open Project dialog box appears.

4. Choose OK.
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Note A PWB makefile cannot be edited or modified when it is the open project.
However, PWB does not disable modification of non-PWB makefiles. You can
edit a non-PWB makefile, even when it belongs to the currently open project.

The LIBS macro in CNT.MAK assumes the default library name. If you have
installed with different names, or you want to use a different library, you must
change the LIBS macro to contain the name of the library you are using.

You can now use the Build, Rebuild All, and Build Target commands from the
Project menu. The Build and Rebuild All commands work as they do with a PWB
makefile by building the first target. However, the Language Options commands
and the LINK Options command on the Options menu are unavailable. You set
options by editing the makefile.

» To build the clean target:

1. From the Project menu, choose Build Target.

PWB displays the Build Target dialog box where you can specify the target
name(s).

2. Type clean in the Target text box.

3. Choose Build.
PWB builds the clean target instead of the first target in the makefile (in this
case, all).

When you close a non-PWB project, PWB saves the environment, window layout,
and file history just as it does for a PWB project.

3.3 Where to Go from Here

This concludes the PWB tutorial section of this manual. If you wish, you can leave
PWB by choosing Exit from the File menu (or by pressing ALT+F4).

Chapter 4, “User Interface Details,” explains how to start PWB, describes the ele-
ments of the user interface, and gives you an overview of the menus.

Chapter 5, “Advanced PWB Techniques,” explains search techniques (including
regular-expression searching), describes how to use the browser, and shows how
to write PWB macros.

Chapter 6, “Customizing PWB,” describes how to change the behavior of PWB to
suit your needs.

Chapter 7, “PWB Reference,” contains an alphabetical reference to PWB menus,
keys, functions, predefined macros, and switches.






User Interface Details

This chapter summarizes the PWB user interface. It contains:

General information on starting PWB.

Instructions on how to use elements of the PWB screen.
A description of the indicators on the status bar.

A summary of every PWB menu command.

Instructions on how to use menus and dialog boxes.

4.1 Starting PWB

You can start PWB in either of the following ways:

From the Windows Program Manager
From the operating-system command line

From the Command Line

» To start PWB from the command line:

At the operating-system prompt, type:
PWSB [[options]|[[filename]|
PWB starts with its default startup sequence.

For a complete list of PWB options and their meanings, see “PWB Command
Line” on page 141. Sometimes, you will want to modify the default startup
sequence. The following procedures are examples of how you can start PWB to
accommodate different circumstances.
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» To start PWB with an existing PWB project:
= Type PWB /PP project.mak

PWB opens the specified project and the files that you were working on with
the project.

» To start PWB with the project you used in your last session:
= Type PWB /PL

As with the previous option, the /PL option opens a project and arranges your
screen as it was when you left PWB.

» To start PWB quickly for editing a file such as CONFIG.SYS:

®m Type PWB /DAS /t CONFIG.SYS

This command suppresses autoloading of extensions and status files (/DAS). It
also tells PWB not to remember CONFIG.SYS for the next PWB session (/t
CONFIG.SYS).

Using the Windows Program Manager

Microsoft Windows offers features that can enhance program development, partic-
ularly if you plan to develop Windows applications. You can edit and build your
application in a “DOS Box” and then immediately run it under Windows.

When you install Microsoft C/C++ on a computer running Windows, the SETUP
program provides a PWB icon in the Microsoft C/C++ 7.0 Program Group and a
.PIF file for running PWB successfully under Windows. These files, PWB.ICO
and PWB.PIF, are located in the \C700\BIN directory (assuming you accepted the
default root directory name supplied by SETUP).

To start PWB under Windows, double-click the PWB icon.

You can add a Program Item to the Program Manager for each project you are
working on. Use the PIF editor to open PWB.PIF, and then choose Save As on the
File menu to create a .PIF file with the same base name as your project. Next, use
the Optional Parameters text box to specify the /PF or /PP options and the name of
the project makefile.
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Using the Windows File Manager

When programming, you are often concentrating on which file or project you want
to work on and would prefer that the computer provide the right tool for the job.
With the Windows File Manager, you can associate certain types of files with the
commands that operate on those files. Therefore, when you double-click the file-
name in the File Manager, the right tool starts with the correct command-line
options.

You can associate project makefiles (MAK files) with the PWB .PIF file. Double-
clicking a project makefile then starts PWB and opens that project, source files
and all.

» To associate PWB with .MAK files:
1. Select any file in the File Manager with the extension .MAK.
2. From the File menu, choose Associate.
3. Type the command PWB.PIF /PP in the dialog box. (Make sure that your
PWB.PIF file specifies a question mark (?) in the Optional Parameters text box.)

Now when you double-click a project makefile, the File Manager automatically
starts PWB, and PWB opens that project.

Note Be sure you have set your PATH, INIT, and TMP environment variables
prior to starting Windows so PWB can find all its files.

4.2 The PWB Screen

Figure 4.1 shows the PWB display. The table which follows it describes each of
the user interface elements.
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Menu bar l— Menu I- Window — Desktop

File Edit Sea'rch Project Run| Options Browse Window Help

Untitled. @02 ————
== Untitled.00} ——

LKF1=Help> <Alt=Menu>|<F6=Window> MP  OCN 0O0O5.001

Status bar |— lcon I— Scroll bars

Figure 4.1 User Interface Elements

Name Description

Menu bar Lists available menus.

Menu Lists PWB commands.

Desktop Background area.

Icon Displays a window in compact form.

Window Contains source code; displays Help, browser results, build results, or
error messages.

Scroll bars Change position in file or list.

Status bar Shows command buttons for the mouse and shortcut keys;

summarizes commands and file and keyboard status.
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Figure 4.2 shows a PWB window. The table which follows it describes each of a

window’s elements.

Close box
Window number

Window title

Minimize box
Maximize/restore box

= Untitled.001

Window border

Scroll up arrow

Page up area

Scroll box

Page down area

Scroll down arrow
Size area

Move bar

Figure 4.2 Window Elements

Name Description
Window border Moves window. Drag to move the window.
Close box Closes the window. Click to close the window.

Window number

Window title
Minimize box
Maximize/Restore box

Scroll up arrow
Page up area
Scroll box

Page down area
Scroll down arrow
Size area

Move bar

Identifies window. Press ALT+number to move to that
window.

Indicates window contents, a filename, or pseudofile title.
Shrinks window to an icon. Click to minimize the window.
Enlarges window to maximum size or restores window to its
original size.

Scrolls up by lines. Click to scroll up.

Scrolls up by pages. Click to page up.

Indicates relative position in the file. Drag to change
position.

Scrolls down by pages. Click to page down.

Scrolls down by lines. Click to scroll down.

Sizes window. Drag to size the window.

Moves window. Drag to move the window.
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Figure 4.3 shows the PWB status bar. The table which follows it describes each of
the status bar’s elements.

Message Area Status  Location
| I |
7 N
<Fi=Help> <Alt=Menu> <F6=Window> TRLMPAX OCN 00005 .001
Command buttons Column
Line and Noise

Figure 4.3 Status Bar Elements

Name

Description

Message area
Status

Location
Command buttons

Line

Column

Shows command buttons for the mouse and shortcut keys,
and summarizes commands.

Indicates current file, editor, and keyboard status, as
described in the following table.

Shows the location of the cursor in the file.

Show common commands and shortcut keys. Click the
button or press the key to execute the command.

Indicates the line at the cursor. When scanning a file during
a search or when loading a file, PWB displays the current
line in the line indicator as specified by the Noise switch.

Indicates the column at the cursor.

The status area of the status bar displays one of the following letters to indicate the

corresponding status.

Letter Description

ZAOX»vZEC® A

File is temporary and is not recorded in the PWB status file.
File is no-edit (read-only); modification is disabled.

Line endings in the file are linefeed characters only.

File is modified.

File is a pseudofile.

Meta prefix (F9) is active.

Macro recording is turned on.

Overtype mode is enabled. In insert mode, no indicator appears.
CAPS LOCK is on.

NUM LOCK is on.
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Figure 4.4 shows the Window menu with the PWB Windows cascaded menu

pulled down. The table which follows it describes each element of a menu.

Selection cursor ——

Cascaded menu ——4

Access key T

1= Menu
New l!
Close Ctrl+F4
Close All————— Menu command
Move Ctr1+F?
Size Ctr1+F8
Restore Ctrl+F5 = Shortcut key
Minimize Ctrl+F9
Maximize Ctrl+F10
Cascade F5
Tile Shift+F5
Arrange Alt+FS
Build Results PWB Windows
Search Results
lgrint Results
lecord
lipboard
p
o¥ser Output

Figure 4.4 PWB Menu Elements

Name

Description

Menu
Menu command

Shortcut key

Cascaded menu

Access key

Selection cursor

Displays a list of commands.

Executes the command. When the command is dimmed, it is
unavailable.

Executes the command directly and bypasses the use of the
menu. Press the key to execute the command.

Lists a group of related commands. The command for a
cascaded menu has a small right arrow after the command.
To open a cascaded menu, click the command or move the
selection cursor to the command and press the RIGHT
ARROW key. To close an open cascaded menu, press the
LEFT ARROW key.

Executes the command. Press the highlighted letter key to
execute the command.

Indicates the selected command. Press the UP ARROW and

DOWN ARROW keys to move the selection cursor. Press
ENTER to execute the command.
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4.3 PWB Menus

PWB commands are organized into menus; the menu names appear along the
menu bar at the top of the screen. When a menu or command is selected, PWB dis-
plays a brief description of the selected menu on the status bar. To get more infor-
mation about a menu or command, point the mouse cursor to the name and click
the right mouse button, or highlight the name by using the arrow keys and then
press Fl.

File

The File menu provides commands to open, close, and save files. You can switch
to any open PWB file or find a specific file on your disk. You can also print a
selection, a file, or a list of files.

Command Description

New Start a new file

Open Open an existing file

Find Locate a file or list of files on disk

Merge Merge one or more files into the current file
Next Open the next file in the list of files specified on the command line
Save Save the current file

Save As Save the current file with a different name

Save All Save all modified files

Close Close the current file

Print Print a selection, the current file, or a list of files
DOS Shell Temporarily exit to the operating-system

All Files List all open files in PWB

Exit Leave PWB
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Edit

The Edit menu provides commands to manipulate text, set the selection mode, and

record macros.

Command Description

Undo Reverse the effect of your recent edit

Redo Reverse the effect of the last Undo

Repeat Repeat the last edit

Cut Delete selected text and copy it to the clipboard

Copy Copy selected text to the clipboard

Paste Insert text from the clipboard

Delete Delete selected text without copying it to the clipboard

Set Anchor Save the current cursor position

Select To Anchor Select text from the anchor to the cursor

Stream Mode Set stream selection mode

Box Mode Set box selection mode

Line Mode Set line selection mode

Read Only Toggle the PWB no-edit state (to prevent accidental
modification or to allow modification)

Set Record Define a macro name and its shortcut key

Record On Record commands for a macro

Search

The Search menu provides commands to perform single-file and multifile text and
regular-expression searches. You can do single-file and multifile find-and-replace
operations. You can define and jump to marks or go to specific lines.

Command Description

Find Search for an occurrence of a text string or pattern
Replace Search for a string or pattern and replace it with another
Log Turn multifile searching on and off

Next Match Move to the next match

Previous Match Move to the previous match

Goto Match Go to the match at the cursor in the Search Results window
Goto Mark Move to a mark or line number

Define Mark Set a mark at the cursor

Set Mark File Open or create a mark file
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Project

Run

The Project menu provides commands to open and create projects, build a project
or selected targets in the project, and determine the location of build errors and

messages.

Command Description

Compile File Compile the current source file

Build Build the project

Rebuild All Build all files in the project (even those that have not been modified)

Build Target Build specific targets in the project

New Project Create a new project

Open Project Open an existing project

Edit Project Change the list of files in the project

Close Project Remove the current project from memory without changing its
contents

Next Error Move to the next error

Previous Error  Move to the previous error

Goto Error Move to the error at the cursor in the Build Results window

The Run menu provides commands to set arguments for the project’s program, run
and debug the program, run operating-system commands, and add or run custom
Run menu commands.

Command Description

Execute Run the current program

Program Arguments Specify commands passed to your program for Execute or
Debug

Debug Run CodeView for the current program

Run DOS Command Perform any single DOS task without exiting PWB
Customize Run Menu  Add commands to the Run menu

The custom commands that you add to the Run menu appear after the Customize
Run Menu command.
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Options

The Options menu provides commands to set environment variables for use within
PWB, customize the look and behavior of PWB, and assign keys to commands.
For projects, you can set the build type, customize the project template, and set
compiler and utility options.

Command Description

Environment Variables View and modify environment variables

Key Assignments Assign keys that invoke functions and macros

Editor Settings Change the setting of any PWB switch

Colors Change screen colors

Build Options Specify whether the program is built as a debug or
release version; specify a build directory

Project Templates Cascaded menu of commands for project templates

Language Options Cascaded menu of compiler options commands

The Project Templates cascaded menu provides the following commands to man-
age project templates:

Command Description

Set Project Template Changes the run-time support and project template
Customize Project Template = Modify the current project template

Save Custom Project Save the current template as a new, custom template
Template

Remove Custom Project Delete custom project templates

Template

The Language Options cascaded menu provides the following commands for
setting compiler options:

Command Description
C Compiler Options Set C compiler options
C++ Compiler Options Set C++ compiler options

Note Additional languages are listed when their PWB extension is loaded.
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The following commands appear when the utilities extension (PWBUTILS) is

loaded:

Command Description

LINK Options Set linker options for your project

NMAKE Options Set options for NMAKE when it builds the project
CodeView Options Set options for CodeView when debugging the project

The following command appears when the browser extension (PWBROWSE) is
loaded:

Command Description

Browse Options Define the way the Source Browser database is built

Browse

The Browse menu provides the commands for the PWB Source Browser. You can
select a browser database. You can jump to specific definitions or symbols in your
project and view complex relationships among program symbols. You can also
view your program as an outline, function-call tree, or class-inheritance tree.

Command Description

Open Custom Open a custom browser database, open the project database,
or save the current database

Goto Definition Locate the definition of any symbol in your source code

Goto Reference Locate the references to any name in the browser database

View Relationship Query the browser database

List References Display a list of functions that call each function and show

the use of each variable, type, macro, or class
Call Tree (Fwd/Rev) View which functions call other functions

Function Hierarchy Display a program outline
Module Outline Display an outline of program modules
Which Reference? Display a list of possible references for the ambiguous

reference at the cursor
Class Tree (Fwd/Rev) View the class inheritance tree

Class Hierarchy View the hierarchy of classes
Next Find the next definition or reference
Previous Find the previous definition or reference

Match Case Define whether or not browse queries are case sensitive
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Window

The Window menu provides commands to manipulate and navigate windows in

PWB.

Command Description

New Duplicate the active window

Close Close the active window

Close All Close all windows

Move Start window-moving mode for the active window

Size Start window-sizing mode for the active window

Restore Restore a minimized or maximized window to normal size

Minimize Shrink the active window to an icon

Maximize Enlarge windows to maximum size

Cascade Arrange windows to show all their titles

Tile Arrange windows so that none overlap

Arrange Organize windows in a useful configuration for viewing Help,
source code, and Build Results

PWB Windows Cascaded menu that lists the following special PWB windows:
PWB Window Description
Build Results View the results of builds
Search Results View the results of logged searches
Print Results View the results of print operations
Record View, edit, save recorded macros
Clipboard View the PWB clipboard
Help Access the Help system
Browser Output View the results of browser queries

1 windowl Move to window n.

5 window5

All Windows View a list of all open windows

The All Windows command does not appear until the full list of open windows is
too long to fit on the menu.
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Help

The Help menu contains commands to access the Microsoft Advisor Help system.
You can see the index or table of contents for the system, get context-sensitive
Help, and perform global plain-text searches in the Help.

Command Description

Index Display a list of available indexes

Contents Display a table of contents for each component of the Help
system

Topic Display Help about the itein or keyword ai the cursor

Help on Help Display information on how to use Help

Next Display the next Help screen that has the same name as the topic
you last viewed

Global Search Search all open Help files for a string or regular expression

Search Results View the results of the last global Help search

About Display the PWB copyright and version number

4.4 Executing Commands

PWB commands appear in menus and as “buttons.” You can execute these com-
mands in two ways:

®  With a Microsoft Mouse or any fully compatible pointing device

You perform mouse operations by “clicking”—moving the mouse cursor to the
specified item and briefly pressing the left mouse button. “Double-click” by
pressing the left button twice, quickly. Always use the left mouse button unless
specifically instructed otherwise.

= With the keyboard

4.5 Choosing Menu Commands

» To choose a menu command with the mouse:

1. Click the menu name to open the menu.
2. Click the command.

» To choose a menu command from the keyboard:

1. Press the ALT key to activate the menu bar.

2. Press the highlighted character in the menu name (such as F for File).
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Shortcut Keys

An alternative is:

1. Press the ALT key to activate the menu bar.

. Use the RIGHT ARROW and LEFT ARROW keys to select a menu.
. Press ENTER to open the menu.

H W N

. Press the highlighted character in the command name (such as S for Save in the
File menu), or use the UP ARROW and DOWN ARROW keys to select the command
and then press ENTER.

There are several ways to close an open menu without executing a command.

» To close a menu without executing a command:

m  Click outside of the menu.
= Press ESC.

® Press ALT twice.

When a menu command is dimmed (rather than black), it is unavailable. For ex-
ample, when no windows are open, the Close command on the File menu is un-
available. If a command you want to use is unavailable, you must perform some
other action or complete a pending action before you can invoke that command.

Some commands are followed by the names of keys or key combinations. Press
the shortcut key to execute the command immediately. You don’t have to go
through the menu. For example, press SHIFT+F2 to execute the Save command,
which saves the current file.

All menu commands with shortcut keys and many other menu commands invoke
predefined PWB macros to carry out their action. You can change the key or add
new shortcut keys for these commands by assigning a key to the predefined
macro. For a complete list of predefined macros and their corresponding menu
commands, see “Predefined PWB Macros” on page 222. For more information
on assigning keys, see “Changing Key Assignments” on page 119.

Many PWB functions have been assigned to keys besides those listed on the
menus. Choose the Key Assignments command on the Options menu to view a
list of functions and macros and their assigned keys.
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Buttons

Dialog Boxes

You can often execute commands by using buttons or boxes, which are areas of
the screen that perform an action when you click them or select them from the key-
board. For example, the rectangle at the upper-left corner of a window is the

“close box.” Clicking this box with the mouse closes the window.

A command name surrounded by angle brackets (< >) appearing on the status bar
or in a dialog box is a button. The following buttons are on the status bar when
you first start PWB:

<General Help> <Fl=Help> <Alt=Menu>

The General Help button brings up a screen that explains how to use the Help sys-
tem. The other two buttons remind you of PWB functions: F1 summons Help, and
ALT activates the menu bar. Clicking one of these buttons with the mouse performs
the same function as pressing the key.

When you have opened more than one window, PWB displays the following
buttons:

<Fl=Help> <Alt=Menu> <F6=Window>
Click the Window button or press F6 to move to the next window.

When a menu is selected or a dialog box is displayed, an informative message ap-
pears on the status bar. While PWB displays this message, no buttons are available
and clicking the status bar does nothing.

When a menu command is followed by an ellipsis (...), PWB needs more informa-
tion before executing the command. You enter this information in a dialog box
that appears when you choose the command.

Dialog boxes can contain any of the items in Figure 4.5.
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— Combo box |— Text box l— Option buttons
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L List box L Command button

Figure 4. 5 Dialog Box Elements

Option Button
A button that you select from a list of mutually exclusive choices. Click the one
you want, press its highlighted letter, or use the arrow keys to move among the
choices.

Text Box
An area in which you can type text. You can move the cursor within the text
box by clicking the location with the mouse or by pressing the LEFT ARROW and
RIGHT ARROW keys. You can toggle between insert and overtype mode by
pressing the INS key. To select text for deletion, click and drag the mouse over
the text or press SHIFT plus an arrow key. Press DEL to delete the text, or type
new text to replace the highlighted text.

List Box
A box displaying a list of information (such as the contents of the current disk
directory). If the number of items exceeds the visible area, click the scroll bar to
move through the list or press PGUP, PGDN, or the arrow keys. You can move to
the next item in the list that starts with a particular letter by typing that letter.

Combo Box
The combination of a text box and a drop-down list box. You can type the name
of an item in the text box or you can select it from the list.

To open the list, click the highlighted arrow, or press ALT+DOWN ARROW or
ALT+UP ARROW. You can then click the item or press the arrow keys to select the
item you want. You can also press the first letter of an item to select it. When
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you have selected an item, click the highlighted arrow or press ALT+DOWN
ARROW Or ALT+UP ARROW to close the list.

Command Button
A button within angle brackets (< >) that invokes a command. Choose the OK
button to accept the current options, or choose the Cancel button to exit the
dialog box without changing the current options. Choose the Help button to see
Help on the dialog box.

If one of the command buttons in a dialog box is highlighted, press ENTER to
execute that command. You can also click a command button to execute that
command. If a button contains an ellipsis (...), it indicates that another dialog
box will appear when you choose it.

Check Box
An on/off switch. If the box is empty, the option is turned off. If it contains the
letter X, the option is turned on. Click the box with the mouse, or press the
SPACEBAR or the UP ARROW and DOWN ARROW keys to toggle a check box on
and off.

Key Box
A pair of braces ({ }) that allows you to enter a key by pressing the key. The
key box is always followed by a text box where you can type the name of the
key.

When the cursor is in the key box (between the braces), most keys lose their
usual meaning, including ESC, F1, and the dialog box access keys. The key you
press is interpreted as the key to be specified. Only TAB, SHIFT+TAB, ENTER, and
NUMENTER retain their usual meaning. To specify one of these keys, type the
name in the text box.

Key box
———  Set Mdcro Record
Tome:: COQETREY - [ 1

ey Assignment: € ¥L0--- - -t 1
e g

[X] Flear First

0K <Cancel> < Jelp >

L Check box
Figure 4.6 Key Box and Check Box

Clicking a dialog-box item either selects it (a text box, for example) or toggles its
value (a check box or option button). You can also move among items with the
TAB and SHIFT+TAB keys.
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Dialog boxes usually contain access keys, identified by highlighted letters.
Pressing an access key is equivalent to clicking that item with the mouse or
moving to it by pressing TAB or SHIFT+TAB, and then pressing ENTER. Although
some access keys are uppercase and others lowercase, dialog boxes are not case
sensitive. Therefore, you can type either an uppercase or a lowercase character.

Note When the cursor is in a text box, access keys are interpreted as text. You
must press ALT along with the highlighted letter. Pressing ALT is also required in
list boxes because typing a letter by itself moves the cursor to the next item that
starts with that letter.






Advanced PWB Techniques

This chapter introduces you to some of the powerful features in the Programmer’s
WorkBench. It is not an exhaustive discussion of all the ways to use PWB. How-
ever, it can provide a starting point for you to begin your own investigation of
PWB using the information in the Microsoft Advisor and in Chapter 7, “Program-
mer’s WorkBench Reference.”

This chapter contains:

® Find and search-and-replace techniques, including marks and regular expres-
sions.

= How to use the PWB Source Browser.
= How to execute PWB functions and macros.

= An overview of PWB macros, macro recording, and the macro language.

5.1 Searching with PWB

PWB offers the following ways to search your files for information:

= Visually inspecting code, moving with the cursor or the PGUP and PGDN keys.
This method is most effective either when you are familiarizing yourself with
some old code or after you have switched from CodeView back to PWB and
want to examine the local impact of a proposed change.

m Searching with text strings. When you have a specific string in mind (for ex-
ample, FileName), you can find, in sequence, all the references to the name in
your file.

m Searching with regular expressions. Regular expressions describe patterns of
text. This is useful when you have a number of similarly named program sym-
bols and you’d like to see them all in succession.

For example, Windows API (application programming interface) names are
made up of multiple words; the start of each new word is shown as a capital
letter (for example, GetTextMetrics). With this in mind, you might search for
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a string optionally starting with spaces and the letters “GetText” followed by
any uppercase letter. This is expressed with a regular expression such as
*GetText[A-Z], which means zero or more spaces (using the * operator after

a space), followed by GetText, followed by any uppercase letter (using a char-
acter class).

= Searching multiple files with text strings or regular expressions. A multifile
search is called a “logged search.” Instead of finding one match, PWB finds all
matches in one operation. You can then browse the results of the search.

® Using the Source Browser. The Source Browser enables you to perform faster

and more sophisticated searches than plain text searches becausc it maintains a

complete database of relationships between program symbols. For example, to
find all occurrences of FileName in your entire program (regardless of the num-
ber of files in the program), you can use the View References command from
the Browse menu.

The Source Browser has many more capabilities than just finding symbols. It
can also produce call trees and perform sophisticated queries on the use-and-
definition relationships among functions, variables, and classes in your program.

These searching techniques are discussed in detail in the following sections.

Searching by Visual Inspection

You can also use
marks when you are
writing new code and
want to come back and
fill in sections.

If you think you’re close to the text you want to see, don’t try a fancy search—use
the PGUP or PGDN key. It’s often faster. One trick you can use to speed up this
method of searching is to leave a trail in the form of marks (names associated with
file locations).

Using Marks

PWRB lets you set named marks at any location in your file by using the Define
Mark command from the Search menu or by using the Mark function. You can
access these locations by name using the Goto Mark command or the Mark
function.

For example, if you are revising a preexisting program and don’t fully understand
all the algorithms, you might leave a mark at each location in the code you want to
examine more closely. That way, you can revise the sections of the program that
you do understand, get a feel for the flow of the program, and then come back to
the marked areas for further research.

To save marks between PWB sessions, create a mark file using the Set Mark File
command from the Search menu.
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Using the Find Command

The searching
functions are named
Psearch (F3) and
Msearch (F4).

LiIi@ The multifile
searching function is
named Mgrep (not
assigned).

The Find command on the Search menu allows you to search a file using text
strings and regular expressions.

Find can help you locate any string of text in any file you specify. PWB usually
searches the file you are currently editing. However, it can also search a list of
files. This is particularly useful for finding all occurrences of a string in an entire
project.

The results of a multifile search are logged—that is—put into the Search Results
window. To see the logged results of a search, choose Search Results from the
PWB Windows cascaded menu. There are two ways to use the information that
PWB puts into Search Results:

® You can look at the matches in sequence by choosing Next Match and Previous
Match from the Search menu.

® You can go directly to a specific match by moving the cursor to the match
listed in the Search Results window and choosing Goto Match from the Search
menu. PWB then jumps to the location of the match.

The Match commands on the Search menu work with the Search Results window
in exactly the same way that the Project menu’s Next Error, Previous Error, and
Goto Error commands work with the Build Results window. These Project menu
commands are described in “Fixing Build Errors” on page 24.

To illustrate the logged-search technique, suppose you want to locate all functions
returning an int in the COUNT project’s source files.

To search all the source files in this project:

1. From the Search menu, choose Find.
PWB brings up the Find dialog box.

2. Turn on Log Search check box.

3. Type int inlowercase.

4. Select the Match Case check box to exclude uppercase or mixed case occur-
rences of the word.

5. Choose the Files button.
PWB brings up the Search In Selected Files dialog box.
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Search in selected files

File Name: [FEERE- - - 1

File @ist: D:\C?OG\SOURCENSAMPLES\PWBTUTOR

COUNT.C
COUNTBUF .C
COUNTCH.C

File(s) Selected:

Kdd / Deletef

<8lear List>

<Add Fattern>

< 0K > <Cancel> < Jelp >

Tospeciyapath 6. Type C0+.C in the File Name text box.
o e neLupe ™" This wildcard specifies all filenames beginning with €0 and having the .c

specify $INCLUDE: (the extension.

environmentvariable 7 Choose the Add Pattern button to add the wildcard to the file list.

must be in all caps.) L. .
8. Return to the File Name text box by clicking the box or by pressing ALT+F.
9. Type COUNT.H in the File Name text box.

Because the default button is Add / Delete, you can press ENTER to add
COUNT.H to the file list.

10. Add COUNT.H to the list.
11. Choose OK to start the search.

When PWB finishes the search, it displays the Log Search Complete dialog box.
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Open the

Search Results
window to see an
overview of all
matches from the
search.

Log Search Complete
Search for “int"

2?7 occurrences found

iew Resultsf <Cancel> < Jelp >

From this dialog box you can:
® Choose View Results to open the Search Results window.

= Choose Cancel to close the dialog box.

Choose Cancel now (you will open the Search Results window later).

» To go to the first match:

= From the Search menu, choose Next Match.

You can step sequentially through all occurrences of the string using the Next
Match command. Choose Previous Match to move to the previous occurrence of
the string. When you reach the end of Search Results, PWB displays the following
message:

End of Search Results

Sometimes, you cannot focus the search narrowly enough to make a sequential
scan of Search Results profitable. In this example, you wanted only functions re-
turning int, but PWB found many more occurrences of int. In these cases, you can
examine the results of the search and skip the matches that aren’t relevant.

» To view the Search Results:

= From the PWB Windows cascaded menu on the Window menu, choose Search
Results. PWB opens the Search Results window.

In this window, PWB displays the file, line, and column where the string was lo-
cated. It also shows as much of the matching line as will fit in the window.
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File Edit Search Project Run Options Browse Window Help
=L 21 Search Results i
\C?OONSOURCENSAMPLES\PWBTUTOR] Search int
CENSAMPLES\NPWETUTORN\COUNTBUF .C 6 33: /- (A character is defined as printable A
CENSAMPLESN\NPWETUTORNCOUNTBUF .C 11 31: FLAG CountWords( FLAG InWord, int nCharsf
CENSAMPLESN\PWBTUTORNCOUNTBUF.C 13 5: int Scan;
CENSAMPLESNPWBTUTORNCOUNT.C 25 1: int main( int argc, char sargull );
CENSAMPLESSPWETUTORNCOUNT.C 25 11: int main( int argc, char sargvll ):
CENSAMPLESNPWBTUTORNCOUNT.C 26 1: int CountFile( char sname ):
CENSAMPLESNPWETUTORNCOUNT.C 29 1: int main( int argc, char sargull )
CEMSAMPLESNPWBTUTORNCOUNT.C 29 11: int main( int argc, char =argul] )
CENSAMPLES\PWBTUTORNCOUNT.C 32 5: int curfirg:
CENSAMPLES\PWBTUTORNCOUNT.C 54 11: printf ¢ "sn\nEnter file name: " ):
CENSAMPLES\PWBTUTORNCOUNT.C 64 1: int CountFile( char »name )
CENSAMPLES\PWBTUTORNCOUNT.C 67 5: int nMax:
CENSAMPLESN\PWBTUTORNCOUNT.C 73 11 printf ( "~nCan’t open xs\n", name )
CENSAMPLESNPWETUTORNCOUNT .C 82 24 ¢/ Calculate and print the results.
CENSAMPLES\PWETUTORNCOUNT.C 83 7: printf ( "sn\nFile statistics for “s\n\n"|

?:

?

?

?

7

CENSAMPLESNPWBTUTORNCOUNT.C 84 printf ¢ "\tBytes: #61d\n", Bytes ):
CENSAMPLESSPWBTUTORNCOUNT .C 85 printf ( "N\tCharacters: »#6ld\n", Characte|
CENSAMPLESNPWETUTORNCOUNT.C 86 printf ( “~tLetters: #6ld\n"”, Letters |
CENSAMPLESNPWBTUTORNCOUNT .C 87 printf ( "\tUowels: 76ld\n"”, Uowels )

CENSAMPLESNPWBTUTORNCOUNT .C 88 printf(

761dsn”, Letters

"\tCansona.nts :

3 =

00001 628

(Fl=Help> <Alt=Mems> <Fo-Window>

For example, if the declaration you want is the one that declares CountWords, you
can jump directly to that location.

» To jump directly to a match:

1. Put the cursor on the match.
2. From the Search menu, choose Set Match.

PWB opens the correct file if it is not already open and positions the cursor on
the text you located.

You can use multifile searching regardless of whether the files that you want to
search are open in PWB. For example, you can search $INCLUDE:*.H (all the head-
ers on the INCLUDE path) for a particular prototype.

Using Regular Expressions

The PWB searching capabilities that you have used so far are useful when you
know the exact text you are looking for. Sometimes, however, you have only part
of the information that you want to match (for example, the beginning or end of
the string), or you want to find a wider range of information. In such cases, you
can use regular expressions.

Regular expressions are a notation for specifying patterns of text, as opposed to
exact strings of characters. The notation uses literal characters and metacharacters.
Every character that does not have special meaning in the regular-expression syn-
tax is a literal character and matches an occurrence of that character. For example,
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letters and numbers are literal characters. A metacharacter is an operator or
delimiter in the regular-expression syntax. For example, the backslash (\) and
the asterisk (*) are metacharacters.

PWB supports two syntaxes for regular expressions: UNIX and non-UNIX. Each
syntax has its own set of metacharacters. The UNIX metacharacters are .\[]#+§.
The non-UNIX metacharacters are ?\[1#+~$@#(){}. Because it uses fewer meta-
characters, the UNIX form is a little more verbose. However, it is more familiar to
programmers who have experience with UNIX tools such as awk and grep. This
book uses the UNIX syntax, but any expression that can be written with this syn-
tax can also be written with the non-UNIX syntax.

The regular-expression syntax used by PWB depends on the setting of the Unixre
switch (UNIX is the default). You can change the Unixre switch by using the Edi-
tor Settings dialog box.

Note PWB switches that take regular expressions always use UNIX syntax. They
are independent from the Unixre switch.

Finding Text

In the multifile searching example, you learned how to locate every occurrence of
int in the COUNT project. In a large project, finding every int would yield too
many matches. To narrow the search, you can use a regular expression.

For this example, you want to match declarations of functions returning int. You
can specify this with a regular expression. This expression matches text that:

= Begins at the start of the line

= Followed by the keyword int

= Followed by white space

= Followed by an identifier

= Followed by any text within parentheses

The syntax for this regular expression is shown in Figure 5.1.

rnt\:bla-zA-Z0-9_]+(.*)
1 2 3 4

Figure 5.1 Regular Expression Example
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It illustrates the following important features of regular expressions:

1. Regular expressions can contain literal text. In this example, int is literal text
and is matched exactly.

2. Regular expressions can contain predefined regular expressions. Here, \:b is
shorthand for a pattern that matches one or more spaces or tabs (that is, white
space). For a complete list of predefined regular expressions, see Appendix A.

3. You can use classes of characters in regular expressions. A class matches any
one character in the class. For example, the class [a-zA-Z0-9_1 is the class of
characters that contains all lowercase and uppercase letters and all digits plus
the underscore. The dash () defines a range of characters in a class.

4. The plus sign (+) after the class instructs PWB to look for one or more occur-
rences of any of the characters in the class. This is the key to regular expres-
sions. You don’t have to know exactly what appears between int and the left
parenthesis; all you have to do is describe what can be there.

The pattern ~int\:b[a-zA-Z0-9_1+(.*) matches strings such as

int CountWords( void )
int 2BadCIdentifiers()

but not the strings

int ( char *t )
integer(val)

Figure 5.2 shows a more detailed way to write an expression that matches the dec-
laration of a function returning an int.

A xint\:b[a-zA-Z_]1[a-zA-Z_0-9$]+ *(.*)

T T 171

123 4 78910
Figure 5.2 Complex Regular Expression Example

This expression is close to the C-language definition for the syntax of the declara-
tion. It is more precise than most searches require, but it is useful as an illustration
of how to write a complex regular expression.

You can interpret this expression as follows:

1. Start at beginning of line, which is specified by a caret (*) at the beginning of
the regular expression.
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Tomatcha C
identifier, use the \:i
predefined expression.

2. Skip leading optional spaces. To specify optional items, this expression
matches zero or more occurrences by using the asterisk (*) operator. The
expression “ *” means “match zero or more spaces.”

Look for the int keyword as literal text.
Skip white space. There must be at least one space or tab.
Look for exactly one alphabetic character or underscore.

A

Look for any characters that are alphabetic, numeric, an underscore (_), or a
dollar sign ($). This and the previous part of the expression guarantee that the
identifier conforms to the Microsoft C definition of an identifier.

7. Skip optional spaces.
8. Look for a left parenthesis.
9. Skip zero or more of any character.

10. Look for a right parenthesis.
This expression is exact to the point that it takes longer to write than the time it
saves. The key to using regular expressions effectively is determining the minimal
characteristics that make the text qualify as a match. For example, it’s probably
not necessary that the text between the space and the left parenthesis be a valid C

identifier to qualify as a match. Any sequence of alphanumeric characters or under-
scores is usually sufficient.

To find all function declarations that return an int:

From the Search menu, choose Find.

In the Find Text box, type ~int\:b\:i(.

Select the Regular Expression check box.

Choose the Files button.

Add the pattern CO*.C and the file COUNT.H to the file list.
Choose OK to start the search.

S i

When the search is complete, choose View Results. You can see in the Search
Results window that PWB matched only the function declarations.

Replacing Text

You can use regular expressions when changing text to achieve some extremely
powerful results. A regular expression replacement can be a simple one-to-one
replacement, or it can use “tagged” expressions. A tagged expression marks part
of the matched text so that you can copy it into the replacement text.



94 Environment and Tools

A simpler

way to get a list of
files is to type Arg
wildcard Openfile
(ALT+A wildcard F10).

Any time you
need a quick reference
to regular expressions,
type ALT:A regex F1.

For example, you can manipulate lists of files easily using regular expressions.
This exercise shows how to get a clean list of files that is stripped of the size and
time-stamp information.

» To get a clean list of C files in the current directory:

1. From the File menu, choose New.
This gives you a new file for the directory listing.
2. Execute the function sequence Arg Arg !dir *.c Paste.

The default key sequence for this command is to press ALT+A twice, type
Idir *.c, then press SHIFT+INS.

Arg Arg introduces a text argument to the Paste function with an Arg count
of two. The exclamation point (!) designates the text argument to be run as
an operating-system command. Without the exclamation point, the text is the
name of a file to be merged. If only one Arg is used, PWB inserts the text
argument.

PWB runs the DIR command and captures the output. When the DIR com-
mand is complete, PWB prompts you to press a key. When you press a key,
PWB then inserts the results of the command at the cursor. For more informa-
tion about this and other forms of the Paste function, see “Paste” in Chapter 7,
“Programmer’s WorkBench Reference.”

3. From the Search menu, choose Replace.
4. In the Find Text box, type \:b\:z \:z-.*$
This pattern means:
= White space followed by
= A number followed by
= Exactly one space followed by
= A number followed by
= A dash (-) followed by
= Any sequence of characters, then
= End of the line

This string must be tied to the end of the line to prevent the search from finding
anything too close to the beginning of the line.

5. Make sure there are no characters in the Replace Text text box.
6. Choose Replace All.

PWB prompts you to verify that you want to replace text with an empty string.
7. Choose OK to confirm that you want to perform the empty replacement.
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To type a literal
tab character in a dialog

box, use the Quote
function by pressing
CTRL+P TAB.

All the file-size, date, and time-stamp information is removed. Because you did
not reuse any of the original text in the replacement, this is a simple regular expres-
sion replacement.

Choose Close from the File menu to discard the text you created in the previous
exercise.

A more complicated task is backing up the C files to a directory called LAST,
which is assumed to be a subdirectory of the current directory. A batch file makes
this easier. You can create such a batch file using regular expressions.

To create a batch file that copies the C files to a subdirectory:

1.

Create a list of C files in the current directory as described in the previous
example, but do not remove the file sizes, dates, and times.

2. Delete the heading printed by the DIR command.

7.

. From the Search menu, choose Replace.
. In the Find Text text box, type:

ANCEY THOT IR T+ o

. This expression finds a string that starts at the beginning of the line (*). Placing

parts of the expression inside the delimiters \( and \) is called “tagging.”

The first tagged expression (\([* ]+\)) matches one or more characters that are
not spaces. A leading caret in a class means “not.”

The pattern then matches one or more spaces ([ ]+), followed by the second
tagged expression which matches one or more characters that are not spaces.

The remainder of the line is matched by the wildcard (.), which matches any
character, and the repeat operator (*). Matching the rest of the line is important
because that is how this pattern removes everything after the filename. It dis-
cards these portions of the matched text.

. In the Replace Text text box, type

COPY \1.\2 .\\LAST

Select Replace All and click OK to begin the find-and-replace operation.

PWB transforms each directory entry into a command to copy the file to the LAST
subdirectory.
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File Edit EIZiCe W Project Run Options Browse Window Help
=[ 2] Untitled.00Z 14|2

copy COUNTBUF.C .\LAST
copy COUNTCH.C .NLAST
copy COUNT.C .\LAST
copy ANNUITY1.C .\LAST
4 file(s) 6437 bytes
20635648 bytes free

4 occurrences replaced

8 ok §

e g

[F1=He ps

iy

Enter Esc=Cancel Tab=Next Field N 60001 .001

The word COPY is inserted literally. The text matched in the first tagged expres-
sion (the base name) replaces the expression \1. The period is inserted literally.
The text matched by the second tagged expression (the filename extension)
replaces the expression \2. The space is inserted literally. The text .\\LAST is
inserted as .\LAST. Be sure to use two backslashes to indicate a literal backslash;
otherwise, PWB expects a reference to a tagged expression such as \1 and dis-
plays an error message.

You’ll notice that the last two lines of the file are not useful in your batch file.
They are the remnants of the summary statistics produced by the DIR command.
Delete these two lines and you have a finished batch file.

Using the Source Browser

Another search technique is “browsing.” Browsing uses information generated by
the compiler to help you find pieces of code quickly. This section introduces you

to some of the capabilties of the Source Browser. The browser is a handy tool for
moving about in projects, large and small.

In addition to navigating through your program, you can use the browser to ex-
plore the relationships between parts of the project. The browser database contains
full information about where each symbol is defined and used and about the rela-
tionships among modules, constants, macros, variables, functions, and classes.
Note that the browser files can be very large.
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Note This section uses the COUNT project you created in Chapter 3. If you did
not create this project or if you have since deleted it, you must create it now. For
instructions on how to create the COUNT project, see “Creating the Project,” on
page 42.

Creating a Browser Database

Before you can use the PWB Source Browser, you must build a browser database.
PWB helps you maintain this database automatically as a part of a normal project
build.

To build a browser database:

1. Open the COUNT project using the Open Project command from the Project
menu.

2. From the Options menu, choose Browse Options.

PWRB displays the Browse Options dialog box.

Browse Options
[X] Generate Jrowse Information

[ 1 Exclude Jacro Expanded Symbols

[ 1 Exclude System Include Files

[ 1 Include Inreferenced Symbols

[X] Fack .SBR files

Paditional Options  [-------eoeooomnoan ]

< Exclude Files... >

OK <Cancel> < Jelp >

3. Turn on the Generate Browse Information check box.
4. Choose OK.

The browser changes the project makefile to build the project. It adds compiler
options for creating browser information (.SBR files). It includes a BSCMAKE
command which combines the .SBR files and creates a browser database (a
.BSC file).

5. From the Project menu, choose Rebuild All.

Rebuilding the entire project ensures that the database contains up-to-date infor-
mation for all files in your program.
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When the build completes, the following new files are on your disk:

COUNT.BSC, the browser database

COUNTBUF.SBR, a zero-length “placeholder” for COUNTBUF.
COUNTCH.SBR, a placeholder for COUNTCH.

COUNT.SBR, a placeholder for COUNT.

After adding each .SBR file’s contribution to the database, BSCMAKE truncates
it and leaves the empty .SBR file on disk to provide an up-to-date target for later
builds. Leaving these files on the disk ensures that a browser database is not re-
built unless it is out-of-date with respect to its source files.

A PWB project is not required to create a browser database (although it is con-
venient). For information on how to build a browser database for non-PWB pro-
jects, see “Building Databases for Non-PWB Projects” on page 104.

Finding Symbol Definitions

When you are working on a program, it’s easy to forget where a particular varia-
ble, constant, or function is defined. You can use the Find command to locate oc-
currences of a symbol, but that offers little information about which one is the
definition. To make such searches easier, you can choose Goto Definition from the
Browse menu to jump directly to the definition of any symbol in your program.

The following procedure uses the COUNT project to demonstrate how powerful
the browser can be.

To go to the definition of CountWords:

1. From the Window menu, choose Close All.

2. Open COUNT.C.

3. Move the cursor to the CountWords call on line 80.

4. From the Browse menu, choose Goto Definition.
PWB displays the Goto Definition dialog box.
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Goto Definition

T R ount Word s T 1
Pl gliCountlords|

File:

Nmes DEfined in:

COUNTBUF.C (12)

Countlords
curfirg
curChar
curCode
clUouwels
cllords
FACTOR
FALSE
fclose
FILE
File

B 0K B <Cancel> < Jelp >

Notice that CountWords is highlighted and the defining file’s name is displayed
in the list box to the right. More than one defining file is listed if a name is de-
fined in several scopes.

5. Choose OK.
PWB opens COUNTBUF.C and shows the definition of CountWords.

Showing the Call Tree

Often when analyzing an existing program’s flow, or when looking for opportu-
nities for optimization, it’s useful to refer to a “call tree.” A call tree is a view of
your program that provides, for each function, a list of other functions called.

» To generate a call tree of COUNT:

1. From the Browse menu, choose Call Tree.
PWB displays the Display Tree dialog box.
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To jump directly
to the definition of a
name, place the cursor
on the name and
choose Goto Definition

from the Browse menu.

Display Tree

AME: Lo 1
Jodules: Gunctions:

COUNT.C CountFile

COUNTBUF .C main

COUNTCH.C Syllables

<Unknown>

1

[ 1 Qeverse Tree 0K <Cancel> < Jelp >

2. Choose COUNT.C from the Modules list box.

Notice that the Functions list box changes to show only the functions in
COUNT.C.

3. Choose OK to see the call tree.

The call tree for COUNT.C is as follows:

CountFile
+-fopen?
+-printf[13]?
+-fread?
+-CountWords

| +-Analyze[2]

|  +-strchr[3]?
+-fclose?

main
+-CountFile[2]...
+-printf?
+-gets?
Syllables

Three kinds of annotations appear in the call tree:

17
A symbol followed by a question mark is used by your program but not defined
in any of the program files in the browse database. These are often library func-
tions.

(]
The number n between square brackets shows symbols that are used more than
once. In the preceding example, CountFile is shown as:

CountFile[2]
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This means that there are two references to CountFile in main.

... (ellipsis)
The ellipsis means that the full information for the function appears elsewhere
in the call tree.

Finding Unreferenced Symbols

As you write your program, you will occasionally remove function calls or refer-
ences to global variables. This can leave unused code in your program or make the
program’s data larger than it needs to be. The browser database contains informa-
tion about where every function and variable is referenced, so you can easily find
the ones that are not used.

The COUNT project that you have been working with contains an unused function
and an unreferenced global variable. This section shows how to use the Source
Browser to find and remove the extra code and data.

The system include files define many more functions than many programs use.
Therefore, unreferenced functions in your program are easiest to find when using
a browser database that does not contain the system include files. This example
begins by building a browser database for COUNT that does not contain informa-
tion defined by system include files.

To build the COUNT browser database:

1. Make sure that debug options are turned on. Debug options select the fast com-
piler and do not generate intrinsic functions. If you perform a release build
which generates intrinsics, you will find many unused intrinsic functions de-
fined by the compiler. For information on how to select debug options, see
“Setting Build Options” on page 19.

2. From the Options menu, choose Browse Options.
PWRB displays the Browse Options dialog box.

3. In the Browse Options dialog box, turn on the Exclude System Include Files
and the Include Unreferenced Symbols check boxes.

4. Choose OK.

Now that the browse options are set, rebuild the project and browser database by
choosing Rebuild All from the Project menu. With the updated browser database,
you can obtain a list of references for functions and variables.
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P> To get a list of references for function and variables:

1. From the Browse menu, choose List References.
PWB displays the List References dialog box.

List References

Show only: [X] ?mcticms
[X] Jariables
[1 “Jpes
[ 1 jacros
[ 1 Slasses

0K <Cancel> < Jelp >

2. Turn on the Functions and Variables options, and then choose OK.

PWB opens the Browser Output window and creates the list of references. Each
name is followed by a colon and a list of functions that refer to the name.

FUNCTION CALLED BY LIST
Analyze: CountWords[2]
CountFile: main[2]
CountWords: CountFile
fclose: CountFile
fopen: CountFile
fread: CountFile
gets: main
main:
printf: main CountFile[13]
strchr: Analyze[3]
Syllables:

» To find an unreferenced symbol:

m Search for the regular expression :$ (colon, dollar sign).

This pattern specifies a colon at the end of the line. It finds names that are fol-
lowed by an empty list of references.

PWB positions you at the first unreferenced name (main) in the Browser Output
window. The function main must be kept in the program, so you want the next
unreferenced name.

To find all unreferenced items with one search, you can perform a logged search
and add only <browse> (the Browser Output pseudofile) to the file list. This is
especially useful for large projects. Because there are only two unused symbols in
the COUNT project, it is simpler to repeat the search.
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» To find the next unreferenced symbol:

= Execute the Psearch function (press F3) to repeat the regular-expression search.
PWB finds the Sy1lables function.

» To go to the definition of Syllables in the source:

1. From the Browse menu, choose Goto Definition.

Because the cursoris on Syllables in the Browser Output window, PWB auto-
matically selects the definition.

2. Choose OK.

PWB jumps to the definition of Syllables in COUNT.C where you can remove
the unused function. Now you can remove the unused variable by following the
same steps.

» To find the unused variable:

1. Return to the Browser Output window.
2. Press F3 to find the next unreferenced variable Consonants.
3. Choose Goto Definition, and then choose OK.

PWB jumps to the definition of Consonants.

You can delete the line to remove the definition of the extra variable. The only
remaining cleanup is to remove the declarations for Syllables and Consonants
from the COUNT.H file.

Advanced Browser Database Information

In the previous sections, you learned the basics of building a browser database and
some useful applications of the Source Browser. In this section, you will find infor-
mation on what goes into a browser database and how to estimate the disk require-
ments to build one. You will also learn how to build a database for non-PWB
projects and how to build a single database for related projects.

Estimating .SBR and .BSC File Size When you build a browser database, you
first create an .SBR file for each source file in the project. Each of these files con-
tains the following information:

®  The name of the source file and the files it includes.

= Every symbol defined in the source file and the files it includes.

These symbols are the names of all functions, types (including the names of all
classes, structures, and enumerations and their members), macros (including
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symbols in the expanded macro), and variables in the file. These symbols also
include all parameters and local variables for the functions.

For C++, the names are the decorated names (names with encoded type infor-
mation), which can take up about half of the .SBR file size. For more informa-
tion on decorated names, see Appendix B.

= The location of all symbol definitions in the files.
= The location of all references to every symbol in the files.
= Linkage information.

This is a tremendous amount of information about your program and can therefore
occupy a large quantity of disk space. The benefit is that the Source Browser pro-
vides fast, sophisticated access to this database of knowledge about your program.

For C source files, the .SBR file is typically half the size of the preprocessed
source file (that is, the source file with comments removed, all files included, and
all macros expanded).

For C++, the expansion of the .SBR file is from approximately 2 to 20 times the
size of the source file. This dramatic expansion occurs because:

= More information is defined in C++ include files than in C include files.

= The database contains decorated symbol names.

Intuitively, you might assume that the resulting browser database (.BSC file) is
approximately the sum of all the .SBR files. However, the browser database is the
union of the information in the component .SBR files. This means that the .BSC
file is not extrememly large. Much of the information in the .SBR files is defined
in include files, which are common to many modules in the project. The union of
the .SBR files is relatively small because most of the include-file information is
duplicated in each .SBR file.

A 400K .BSC file is common for a modestly sized program. At the time this book
was written, the largest known browser database was about four megabytes.

Building Databases for Non-PWB Projects The simplest way to build a
browser database for non-PWB projects is to build the browser database separately
from the project. You can use a makefile or a batch file for this purpose. The
process requires only two steps:

1. Create an .SBR file for each module. The simplest way to do this is to run the
compiler with the options to produce an .SBR file and no other files. For ex-
ample, the CL command line:

CL /Zs /W@ /Fr *.c
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specifies that the compiler processes all .C files in the current directory, checks
syntax only ( /Zs) and issues no warnings ( /W@ ). Therefore, no object files
are produced. However, browser information (.SBR files) are generated

( /Fr ).

2. Combine the .SBR files into a browser database.
The syntax for this command is:
BSCMAKE options loproject BSC *.sbr
For complete information on BSCMAKE options and syntax, see Chapter 21.

The process of creating a browser database changes little between projects. There-
fore, you could use a batch file for many projects similar to the following example:

ECHO OFF
REM Require at least one command-line option
IF %1.==. GOTO USAGE

REM Compile to generate only .SBR files
CL /Zs /W@ /Fr *.cC

REM Build the browser database
BSCMAKE %2 %3 %4 %5 %6 %7 %8 /0%1.BSC *.sbr
GOTO END

:USAGE
REM Print instructions
ECHO -Usage: %@ project [option]...

ECHO - project Base name of browser database
ECHO - [option]... List of BSCMAKE options
:END

This batch file assumes that all the project sources are in the current directory. It
requires that you specify the name of the browser database and allows BSCMAKE
options. You may want to change this file to specify different BSCMAKE or com-
piler options.

If your project’s sources are distributed across several directories, you must write
a custom batch file or makefile to build the database. For more information on the
BSCMAKE utility, see Chapter 21.

» To use a custom browser database in PWB:

1. From the Browse menu, choose Open Custom.
2. Choose the Use Custom Database button.
3. Select your custom browser database and choose OK.

If you want to save this database name permanently, choose Save Current
Database.
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4. Choose OK.

The PWB Source Browser opens your custom database.
You can now browse your non-PWB project.

If you are using a makefile to build your project, you can choose Open Project
from the Project menu and open it as a non-PWB project makefile. If the project
makefile has the same base name as the browser database and resides in the same
directory, PWB automatically opens the database when you open the project. For
more information on using a non-PWB makefile for a project in PWB, see “Using
a Non-PWB Makefile” on page 61.

Building Combined Databases  If you have two or more closely related pro-
jects, you can combine the browser databases for the projects. For example, if two
large programs differ only in one or two modules so that most of the sources are
shared between the two projects, it can be useful to browse both projects with a
single browser database.

To build a combined browser database:

1. Generate the .SBR files for both projects.
2. Pass all of the .SBR files to BSCMAKE to build the combined database.

The resulting database is the inclusive-OR of the information in the two projects.

5.2 Executing Functions and Macros

The menus and dialog boxes in PWB provide access to almost everything you
need to do to develop your projects. You can edit, search, and browse your source
files. You can build, run, and debug your project, and you can view Help for the
entire system. However, the visible display provides access to only part of the
capabilities available in PWB. Behind the menu commands lie functions with
many more options than you can access from the menus. Many functions and
macros are not assigned to keys by default.

The sophisticated PWB user learns how to use the functions and predefined mac-
ros to perform the precisely correct action. Each function has several forms that
are invoked with the combinations of the Arg and Meta prefixes. These two func-
tions are used to introduce arguments and modify the action of PWB functions.

Arg (ALT+A)
The fundamental function in PWB. You use Arg to begin selecting text, intro-
duce text and numeric function arguments, or modify the action of functions by
increasing the Arg count.
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Lasttext (cTRL+0)
recovers the previous
text argument and
displays it in the Text
Argument dialog box.

A selection is also
a text argument.

To pass a text argument to a function, for example, press ALT+A, and then type
the text. The text you type doesn’t go into your file. The Text Argument dialog
box appears when you type the first letter of the text.

Text firgument

Argl1]

[Ambidextrous--------- - oo 1

<Cancel> < Jelp >

You can then edit the text. PWB displays the current argument count and Meta
state in the dialog box.

Notice that there is no OK button in this dialog box. Instead of choosing OK,
press the key for the function you want to execute with this argument. Choose
the Cancel button if you do not want to execute a function.

Meta (F9)

Modifies the action of a function in different ways from the various argument
types. It generally toggles an aspect of the function’s action.

For example, the text-deletion functions usually move the deleted text to the
clipboard. However, when modified with Meta, they clear the text without
changing the clipboard.

The combination of Arg and Meta greatly increases the number of variations
available to each function. For example, the Psearch function can perform differ-
ent search operations depending on how it is executed. Psearch can:

Repeat the previous search (Psearch).

Search for text (Arg text Psearch).

Perform a case-sensitive text search (Arg Meta fext Psearch).

Search for a regular expression (Arg Arg fext Psearch).

Search for a case-sensitive regular expression (Arg Arg Meta rext Psearch).

Because you can reassign keys to your preference, the PWB documentation cannot
assume that a specific key executes a given function or macro. Therefore, the
PWB documentation gives a sequence of functions or macros by name, followed
by the same sequence of actions by key name. In this book, the key is the default
key. In PWB Help, the displayed key is the one currently assigned to that function.
When no key is assigned, PWB displays unassigned.
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For example, to insert the definition of a macro at the cursor, you pass the name of
the macro to the Tell function and modify Tell’s action with the Meta prefix. This
sequence of actions is expressed as follows:

= Execute the function sequence Arg Meta macroname Tell
(ALT+A F9 macroname CTRL+T).

If the Tell function is assigned to a different key, Help displays that key in place
of CTRL+T.

Chapter 7, “Programmer’s WorkBench Reference,” contains complete descrip-
tions of all forms of each function in PWB.

Executing Functions and Macros by Name

The most frequently used functions and macros are assigned to certain keys by
default. For example, the Paste function is assigned to SHIFT+ENTER, Linsert is as-
signed to CTRL+N, and so on. Sometimes, however, you want to use a function or
macro that is not assigned to a key. You can always assign a key by using the Key
Assignments command or by using the Assign function. However, that is a lot of
trouble for something you need only once. PWB allows you to execute a function
or macro by name, rather than by pressing a key.

» To execute a function or macro by name:

= Perform the function sequence Arg function Execute
(ALT+A function F7).

In other words, press ALT+A (execute the Arg function), type the name of the func-
tion or macro, and then press F7 (invoke the Execute function).

The argument to Execute doesn’t have to be a single function or macro name. It
can be a list of functions and macros. The argument is really a temporary, name-
less macro. This means that you can do anything in an argument to Execute that
you can do in a macro. PWB follows the rules for macro syntax and execution.
You can define labels, test function results, and loop.

Warning When executed from a macro, PWB functions that display a yes-or-no
prompt assume a “Yes” response. To restore the prompt, use the macro prompt
directive (<). For more information, see “Macro Prompt Directives” in PWB Help.
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5.3 Writing PWB Macros

The Programmer’s WorkBench, like other editors designed for programmers, pro-
vides a macro language so that you can customize and extend the editor or auto-
mate common tasks. You can create macros in one of the following ways:

® By recording actions you perform. The recording mechanism allows you to per-
form a procedure once, while PWB is recording. After you’ve recorded it, you
can execute the macro to repeat the recorded procedure.

= By manually writing macros. This technique is less automatic but does allow
you to write more powerful macros.

These two techniques are not mutually exclusive. You can start by recording a
macro that approaches the steps you want to perform, then edit it to expand its
functionality or handle different situations.

When Is a Macro Useful?

Macros are useful for automating procedures you perform frequently. You may
also write macros that automate tedious one-time tasks.

Of course, not every task is a good candidate for automation. It might take longer
to write the macro than to do the task by hand. If you don’t expect to perform a
task often, don’t automate it. Also, automated editing procedures introduce an ele-
ment of risk. You might not foresee situations that your macro can encounter. In-
correct macros can sometimes be destructive.

A little experience with macros and some careful testing will enable you to create
a good set of macros for your own use.

Recording Macros

Recording actions you perform with the mouse or at the keyboard can be a power-
ful way to write a macro. You turn on recording and perform the actions that you
want the macro to execute. You can concentrate on the task that you want to auto-
mate, instead of concentrating on the syntax of the macro language.

For example, if you occasionally reverse characters when you type quickly, a
macro to switch them back is useful. Before recording a macro to transpose charac-
ters, you should think about what you are going to do while recording the macro.
To transpose characters, you will select the character at the cursor, cut it onto the
clipboard, move over one character, and then paste the character you cut.
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» To record a macro that transposes characters:

1. From the Edit menu, choose Set Record.
PWB brings up the Set Macro Record dialog box.

Set Macro Record

Towe : (EMORR- - 1
ey Assignment: € ¥[------ -
Jeu Assig t: {3 1

[X] Ylear First

OK <Cancel> < Jelp >

2. In the Name text box, type Transpose.

3. Click the mouse in the key box (between the braces { }), or press TAB until the
cursor is in the key box.

4. Press CTRL+SHIFT+T (for transpose).
PWB automatically fills in the name of the key you pressed.
———— Set Macro Record
Tame: [Transpose - - - -« - -« -----c-cmmmn--- 1
Jey Assignment: { F[Shift+Ctrl+T-------- 1

[X] Ylear First

0K <Cancel> < Jelp >

5. Press TAB to leave the key box, and then choose OK.

PWB closes the Set Macro Record dialog box. When you turn on macro record-
ing, PWB records a macro called Transpose and associates it with SHIFT+CTRL+T.

Important The Set Macro Record command does not start the macro recorder.
It only specifies the name and key association for the macro you are going to
record.

6. From the Edit menu, choose Record On.

When you choose Record On, the macro recorder starts. To indicate that the
macro recorder is running, PWB displays the letter X on the status bar. Notice
that the Project, Options, and Help menus are unavailable while PWB is record-
ing a macro.

7. Select the character at the cursor by holding down the SHIFT key and pressing
the RIGHT ARROW key.

8. Press SHIFT+DEL to cut the character onto the clipboard.
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9. Press the RIGHT ARROW key to move the cursor to the new location for the char-
acter.

10. Press SHIFT+INS to paste the character from the clipboard back into the text.
11. From the Edit menu, choose Record On to stop the macro recorder.

Press SHIFT+CTRL+T to switch the character at the cursor with the character to the

right. You can now use the new macro and key assignment for the rest of the PWB
session.

» To edit the macro:

= From the Window menu, choose Record from the PWB Windows cascaded
menu.

PWB opens the Record window.

File Edit Search Project Run Options Browse Window Help
s=[ 2] Record 14]2
Transpose:= select right delete right paste cancel

|

: G i .'s::“:: i SEnnn i i N
<KFi=Help> <Alt=Menu> <Fb6=Window> N 00001 .001]

The Record window shows the definition of the Transpose macro that you just
recorded. You can edit the definition to change the way the macro works. For ex-
ample, you decide that the macro should reverse the character at the cursor with
the character to the left, instead of the character to the right.

» To redefine the macro:
1. Change the macro to read as follows:

Transpose:=select Teft delete left paste

2. Move the cursor to the macro definition.
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LA You can find a 3. Press ALT+=, the default key for the Assign function.

lete list of PWB . . .
:::l::)inen: illlsCIC'l'apler Assigning the macro replaces the previous definition of Transpose with the

7 and in PWB Help. new definition.
4. Return to the file you were originally viewing.

Up to this point, the macro exists only in memory. To use your recorded macro for
subsequent PWB sessions, you must save the definition of the macro to disk.

» To save the macro:

1. If the Record window is not open, choose Record from the PWB Windows cas-
caded menu.

PWB opens the Record window.
2. From the File menu, choose Save.

PWB inserts the macro definition and the key assignment into your TOOLS.INI
file for future sessions. When you leave PWB, you are prompted to save

TOOLS.INI. Your changes are not permanent until you actually save
TOOLS.INI.

Flow Control Statements

Recorded macros have the inherent limitation of playing back one fixed sequence
of commands. Often you need a macro to execute repeatedly until some condition
is satisfied. This requires that you use flow control statements to govern the ac-
tions your macro takes.

All editor functions return a true or false value. The macro flow control operators
that use these values are:

Operator Meaning

+>label Branch to label if last function yields TRUE
->label Branch to label if last function yields FALSE
=>label Branch unconditionally to label

>label Define label

These rudimentary operators are not as sophisticated as a high-level language’s IF
statement or FOR loop. They are more like an assembly language’s conditional
jump instruction. However, they provide the essential capabilities needed for writ-
ing loops and other conditional constructs.
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Flow Control Example

If you frequently perform multiple-window editing, a macro that restores the dis-
play to a single window can be helpful. Such a macro requires the following logic:

1.
2.

Switch to the next window.

If the switch is not successful (meaning that only one window is present), end
the macro.

. If the switch is successful (another window is present), close that window and

go back to step one.

This macro will be called CloseWindows and assigned to SHIFT+CTRL+W.

To create the CloseWindows macro:

1.

From the File menu, choose All Files.
PWB displays the All Files dialog box.

Notice that your TOOLS.INI file is in the list of open files, even though you did
not explicitly open it. PWB opens TOOLS.INI to load its configuration informa-
tion (unless when you specify /DT on the PWB command line).

. Select TOOLS.INI file in the list of open files.
. Choose OK.

PWB opens a window and displays your TOOLS.INI file.

. Find the section of TOOLS.INI that begins with [pwb]. This is the section

where PWB keeps its startup configuration information.

. In the PWB section, type the following two new lines:

CloseWindows:= :>Loop Openfile -> Meta Window Window =>Loop
CloseWindows: SHIFT+CTRL+W

If you want these definitions to take effect immediately, select both lines and
press ALT+= to execute the Assign function. You can also assign the definitions
one at a time.

. Choose Save from the File menu to make this macro and key assignment part

of your TOOLS.INI file.

The next time you start PWB, the CloseWindows macro is defined and as-
signed to the SHIFT+CTRL+W key.

The first line you typed uses the := operator to associate the macro definition with
the name “CloseWindows.” After the operator is the list of functions and macro
operators that specify what the macro is to do. The second line is a separate state-
ment that uses the : operator to assign the macro to the SHIFT+CTRL+W key.
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The CloseWindows macro works as follows:

1. :>Loop defines a label called Loop. There cannot be a space between the :>
operator and the label name.

2. Openfile switches to the window under the active window.

3. The -> operator examines the return value from the Openfile function. If the
function returns false because there is no other window, the -> operator exits
the macro.

4. The phrase Meta Window closes the active window.

5. Window returns to the window you started from.

6. =>Loop unconditionally transfers control back to the Loop label and starts the
sequence again.

When this macro is defined, you can press SHIFT+CTRL+W whenever you want to
close all windows except the active window.

User Input Statements

PWB macros can prompt for input. This helps you write more general macros. For
example, you might keep a history of the changes you make to a file at the top in a
format similar to the following:

//%% Revision History *x*
//15-Nov-1991:1AD:Add return value for DoPrint
//31-0ct-1991:IAD:Implement printing primitives

To facilitate entering the revision history in reverse chronological order and to
make it easy to keep track of where you were in the source file, you can write a
macro to perform the following steps:

. Set a mark at the cursor for future reference.
. Insert a revision history header at the beginning of the file if one is not present.
. Insert the current date.

. Prompt for initials and insert them just below the header.

N AW N =

. Prompt for comments and insert them after the initials.
6. Return to the saved position in the file.
Note that while this macro is executing, you can choose the Cancel button in the

dialog boxes that prompt for initials and comments. The macro must handle these
cases and gracefully back out of the changes to the file.
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» To enter this macro in TOOLS.INI:

1. Open TOOLS.INI for editing.
2. Type the following macros and key assignment in the [pwb] section of

TOOLS.INI:

LineComment:="// "

RevHead:= "=xx Revision History ="

RevComment:= \
Arg Arg "Start" Mark \
Begfile Arg RevHead Psearch +>Found \
Linsert LineComment RevHead \

:>Found \
Down Linsert Begline LineComment Curdate " (" \
Arg "Initials"™ Prompt ->Quit Paste Endline ") " \
Arg "Comment™ Prompt ->Quit Paste =>End \

:>Quit Meta Ldelete \
:>End Arg "Start" Mark
RevComment:Ctri+H

There are at least two spaces before the backslash at the end of each line. The
backslashes are line-continuation characters. They allow you to write a macro
that is more than one line long. In this case, line continuations format the macro
in a readable way. To further assist in readability, you can indent the parts of
the macro which define the actual keystrokes, as in the preceding example.

3. Choose Save from the File menu to save your changes.

4. To reinitialize PWB, execute the Initialize function by pressing SHIFT+FS.
PWB discards all of its current settings and rereads the PWB section of
TOOLS.INI. The same effect can be achieved by quitting and restarting PWB.

The following discussion analyzes the workings of the definitions you added to
TOOLS.INL It repeats one or two lines from the text you typed and describes how
each line works. You may want to refer to the full definition as you follow along.

The first two lines

LineComment:="//"
RevHead:= "% Revision History s**"

define two utility macros that are used by the main RevComment macro. They
define strings that are used several times in RevComment.

The third line

RevComment:= \

declares the name of the macro. The succeeding lines define the action of the
RevComment macro.
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The first line of the definition

Arg Arg "Start" Mark \

sets a mark named “Start” at the cursor so that the macro can restore the cursor
position after inserting the comments at the beginning of the file.

The next line

Begfile Arg RevHead Psearch +>Found \

moves to the beginning of the file (Begfile), then searches forward for the revision-
history header. If the header is found, PWB branches to the Found label; other-
wise, it executes the next line.

Linsert LineComment RevHead \

If the macro is here, the header was not located in the file. The Linsert function
creates a new line, and PWB types the revision-history header. The macro con-
tinues with the line:

:>Found \

This line defines the Found label. At this point in the macro, the cursor is on the
line with the header. The next lines insert the new revision information, starting
with the following line:

Down Linsert Begline LineComment Curdate "™ (" \

PWB moves the cursor down one line (Down), inserts a new line (Linsert),
moves to the beginning of the line (Begline), and calls the LineComment macro
to designate the line as a comment. PWB then types the current date (Curdate)
and an open parenthesis. ‘

The macro prompts for initials:

Arg "Initials" Prompt ->Quit Paste Endline ") " \

The macro uses the Prompt function to get your initials. If you choose the Cancel
button, the function returns false, so the macro branches to the label Quit. If you
choose the OK button, the text you typed in the dialog box is passed to the Paste
function, which inserts the text. The macro moves the cursor to the end of the line
(Endline) and types a closing parenthesis.

The code on this line explicitly handles the case when you cancel the prompt (the
false condition). The phrase ->Quit causes PWB to skip to the label Quit when
Prompt returns false.
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If you use the Prompt function and you do not handle the false condition, a null
argument (a text string with zero length) is passed to the next function. Therefore,
aphrase like Arg "Que?" Prompt Paste pastes either the input or nothing, depend-
ing on whether you choose the OK or Cancel button. Passing a null argument to
Paste is harmless, but some functions require an argument. In these cases, you can
use the -> operator to terminate the macro.

The RevComment macro uses an explicit label so that it can end the macro with-
out an error when you choose the Cancel button. The next line of the macro is
almost the same as the previous line in the macro.

Arg "Comment”™ Prompt ->Quit Paste =>End \

On this line, if the paste is carried out, an unconditional branch is taken to the
label End and passes over the Quit branch, which is defined on the next line.

:>Quit Meta Ldelete \

The Quit branch is taken when you cancel a prompt. The macro has to clean up
the text already inserted by the macro. The Meta Ldelete function deletes the
incomplete line that would have been the revision-history entry. The next line de-
fines the last step of the macro.

:>End Arg "Start" Mark

The End label defines the entry point for the common cleanup code. This line
restores the cursor to the initial position when you invoked the macro. Because
this line does not end in a line-continuation character (\), it is the end of the
RevComment macro.

The last line that you typed is not part of the RevComment macro. It is a separate
TOOLS.INI entry.

RevComment:Ctri1+H
This line assigns the CTRL+H key to the RevComment macro.

You can polish this macro by adding Arg "Start" Meta Mark to the end of the
macro. This phrase deletes the mark. A better alternative is to use the Savecur and
Restcur functions instead of named marks. However, this example uses named
marks to illustrate how to use them in a macro.






Customizing PWB

PWB is a completely customizable development environment. You can modify
PWB in the following ways:

= Changing mapping of keystrokes to actions.

= Changing default behavior of PWB (for example, how tabs are handled or if
PWB automatically saves files).

= Changing the colors of parts of the PWB display.
= Adding new commands to the Run menu.
= Programming new editor actions (macros).

You can find instructions on how to write macros in “Writing PWB Macros”
on page 109.

In addition to the customizations that you can make by using the commands in the
Options menu, you can also customize PWB by editing the TOOLS.INI file.

Note Another category of customization that is not covered in this book is how
to write PWB extensions. An extension is a dynamically loaded module that can
access PWB’s internal functions. Extensions can do much more than macros. To
learn more about writing PWB extensions, see the Microsoft Advisor Help system
(choose “PWB Extensions” from the main Help table of contents).

6.1 Changing Key Assignments

PWB maps actions (functions and macros) to keys. You can assign any of these
actions to keys other than the default keys.

For example, Exit is a PWB function. Its default key assignment is F8. A BRIEF
user may prefer to use ALT+X to leave the editor.
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» To make ALT+X execute the Exit function:

1. From the Options menu, choose Key Assignments.

PWB displays the Key Assignments dialog box.

Key Assignments

2.

3.

4.

Jacro/Function Name: [exit-------- - oo 1

New Jey: € 3[-------vnmnnnnno. 1 Assigned To:

Macro/Function Jist: Surrent Keys:

—1

emacsnewl F8 T
endfile | ]
endline 4
environment '
execute Uflassigned Keys:

.
graphic Alt+? 1
home Alt+" [ ]
initialize Alt+ i

1
Kissigng <Inassign> <Safe...> <Gunction Help>

< OK > <Cancel> < Jelp >

Select Exit in the Macro/Function List box, or type exit in the Macro/
Function Name text box.

Move the cursor to the New Key box between the braces ({}) by clicking
between the braces or by pressing ALT+K.

Press ALT+X.

PWB types ALT+X in the text box after the braces and displays the name of the
macro or function that ALT+X is currently assigned to. With the default settings,
you can see that ALT+X is assigned to the Unassigned function. Pressing a key
in the key box is a quick way to find out the name of the function assigned to
the key.

Note When the cursor is in the key box (between the braces), most keys lose
their usual meaning, including ESC, F1, and the dialog box access keys. The key
you press is interpreted as the key to be assigned. Only TAB, SHIFT+TAB, ENTER,
and NUMENTER retain their usual meaning. To assign one of these keys, type the
name of the key in the text box.

5. Press TAB to move the cursor out of the key box.

6. Choose Assign.

7.

PWB assigns Exit to the ALT+X key. Note that Exit is still assigned to the Fs
key. Functions can be assigned to many keys.

Choose OK.
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Important To change a key, you must choose the Assign button. The OK button
dismisses only the dialog box. It does not perform any other action. This design
allows you to assign many keys in one session with the dialog box.

The change remains in effect for the duration of the session.

» To make a permanent key assignment:

1. From the Options menu, choose Key Assignments.
2. Choose Save.

PWB displays the Save Key Assignments dialog box, which lists all of the un-
saved assignments that you have made during the PWB session by using the
Key Assignments dialog box.

3. Delete any settings that you do not want to save.
4. Choose OK.
PWB writes your new settings into the [PWB] section of TOOLS.INI for sub-

sequent sessions. When you exit PWB, you are prompted to save TOOLS.INI.
Your changes are not permanent until you actually save the file to disk.

Key assignments  If you already know the function name, you can make a quick assignment for the
can be temporary. current session by using the Assign function instead of going through the Key
Assignments dialog box.

» To assign a key using the Assign function:

= Execute the function sequence:
Arg function:key Assign (ALT+A function:key ALT+=).
For example, to assign Exit to ALT+X:
1. Press ALT+A to execute Arg.
2. Type exit:ALT+X
3. Press ALT+= to execute Assign.
The assignment is in effect for the rest of the PWB session.

The key assignments you make by using the Assign function are not listed in the
Save Key Assignments dialog box.

To discover the name of the function or macro that is currently assigned to a key,
use the Key Assignments dialog box (as previously described) or use the Tell
function.
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» To find a current key assignment using Tell:

1. Press CTRL+T to execute Tell.
PWB displays the prompt:

Press a key to tell about

2. Press the key you want to find out about.
If you press F10, PWB displays the function assigned to the F10 key (Openfile).

Tell

openfile:F10

g ok g

The Tell function has many other uses in addition to displaying key assignments.
For more information on Tell, see page 216.

6.2 Changing Settings

When you first use PWB, you don’t have to specify the tab stops, whether the edi-
tor starts in insert or overtype mode, and so on. These settings (called “switches”)
are all covered by defaults. PWB’s default behavior can be extensively customized
by changing the values of PWB switches.

Il To see a list of Switches fall into three categories:
PWB switches in . . .
Help, type ALT+A = Boolean switches. True/false or on/off switches that can also be specified as

switches F1. yes/no or 0/1. An example of a Boolean switch is Autosave, which governs
whether PWB saves a file when you switch to a different one.

®  Numeric switches. An example of a numeric switch is Undocount, which deter-
mines the maximum number of editing actions you can undo.

® Text switches. Examples of a text switch are Markfile, the name of the file in
which to store marks, Tabstops, a list of tab-stop intervals, and Readonly, the
operating-system command for PWB to run when saving a read-only file.
» To change the setting for Tabstops:

1. From the Options menu, choose Editor Settings.
PWB displays the Editor Settings dialog box.
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Choose Switch
Help to determine what
a switch does and the
syntax to s acify its
value.

2. Tabstops is a text switch (not a numeric switch as you might expect), so select
the Text option button.

3. Select Tabstops in the Switch List box.

PWB shows the current setting for Tabstops in the Switch text box at the top of
the dialog box.

4. Move to the Switch text box by clicking in the box or by pressing ALT+S.
PWB selects only the switch value, instead of the entire text.
5. Type the new setting:

3478

This setting defines a tab stop at columns 4, 8, 15, and every eight columns
thereafter. At this point, the Editor Settings dialog box should look like:

Editor Settings
Suitch: [tabstopsi3 4 2 B--- - o -onomm i 1

Switch Juwner:
EPMWB - -« < - oo el n

Switch Jist:

fastfunc:up on
markfile:
printcmd:
readonly:

word : [a-zA-Z20-9_51+ 1
1

ESHt Switchy <Safe...> <S¥itch Help>

< DK > <Cancel> < Jelp >

6. Choose the Set Switch button to change the setting of the Tabstops switch.
7. Choose OK.

Important To change a setting you must choose the Set Switch button. The OK
button only dismisses the dialog box. It does not perform any other action. This
design allows you to set many switches in one session with the dialog box.

The new tab stops you set are used for the current session. If you want to use this
setting permanently, you must choose the Save button in the Editor Settings dialog
box. This changes your TOOLS.INI file in the same way as for key assignments.
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You can set
temporary switch
settings.

You can make temporary switch assignments for the current session by using the
Assign function. You do this in the same way as for a key assignment by typing
Arg switch:value Assign (ALT+A switch:value ALT+=).

You may be curious about the Switch Owner box that you did not use in this ex-
ample. The Switch Owner is either PWB or a PWB extension such as PWBHELP
(the extension that provides the Microsoft Advisor in PWB). Type or select a
switch owner to set switches for that extension. Each extension has its own section
in TOOLS.INI.

Note When you choose Set Switch, most switch settings take effect immediately.
However, changes to the Height switch do not take effect until you choose OK.

6.3 Customizing Colors

You can change the color of almost any item in the PWB interface. For a table
showing the names and meanings of PWB’s color settings, see the “Programmer’s
WorkBench Reference” on page 271.

Some displays show a brilliant green for the left and right triangular symbols sur-
rounding buttons in Help.

» To change the light green to light cyan:

1. From the Options menu, choose Colors.
PWB displays the Colors dialog box.

Colors
Solor: Joreground : Jackground :
1

desktop Black T Black
pwbwindowtext Blue [ | Blue
pwbwindowborder Green Green
message Cyan
location Red Red
helpnorm Magenta Magenta
helpbold Brown Brown

White White
helpunderline .
helpuwarning 1

I [ 1Bright Fjre [ 1 Bright Blck

Example: SFIICIIos et Colorf <safe...>

< DK > <Cancel> < Jelp >
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2. Select Helpitalic in the Color list box.
3. Select Cyan in the Foreground list box.
4. Choose Set Color.

To verify your change, press Fi. The green symbols in help are now light cyan.
While you are viewing Help, you can find out what parts of PWB the rest of the
color names determine. To leave Help, click the Cancel button or press ESC. PWB
returns you to the Colors dialog box.

The Bright Fore and Bright Back check boxes determine if the given color is the
usual version of the color or the bright version of the color. Bright black, for ex-
ample, is usually a dark gray color.

If you want to save your new colors for subsequent sessions, choose the Save but-
ton. PWB displays the Save Colors dialog box where you can delete modifications
that you don’t want to save. When you choose OK in the Save Colors dialog box,
PWB modifies TOOLS.INI to record your changes.

6.4 Adding Commands to the Run Menu

You can add up to six commands to the Run menu to integrate your own utilities
into PWB. A command is the name of any executable (.EXE or .COM) file, batch
(.BAT) file, or built-in operating-system command such as DIR or COPY.

Suppose you use an outline processor to keep project notes. You can start the out-
line processor from PWB’s Run menu.

» To add a command to the Run menu:

1. From the Run menu, choose Customize Run Menu.
2. Choose the Add button.

PWB displays the Add Custom Run Menu Item dialog box for you to describe
your custom menu item:
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Add Custom Run Menu Item

zenu Text: [Project “Notes------ - v-nomommmamaoaann.. 1
Fath Name: [----- oo ]
Teguments: [--- oo 1
Tutput File Name: [-----coocnevommonmaaaaa . 1
[nitial Directory: [-------coeommmmmmnai 1
Help Bine: [--------vmmmm 1

[ 1 Use QJialog Box for Arguments and Output File
[X] Prompt Before Jeturning [ 1 Execute in Background

Shortcut Key: (+) Jone ) Alt+JL--1]

OK <Cancel> < Jelp >

3. Type Project ~Notes... in the Menu Text box.

The tilde (~) before the letter N indicates the highlighted access letter for the
menu command. The ellipsis (. . .) uses the standard convention to indicate that
the command will require more information before it is completed. An ellipsis
is commonly associated with a dialog box command but can be used in this con-
text as well.

. Specify the full path to the outlining program, OUTLINE.EXE, in the Path

Name text box. (The program name OUTLINE.EXE is for example purposes
only. Substitute the name of your own outliner or other program in its place.)

. Specify the arguments you want to pass to the outliner in the Arguments text

box: %|dpfF.log.

This example illustrates a powerful feature of PWB: its ability to extract parts
of the filename to form a new name for customized menu items. The specifica-
tion %|dpfF extracts the drive (d), path (p), and base name (f) of the current
file. Anything after F is added to the end of the name.

For example, if the current file is CASOURCE\COUNT.C, the argument that
PWRB passes to the program is C:\SOURCE\COUNT.LOG.

6. In the Help Line text box, type the explanatory message that appears on the

status bar when you browse this menu item:

Run the OUTLINE program

7. Choose OK to confirm your entries.

PWB adds the command to your Run menu and modifies TOOLS.INI to save the
new item. You can now access your outline processor directly from the Run menu.
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File Edit Search Project lJJ] Options Browse Window Help
p=[ 11

Execute: I
Program Jrguments. ..
Debug :

un DOS Command. . .
tstomize Run Menu. ..

Project Notes

m B

Run the OUTLINE Program N 00001 .005

Note You can add other text processing or word processing programs to the Run
menu. If you change the current file using another program, PWB prompts you to
update the file or to ignore the changes made by the other program.

6.5 How PWB Handles Tabs

The following functions and switches control how PWB handles tabs:

Name Type Description

Realtabs Switch Determines if PWB preserves tabs on modified lines
Entab Switch The white space translation method

Tabalign Switch The alignment of the cursor within a tab field
Filetab Switch The width of a tab field

Tabdisp Switch The fill-character for displaying tab fields

Tab Function = Moves the cursor to the next tab stop

Backtab Function =~ Moves the cursor to the previous tab stop

Tabstops Switch Tab positions for Tab and Backtab

For detailed information on each function and switch, see Help or the “Program-
mer’s WorkBench Reference.” For instructions on how to set a switch see “Chang-
ing Settings” on page 122. For instructions on how to assign a function to a key,
see “Changing Key Assignments” on page 119.
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To understand how PWB handles tabs, you need to know only a few facts:

The Tab (TAB) and Backtab (SHIFT+TAB) cursor-movement functions and the
Tabstops switch have nothing to do with tab characters. They affect cursor
movement, rather than the handling of tab characters, and are not discussed
further here. For more information on these items, see the “Programmer’s
WorkBench Reference.”

PWB never changes any line in your file unless you explicitly modify it (lines
longer than PWB’s limit of 250 characters are the exception).

Some text editors translate white space (that is, entab or detab) when they read
and write the file. PWB does not translate white space when it reads or writes a
file. This is to be compatible with source-code control systems that would de-
tect the translated lines as changed lines.

PWB translates white space according to the Entab switch only when you mod-
ify a line.

Tabalign has an effect only when Realtabs is set to yes.
A “tab break” occurs every Filetab columns.

When PWB displays a tab in the file, it fills from the tab character to the next
tab break with the Tabdisp character.

Figure 6.1 illustrates how PWB displays tabs.

24 32 (Filetab: 8)
XXXXXXXXXXXXXXXX
[ Text
Text Tab field, shown as Tabdisp.46
Physical tab character

Figure 6.1 How PWB Displays Tabs

When translating white space, PWB preserves the exact spacing of text as it is
displayed on screen.

To set the width of displayed tabs, change the setting of the Filetab switch.

To tell PWB to translate white space on lines that you modify, set the Realtabs
switch to no and the Entab switch to a nonzero value, according to the translation
method that you want to use. The Entab switch takes one of the following values:
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Entab Translation Method

0 Translate white space to space characters

1 Translate white space outside of quotation-mark pairs to tabs
2 Translate white space to tabs

To preserve white space exactly as you type it, set the Realtabs switch to yes and
the Entab switch to 0.

When Realtabs is yes, the Tabalign switch comes into effect. When Tabalign

is set to yes, PWB automatically repositions the cursor onto the physical tab char-
acter in the file, similar to the way a word processor positions the cursor. When
Tabalign is set to no, PWB allows the cursor to be anywhere in the tab field.

If you want the TAB key to type a tab character, assign the TAB key to the Graphic
function. Note that when a dialog box is displayed, the TAB key always moves to
the next option. You can always use the following method to type a tab character,
whether you are in a dialog box or an editing window.

To type a literal tab character in your text or in a dialog box:

1. Execute the Quote function (press CTRL+P).
2. Press TAB.

Examples

The following example sets up tabs so that they act the same as in other Microsoft
editors, such as QuickC or Word:

realtabs:yes
tabalign:yes
graphic:tab
trailspace:yes
entab:0

The Trailspace switch is needed so that the TAB key will have an effect on other-
wise blank lines.

To save your file so that it does not include any actual tab characters (ASCII 9),
use the following settings:

realtabs:no
entab:0
tabstops:3

The Tabstops value determines the number of spaces inserted for each press of
the tab key.
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Another example of a common tab configuration is one in which the TAB key in-
serts a tab in insert mode but moves over text to the next tab stop when the editor
is in overtype mode.

First, use the following tab settings:

realtabs:yes
tabalign:yes

Then insert the following macro into the PWB section of your TOOLS.INTI:
;Insert mode and overtype mode tabbing
TabIO:= Insertmode +>over Insertmode "\t" => \

:>over Insertmode Tab
TabI0:TAB

For more information on PWB macros see “Writing PWB Macros” on page 109.

6.6 PWB Configuration

PWB keeps track of three kinds of information between sessions in these three

files:
File Information Saved
TOOLS.INT Configuration and customizations, such as key assignments,

colors, and macro definitions
CURRENT.STS The editing environment used most recently
project.STS The editing and building environment for a project

TOOLS.INI is described in the next section: “The TOOLS.INI File” on page
131. For more information about CURRENT.STS, see “Current Status File
CURRENT.STS” on page 138, and for more information about the project.STS
files, see “Project Status Files” on page 138.

When you start PWB, it reads the TOOLS.INI file, loads PWB extensions, and
reads the CURRENT.STS or project status file in the following order:

1. PWB reads the [PWB] section of TOOLS.INI (except when PWB is started
using the /D or /DT command-line options). For more information on tagged
sections, see “TOOLS.INI Section Tags” on page 132.

If the [PWB] section contains Load switches, PWB loads the specified exten-
sion when each switch is encountered. When PWB loads an extension, it also
reads the extension’s tagged section of TOOLS.INI, if any. For example, when
the Help extension is loaded, PWB reads the [PWB-PWBHELP] section of
TOOLS.INI.
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2. PWB autoloads extensions (except when the /D or /DA option is used to start
PWB).

The automatic loading of PWB extensions is described in the next section,
“Autoloading Extensions.”

3. PWB reads the TOOLS.INI operating-system tagged section (except when /D
or /DT is used).

4. PWB reads the CURRENT.STS status file (except when /D or /DS is used to
start PWB).

5. PWB reads the TOOLS.INI tagged section for the file extension of the current
file (except when /D or /DT is used to start PWB).

6. PWB runs the Autostart macro if it is defined in TOOLS.INI (except when /D
or /DT is used).

Autoloading Extensions

PWB automatically loads extensions if they follow a specific naming convention
and reside in a certain directory. For extensions that follow the convention, it is
not necessary to put load statements in TOOLS.INI.

PWB searches the directory where the PWB executable file is located for file-
names with the following pattern:

PWB=* .MXT

PWB loads as many extensions with names of this form as it finds. When PWB
loads an extension, it also loads the extension’s tagged section of TOOLS.INL.

To suppress extension autoloading, use the /DA option on the PWB command line.

Important Do not rename editor extensions. PWB and some extensions may
assume the predefined filename.

The TOOLS.INI File

PWRB, like other Microsoft tools, stores information in a file called TOOLS.INI.
This file retains information about how you want PWB to work under various cir-
cumstances. PWB expects to find this file in the directory specified by your INIT
environment variable.

TOOLS.INI is a text file. You can edit it using PWB or any other text editor. PWB
also can store information directly to TOOLS.INI when, for example, you choose
the Save Colors button in the Colors dialog box. PWB modifies this file when you
save a recorded macro, a changed switch, a new key assignment, a custom
browser database, or a custom project template.
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To open
TOOLS.INI, choose it
in the All Files dialog
box. TOOLS.INI is
always open.

TOOLS.INI Section Tags

The TOOLS.INI file is divided into sections, separated by “tags.” These tags are
specified in the form:

[tagname]

The tagname is the base name of an executable file, such as NMAKE, CVW, or
PWB. The tag defines the start of a TOOLS.INI section that contains settings for
the indicated tool.

PWB extends this simple syntax to enable you to take different action depending
on the operating system or the current file’s extension. The extended syntax is:

[PWB-modifier]

The modifier can be the base name of a PWB extension, an operating system’s
identifier, or a filename extension for files that you edit.

Operating-System Tags

The following table lists the operating-system tags for various operating environ-
ments. If you are running Windows, use the tag for the version of DOS that you
are running.

Tag Operating Environment
[PWB-4.0] MS-DOS versions 4.0 and 4.01
[PWB-5.0] ' MS-DOS version 5.0

Be sure to use the correct version number for your operating system.

Filename-Extension Tags

The operating-system tags are read only once at startup. PWB reads the filename-
extension tagged sections each time you switch to a file with that extension. For
example, suppose that you want the tab stops for C and C++ files to be every four
columns, and every eight columns for text files.

P To set tab options based on filename extension:

1. Open your TOOLS.INI file in an editing window.
2. Create a C and C++ section by typing the tag:

[PWB-.C PWB-.H PWB-.CPP PWB-.HPP]
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The default
extension tag is
[PWB-..1.

3. Create a text file section by typing the tag:

[PWB-.TXT]

4. Put the appropriate Tabstops, Entab, and Realtabs switches in each section.
The lines that begin with a semicolon are comments.

[PWB-.C PWB-.H PWB-.CPP PWB-.HPP]
; Set the tab stops for C and C++ to 4

tabstops : 4

; Translate white space to tabs

entab 1

realtabs : no

[PWB-.TXT]

; Set the tab stops for text files to 8
tabstops : 8

; Translate white space to spaces

entab : 0

realtabs : no

Depending on whether the current file is a C (.C or .H) file or a text (.TXT) file,
the tab stops are set at 4 or 8 columns, respectively.

PWB reads multiple sections and applies the appropriate settings. You can use this
to your advantage by storing all your general settings in the [PWB] section and
storing differences in separate tagged sections.

Filename-extension tagged sections are useful for the kinds of files you edit most
frequently. However, it’s impossible to define settings for every conceivable exten-
sion. To handle this case, PWB provides a special extension (. .) that means “all
extensions not defined elsewhere in TOOLS.INL.”

For example, to set tab stops to 8 for all files except C and C++ files, modify the
preceding example to use the [PWB-..] tag in place of [PWB-.TXTI.

Note When you choose the Save button in the Key Assignments, Editor Settings,
and Colors dialog boxes, and when you save a recorded macro or custom Run
menu command, PWB saves the setting in the main section. If the setting is for a
PWB extension, it is saved in that extension’s tagged section. PWB never modi-
fies or writes settings in a filename-extension or operating-system section.

Named Tags

You can define tagged sections of TOOLS.INT that you load manually. Use
manually loaded sections to make special key assignments, to load complex or
rarely used macros, or to use a special PWB configuration under a particular
circumstance.



134 Environment and Tools

The syntax for a manually-loaded section tag is:
[PWB-name]

Where name is the name of the tagged section. A single section of TOOLS.INI
can be given several tag names. These tags have the form:

[PWB-namel PWB-name?2...]

When you want to use the settings defined in one of these named sections, pass the
name of the section to the Initialize function (SHIFT+F8).

» To read a tagged section of TOOLS.INI:

m Execute Arg name Initialize (ALT+A name SHIFT+F8)

You can use this method to read any tagged section, including the automatically
loaded sections.

Note When you execute Initialize with no arguments, PWB clears all the current
settings before reading the [PWB] section, including settings that you have made
for specific PWB extensions. PWB does not reread the operating-system or other
additional sections of TOOLS.INI. To reread the main section without clearing
other settings that you want to remain in effect, label the main PWB section with
the tag [PWB PWB-main]. You can then use Arg main Initialize to recover your
startup settings, instead of using Initialize with no arguments.

TOOLS.INI Statement Syntax

Within each TOOLS.INI section you place a series of comments or statements.
Each statement is a macro definition, key assignment, or switch setting, and must
be stated on a single logical line. Statements can be continued across lines by
using line-continuations.

General Macro Syntax

The general syntax for a macro definition is:
name := definition

PWB does not reserve any names. Therefore, be careful not to redefine a PWB
function. For more information about how to write macros, see “Writing PWB
Macros” on page 109.
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General Key Syntax

The general syntax for a key assignment is:
name : key

The name is the name of a function or macro, and the key is the name of a key. To
see how to write a given key, use the Tell function as described in “Changing Key
Assignments” on page 119.

Note that certain keys have fixed meanings when the cursor is in a dialog box or in
the Help window. You can assign one of these keys to a function or macro, but the
fixed meaning is used in a dialog box or the Help window.

The following keys have fixed meanings:

Key Dialog Box Help Window

ESC Choose Cancel Close the Help window

F1 See Help on the dialog box See Help on the current item
(choose Help)

TAB Move to the next option Move to the next hyperlink

SHIFT+TAB Move to the previous option Move to the previous

hyperlink

SPACEBAR Toggle the setting of the Activate the current hyperlink
current option

ENTER, Choose the default action Activate the current hyperlink

SHIFT+ENTER,

NUMENTER,

SHIFT+NUMENTER

Note The Windows operating environment or a terminate-and-stay-resident
(TSR) program may override PWB’s use of specific keys. PWB has no knowledge
of keys that are reserved by these external processes. PWB lists these keys as avail-
able keys in the Key Assignments dialog box and allows you to assign functions to
these keys, but you may not be able to use them. See the documentation for your
operating environment to see what keys are reserved by the system.

General Switch Syntax

The general syntax for a switch setting is:
switch : value

The exact syntax for the switch value depends on the switch. See Chapter 7,
“PWB Reference,” for more information about each switch.
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Line Continuation

All statements in TOOLS.INI must be stated on a single logical line. A logical line
can be written on several physical lines by using the TOOLS.INI line-continuation
character, the backslash (\).

The backslash must be preceded by a space to be treated as a line-continuation
character. Precede the backslash by two spaces if you want the concatenated state-
ment to contain a space at that location. If the backslash is preceded by a tab, PWB
treats the tab as if it were two spaces. The backslash should be the last character
on the line except for spaces or tabs.

The backslash in the following statement is not a line continuation.

Qreplace:CTRL+\

However, the backslash at the end of the first line below is a line continuation.

findtag:=Arg Arg "A\\[[A\\]]+\\]" Psearch ->nf \
Arg Setwindow => :>nf Arg "no tag" Message

In this example, the backslash is preceded by two spaces. The first space is in-
cluded to separate ->nf from Arg in the concatenated macro definition. The sec-
ond space identifies the backslash that follows it as the line-continuation character.

Comments

In the TOOLS.INI file, PWB treats the text that follows a semicolon (3) up to the
end of the line as a comment. To specify the beginning of a comment, you must
place the semicolon at the beginning of a line or following white space.

For example, the first semicolon in the following statement is part of a command,
and the second semicolon begins a comment.

Printcmd:Tister -t4 %s -c; ;Print using lister program

In the following example, the first semicolon is a key name, and the second semi-
colon begins a comment.

Sinsert:CTRL+; ;Stream insertion: CTRL plus semicolon

Semicolons inside a quoted string do not begin a comment.
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Environment Variables

The INIT environment variable tells PWB where to find the TOOLS.INI file and
where to store the CURRENT.STS file. The proper setting of these variables—
INIT, TMP, LIB, INCLUDE, HELPFILES, and PATH—governs whether your
development environment works smoothly.

» To set the INIT environment variable from the command line:

= Type SET INIT=C:\INIT

The operating-system SET command sets the environment variable to contain the
string C:\INIT. This example presumes that you want to store your initialization
files in C:\INIT. You could use any other directory. Make sure that the INIT en-
vironment variable lists a single directory. Multiple directories in INIT can cause
inconsistent behavior.

The following list outlines how the environment works:

= The environment is always inherited from the parent process. The parent is
the process that starts the current process. In DOS, the parent is often
COMMAND.COM or Windows.

= Inheritance of environment variables is a one-way process. A child inherits
from its parent. You can make changes to the environment in a child (when you
use the Environment Variables command in PWB, for example), but they are
not passed back to the parent. This means that any changes to environment vari-
ables that you make while shelled out are lost when you return to PWB.

= Each DOS session under Windows inherits its environment from Windows.
Changes made to the environment in one session do not affect any other session.

The best way to make sure your environment is set properly is to explicitly set it in
one of your startup files. These are:

= CONFIG.SYS
= AUTOEXEC.BAT

PWB can save the complete table of environment variables for each project. You
can then use the Environment Variables command from the Options menu to
change environment variables for individual projects.

If you prefer that PWB save the environment variables for all PWB sessions or
use the current operating-system environment when it starts up, change the
Envcursave and Envprojsave switches. For more information on these switches,
sec the “Programmer’s WorkBench Reference” on pages 279 and 280.
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Current Status File CURRENT.STS

The first time you run PWB or CodeView, it creates a CURRENT.STS (current
status) file in your INIT directory. If there is no INIT directory, PWB and
CodeView create the file in the current directory.

CURRENT.STS keeps track of the following items for PWB:

= Open windows, including their size and position and the list of open files in
each window

= Screen height
= Window style
= Find string

= Replace string

= The options used in a find or find-and-replace operation, such as the use of regu-
lar expressions

= Optionally, all environment variables

PWB and CodeView share the current location and filename for the active win-
dow. When you leave CodeView after a debugging session and return to PWB,
PWB positions the cursor at the place where you stopped debugging. For more
information on the items that CodeView saves in CURRENT.STS, see “The
CURRENT.STS State File” on page 343.

The next time you run PWB, it reads CURRENT.STS and restores the editing en-
vironment to what it was when you left PWB. For more information on how PWB
uses environment variables, see “Environment Variables” on page 137.

The status files are plain text files. You can load one into an editor and read it.
However, you might corrupt the file if you try to modify it. There is no need to
modify it because PWB keeps it updated for you. No harm occurs if you delete
CURRENT.STS. However, you will have to manually reopen the files you were
working on.

Project Status Files

For each project, PWB creates a project status file. PWB stores this file in the pro-
ject directory and gives it the name project.STS, where project is the base name of
the project.

Project status files contain the same kind of information that CURRENT.STS
contains, except on a per-project basis. This scheme allows PWB to keep track of
your screen layout, file history, and environment variables for each project. The
project status files also contain the current project template, language and utility
options, build directory, and the program’s run-time arguments.
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The main difference between the two status files is that the CURRENT.STS file
supplies default status information—settings that PWB uses when you have not
set a project. PWB uses the project’s status file when you open that project.

By default, PWB saves a project’s environment variables in the project status file.
For more information on how PWB uses environment variables, see “Environment
Variables” on page 137.

Important While it is harmless to delete CURRENT.STS, you should rnot delete
project status files. They contain important information for building and updating
your project. If you delete a project status file, you may need to delete the project
makefile and start over.
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7.1 PWB Command Line

Syntax PWB [[options] [/t]] files
Options Use the following case-insensitive options when starting PWB:
/D[SITIA]...

Disables PWB loading the initialization files or PWB extensions as indicated
by the following letters:

Letter Meaning

S Disable reading the status file CURRENT.STS
T Disable reading TOOLS.INI
A Disable PWB extension autoload

The /D option alone disables loading all the PWB extension and initialization
files. See: Autoload.

Note If you start PWB with the /DT option, this means that PWB options you
change during the session cannot be saved.

/PP makefile
Opens the specified PWB project.

[PF makefile
Opens the specified non-PWB project (foreign makefile).

/PL
Resets the last project. Use this option to start PWB in the same state you last
left it. You can set this option as the default by setting the Lastproject switch
to yes.
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[E command
Executes the given command or sequence of commands as a macro upon
startup.

If command contains a space, command should be enclosed in double quotation
marks ("'). A single command need not be quoted. If command uses literal quo-
tation marks, place a backslash (\) before each mark. To use a backslash, pre-
cede it with another backslash.

/R
PWB starts in no-edit mode. You cannot modify files in this mode. See: Noedit.

IM {mark | line)

PWRB starts at the specified location. See: Mark.

[ [/T7 filell...
Tells PWB to load the given files on startup. If you specify a single file, PWB
loads it. If you specify multiple files, PWB loads the first file; then when you
use File Next or the Exit function, PWB loads the next file in the list.

If a /T precedes a filename or wildcard, PWB loads each file as a temporary
file. PWB does not include temporary files in the list of files saved between
sessions.

Note No other options can follow /T on the PWB command line. You must
specify /T for each file you want to be temporary.

7.2 PWB Menus and Keys

Many PWB menu commands activate PWB functions or predefined macros. The
menu commands that are attached to functions and macros are listed in the tables
that follow. To assign a shortcut key for one of these menu commands, use the
Key Assignments command on the Options menu and assign a key to the corre-
sponding function or macro. For details on using the Key Assignments dialog box,
see “Changing Key Assignments” on page 119.

Names beginning with an underscore (_pwb...) are macros. Names without an un-
derscore are functions.



Programmer’s WorkBench Reference

143

Table 7.1 File Menu and Keys

Menu Command Macro or Function Default Keys

New _pwbnewfile Unassigned

Close _pwbclosefile Unassigned

Next _pwbnextfile Unassigned

Save _pwbsavefile SHIFT+F2

Save All _pwbsaveall Unassigned

DOS Shell _pwbshell Unassigned

n file _pwbfilen Unassigned

Exit _pwbquit ALT+F4

Table 7.2 Edit Menu and Keys

Menu Command Macro or Function Default Keys

Undo _pwbundo Unassigned

Redo _pwbredo Unassigned

Repeat _pwbrepeat Unassigned

Cut Delete SHIFT+DEL, SHIFT+NUM-
Copy Copy CTRL+INS, SHIFT+NUM*
Paste Paste SHIFT+INS, SHIFT+NUM+
Delete _pwbclear DEL

Set Anchor Savecur Unassigned

Select To Anchor Selcur Unassigned

Stream Mode _pwbstreammode Unassigned

Box Mode _pwbboxmode Unassigned

Line Mode _pwblinemode Unassigned

Record On _pwbrecord Unassigned
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Table 7.3 Search Menu and Keys

Menu Command Macro or Function Default Keys
Log _pwblogsearch Unassigned
Next Match (Logging on) _pwbnextlogmatch SHIFT+CTRL+F3
Next Match (Logging off) _pwbnextmatch Unassigned
Previous Match (Logging on) _pwbpreviouslogmatch SHIFT+CTRL+F4
Previous Match (Logging off) _pwbpreviousmatch Unassigned
Goto Match _pwbgotomatch Unassigned
Table 7.4 Project Menu and Keys

Menu Command Macro or Function Default Keys
Compile File _pwbcompile Unassigned
Build _pwbbuild Unassigned
Rebuild All _pwbrebuild Unassigned
Close _pwbcloseproject Unassigned
Next Error _pwbnextmsg SHIFT+F3
Previous Error _pwbprevmsg SHIFT+F4

Goto Error _pwbsetmsg Unassigned
Table 7.5 Run Menu and Keys

Menu Command Macro or Function Default Keys
commandl _pwbuserl [ALT+Fn]]
command2 _pwbuser2 [ALT+Fn]]
command3 _pwbuser3 [ALT+Fn]]
command4 _pwbuser4 [ALT+Fn]]
command5 _pwbuser5 [ALT+Fn]]
command6 _pwbuser6 [ALT+Fn]]
command7 _pwbuser7 TALT+Fn]|
command8 _pwbuser8 [ALT+Fn]]
command9 _pwbuser9 [ALT+Fn]]
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Table 7.6 Browse Menu and Keys

Menu Command Macro or Function Default Keys
Goto Definition Pwbrowsegotodef Unassigned
Goto Reference Pwbrowsegotoref Unassigned
View Relationship Pwbrowseviewrel Unassigned
List References Pwbrowselistref Unassigned
Call Tree (Fwd/Rev) Pwbrowsecalltree Unassigned
Function Hierarchy Pwbrowsefuhier Unassigned
Module Outline Pwbrowseoutline Unassigned
Which Reference Pwbrowsewhref Unassigned
Class Tree (Fwd/Rev) Pwbrowsecltree Unassigned
Class Hierarchy Pwbrowseclhier Unassigned
Next Pwbrowsenext CTRL+NUM+
Previous Pwbrowseprev CTRL+NUM-
Table 7.7 Window Menu and Keys

Menu Command Macro or Function Default Keys
New _pwbnewwindow Unassigned
Close _pwbclose CTRL+F4
Close All _pwbcloseall Unassigned
Move _pwbmove CTRL+F7
Size _pwbresize CTRL+F8
Restore _pwbrestore CTRLA+F5
Minimize _pwbminimize CTRL+F9
Maximize _pwbmaximize CTRL+F10
Cascade _pwbcascade F5

Tile _pwhbtile SHIFT+F5
Arrange _pwbarrange ALT+F5

n file _pwbwindown ALT+n
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Table 7.8 Help Menu and Keys

Menu Command Macro or Function Default Keys
Index _pwbhelp_index Unassigned
Contents _pwbhelp_contents SHIFT+F1
Topic _pwbhelp_context F1

Help on Help _pwbhelp_general Unassigned
Next _pwbhelp_again Unassigned
Search Results _pwbhelp_searchres Unassigned

7.3 PWB Default Key Assignments

PWB’s default keys assignments are shown in table 7.9. In each position having
the text Unassigned, you can assign a function or macro to that key without taking
away a default keystroke. You cannot assign keys for positions that are empty.
These can usually be expressed in a different way. For example, CTRL+{ is ex-
pressed as SHIFT+CTRL+.

Table 7.9 PWB Default Key Assignments

Key Plain SHIFT ALT CTRL CTRL+SHIFT
! Graphic —_— — —_— —
# Graphic —_— — —_— —
$ Graphic —_ —_— —_— —
% Graphic — — — —
& Graphic — —_— —_— —
( Graphic — —_ —_— —
* Graphic — — —_— —_
+ Graphic — o —_— —
Graphic — Unassigned — —
- Graphic —_ Unassigned Unassigned —
. Graphic — Unassigned Unassigned _—
/ Graphic —— Unassigned Unassigned —
0 Graphic e Unassigned Unassigned —
1 Graphic — _pwbwindow1 Unassigned —
2 Graphic —_— _pwbwindow2 Unassigned —
3 Graphic —_ _pwbwindow3 Unassigned —_—
4 Graphic — _pwbwindow4 Unassigned —
5 Graphic — _pwbwindow5 Unassigned —
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Table 7.9 (continued)

Key Plain SHIFT ALT CTRL CTRL+SHIFT
6 Graphic — _pwbwindow6 Unassigned —_—
7 Graphic — _pwbwindow7 Unassigned —
8 Graphic —_— _pwbwindow8 Unassigned ——
9 Graphic —_— _pwbwindow9 Unassigned —
Graphic e Unassigned —_ Unassigned
Graphic —_— Unassigned Unassigned —_
< Graphic — Unassigned —_— Unassigned
= Graphic — Assign Unassigned —
> Graphic — Unassigned — Unassigned
? Graphic — Unassigned — Unassigned
@ Graphic —_ — —_ Unassigned
A Graphic Graphic Arg Mword Unassigned
B Graphic Graphic (Browse menu) Unassigned Unassigned
C Graphic Graphic Unassigned Ppage Unassigned
D Graphic Graphic Unassigned Right Unassigned
E Graphic Graphic (Edit menu) Up Unassigned
F Graphic Graphic (File menu) Pword Unassigned
G Graphic Graphic Unassigned Cdelete Unassigned
H Graphic Graphic (Help menu) Unassigned Unassigned
I Graphic Graphic Unassigned Unassigned Unassigned
J Graphic Graphic Unassigned Sinsert Unassigned
K Graphic Graphic Unassigned Unassigned Unassigned
L Graphic Graphic Unassigned Replace Unassigned
M Graphic Graphic Unassigned Mark Unassigned
N Graphic Graphic Unassigned Linsert Unassigned
0 Graphic Graphic (Options menu) Lasttext Unassigned
P Graphic Graphic (Project menu) Quote Unassigned
Q Graphic Graphic Unassigned Unassigned Unassigned
R Graphic Graphic (Run menu) Mpage Record
S Graphic Graphic (Search menu) Left Sethelp
T Graphic Graphic Unassigned Tell Unassigned
U Graphic Graphic Unassigned Lastselect Unassigned
v Graphic Graphic Unassigned Insertmode Unassigned
W Graphic Graphic (Window menu) Mlines Unassigned
X Graphic Graphic Unassigned Down Unassigned
Y Graphic Graphic Unassigned Ldelete Unassigned
Z Graphic Graphic Unassigned Plines Unassigned
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Table 7.9 (continued)

Key Plain SHIFT ALT CTRL CTRL+SHIFT
[ Graphic — Unassigned Pbal Unassigned
\ Graphic —_ Unassigned Qreplace Unassigned
] Graphic — Unassigned Setwindow Unassigned
A Graphic — —_ —_— Unassigned
_ Graphic o — — Unassigned
{ Graphic —_— Unassigned —_— e
I Graphic -— Unassigned —_— —_—
} Graphic —_ Unassigned —_— —_
~ Graphic o Unassigned —_— Unassigned
F1 _pwbhelp- _pwbhelp- _pwbhelp_back Pwbhelpnext Unassigned
_context _contents
F2 Setfile _pwbsavefile Unassigned Unassigned Unassigned
F3 Psearch _pwbnextmsg Unassigned Compile _pwbnext-
logmatch
F4 Msearch _pwbprevmsg _pwbquit _pwbclose _pwbprevious-
logmatch
F5 _pwbcascade _pwbtile _pwbarrange _pwbrestore Unassigned
F6 Selwindow _pwb- Unassigned Winstyle Unassigned
prevwindow
F7 Execute Refresh Unassigned _pwbmove Unassigned
F8 Exit Initialize Unassigned _pwbresize Unassigned
F9 Meta Shell Unassigned _pwbminimize Unassigned
F10 Openfile Unassigned Unassigned _pwbmaximize Unassigned
F11 Unassigned Unassigned Unassigned Unassigned Unassigned
F12 Unassigned Unassigned Unassigned Unassigned Unassigned
F13 Unassigned Unassigned Unassigned Unassigned Unassigned
F14 Unassigned Unassigned Unassigned Unassigned Unassigned
F15 Unassigned Unassigned Unassigned Unassigned Unassigned
F16 Unassigned Unassigned Unassigned Unassigned Unassigned
LEFT Left Select Unassigned Mword Select
RIGHT  Right Select Unassigned Pword Select
UP Up Select Unassigned Mlines Unassigned
DOWN  Down Select Unassigned Plines Unassigned
INS Insertmode Paste Unassigned Copy Unassigned
DEL _pwbclear Delete Unassigned Unassigned Unassigned
HOME  Begline Select Unassigned Begfile Select
END Endline Select Unassigned Endfile Select
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Table 7.9 (continued)

Key Plain SHIFT ALT CTRL CTRLA+SHIFT
ENTER  Emacsnewl Newline Unassigned Unassigned Unassigned
BKSP Emacscdel Emacscdel Undo Unassigned Undo
ESC Cancel Unassigned Unassigned Unassigned Unassigned
GOTO Home Unassigned Unassigned Unassigned Unassigned
NUM* Graphic Copy Unassigned Unassigned Unassigned
NUM+  Graphic Paste Unassigned Pwbrowsenext Unassigned
NUM- Graphic Delete Unassigned Pwbrowseprev Unassigned
NUM/ Graphic — Unassigned Unassigned Unassigned
NUM- Emacsnewl Newline Unassigned Unassigned Unassigned
ENTER
PGUP Mpage Select Unassigned Unassigned Select
PGDN Ppage Select Unassigned Unassigned Select
TAB Tab Backtab Unassigned Unassigned Unassigned
Note on Available Keys

PWB allows you to assign functions and macros to almost any key combination.
However, some keys have a fixed meaning in certain circumstances or operating
environments. PWB lists these key as available keys in the Key Assignments
dialog box, and PWB allows you to assign a command to the key. However, when
the circumstance holds, or you are running PWB in a specific environment, certain
keys have a fixed meaning that overrides any assignment that you make.

Help Window

In the Help window, the following keys have a fixed meaning:
Key Meaning

ESC Close the Help window

TAB Move to next hyperlink

SHIFT+TAB Move to previous hyperlink

ENTER Activate current hyperlink

NUMENTER Activate current hyperlink

SHIFT+ENTER Activate current hyperlink
SHIFT+NUMENTER Activate current hyperlink

SPACE Activate current hyperlink
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Dialog Boxes
In dialog boxes, all keys have predetermined meanings. Your assignments have no
effect when a dialog box is displayed. In particular, note the following keys:

Key Meaning

ESC Choose Cancel

ENTER Choose the active command button

F1 Choose Help

TAB Move to the next option or command

SHIFT+TAB ~ Move to the previous option or command

SPACE Toggle active option

CTRL+P When used in a text box, inserts the next key as a literal value. Use this

key to type a literal tab character.

The Text Argument dialog box is an exception. All keys except ESC (Cancel) and
F1 (Help) have their assigned meaning.

Microsoft Windows
When running PWB under Windows, some keys are reserved for use by Win-
dows. You can override Windows’ use of these keys by setting options in a PIF

file.

Key Default Meaning in Windows

ALT+ESC Switch to the next window in Windows
CTRL+ESC Switch to the Windows Task Manager

ALT+TAB Switch to the next application

ALT+SPACE Activate the current window’s system menu
ALT+ENTER Shift application between full screen and window

7.4 PWB Functions

PWB provides a rich variety of editing, searching, and project-management capa-
bilites in the form of functions. Most of PWB’s menus and dialogs call these func-
tions (or macros that use these functions) to perform their actions. You can write
your own macros that use these capabilities in ways that precisely suit your needs.
You can also execute every function directly, either by pressing a key or by using
the Execute function.

Table 7.10 summarizes PWB functions. Most functions can be executed in differ-
ent ways to perform related actions. Complete details are given in the A-to-Z refer-
ence that follows the table.
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Table 7.10 PWB Functions

Function Description Keys
Arg Begin a function argument ALT+A
Arrangewindow Arrange windows or icons Unassigned
Assign Define a macro or assign a key ALT+=
Backtab Move to previous tab stop SHIFT+TAB
Begfile Move to beginning of file CTRL+HOME
Begline Move to beginning of line HOME
Cancel Cancel arguments or current operation ~ ESC
Cancelsearch Cancel background search Unassigned
Cdelete Delete character CTRL+G
Clearmsg Clear Build Results Unassigned
Clearsearch Clear Search Results Unassigned
Closefile Close current file Unassigned
Compile Compile and build CTRLA+F3
Copy Copy selection to the clipboard CTRL+INS,
SHIFT+NUM*
Curdate Today’s date (dd-Mmm-yyyy) Unassigned
Curday Day of week (Tue) Unassigned
Curtime Current time (hour:minute:second) Unassigned
Delete Delete selection SHIFT+DEL,
SHIFT+NUM-
Down Move down one line CTRL+X, DOWN
Emacscdel Delete character BKSP, SHIFT+BKSP
Emacsnewl Start a new line ENTER, NUMENTER
Endfile Move to end of file CTRL+END
Endline Move to end of line END
Environment Set or insert environment variable Unassigned
Execute Execute macros and functions by F7
name
Exit Advance to next file or leave PWB F8
Graphic Type character (many)
Home Move to window corner GOTO
Information (Obsolete) -
Initialize Reinitialize SHIFT+F8
Insert Insert spaces or lines Unassigned
Insertmode Toggle insert/overtype mode CTRL+V, INS
Lastselect Recover last selection CTRL+U
Lasttext Recover last text argument CTRL+O
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Table 7.10 (continued)

Function Description Keys
Ldelete Delete lines CTRL+Y
Left Move left CTRL+S, LEFT
Linsert Insert lines or indent line CTRL+N
Logsearch Toggle search logging Unassigned
Mark Set, clear, or go to a mark or line CTRL+M

number
Maximize Enlarge window to full size Unassigned
Menukey Activate menu ALT
Message Display a message or refresh the Unassigned

screen
Meta Modify the action of a function F9
Mgrep Search across files for text or pattern Unassigned
Minimize Shrink window to an icon Unassigned
Mlines Scroll down by lines CTRL+UP, CTRLAW
Movewindow Move window Unassigned
Mpage Move up one page CTRL+R, PGUP
Mpara Move up one paragraph Unassigned
Mreplace Multifile replace with confirmation Unassigned
Mreplaceall Multifile replace Unassigned
Msearch Search backward for pattern or text F4
Mword Move back one word CTRL+A, CTRL+LEFT
Newfile Create a new pseudofile Unassigned
Newline Move to the next line SHIFT+ENTER,

SHIFT+NUMENTER
Nextmsg Go to build message location Unassigned
Nextsearch Go to search match location Unassigned
Noedit Toggle the no-edit restriction Unassigned
Openfile Open a new file F10
Paste Insert file or text from clipboard SHIFT+INS,
SHIFT+NUM+

Pbal Balance paired characters CTRLH
Plines Scroll up by lines CTRL+DOWN, CTRL+Z
Ppage Move down one page CTRL+C, PGDN
Ppara Move down one paragraph Unassigned
Print Print file or selection Unassigned
Project Set or clear project Unassigned
Prompt Request text argument Unassigned
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Table 7.10 (continued)

Function Description Keys
Psearch Search forward for pattern or text F3
Pwbhelp Help topic lookup Unassigned
Pwbhelpnext Relative help topic lookup CTRL+F1
Pwbhelpsearch Global full-text help search Unassigned
Pwbrowse1stdef Go to first definition Unassigned
Pwbrowse Istref Go to first reference Unassigned
Pwbrowsecalltree Browse Call Tree (Fwd/Rev) Unassigned
Pwbrowseclhier Browse Class Hierarchy Unassigned
Pwbrowsecltree Browse Class Tree (Fwd/Rev) Unassigned
Pwbrowsefuhier Browse Function Hierarchy Unassigned
Pwbrowsegotodef ~ Browse Goto Definition Unassigned
Pwbrowsegotoref ~ Browse Goto Reference Unassigned
Pwbrowselistref Browse List References Unassigned
Pwbrowsenext Browse Next CTRL+NUM+
Pwbrowseoutline Browse Module Outline Unassigned
Pwbrowsepop Go to previously browsed location Unassigned
Pwbrowseprev Browse Previous CTRL+NUM-
Pwbrowseviewrel ~ Browse View Relationship Unassigned
Pwbrowsewhref Browse Which Reference? Unassigned
Pwbwindow Open a PWB window Unassigned
Pword Move forward one word CTRL+F, CTRL+RIGHT
Qreplace Replace with confirmation CTRL+\
Quote Insert literal key CTRLAP
Record Toggle macro recording SHIFT+CTRLA+R
Refresh Reread or discard file SHIFT+F7
Repeat Repeat the last editing operation Unassigned
Replace Replace pattern or text CTRL+L
Resize Resize window Unassigned
Restcur Restore saved position Unassigned
Right Move right CTRL+D, RIGHT
Saveall Save all modified files Unassigned
Savecur Save cursor position Unassigned
Sdelete Delete streams Unassigned
Searchall Highlight occurrences of pattern or Unassigned
text
Selcur Select to saved position Unassigned
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Table 7.10 (continued)

Function Description Keys
Select Select text SHIFT+PGUP,
SHIFT+CTRL+PGUP,
SHIFT+PGDN,
SHIFT+CTRL+PGDN,
SHIFT+END,
SHIFT+CTRL+END,
SHIFT+HOME,
SHIFT+CTRL+HOME,
SHIFT+LEFT,
SHIFT+CTRL+LEFT,
SHIFT+UP,
SHIFT+RIGHT,
SHIFT+CTRL+RIGHT,
SHIFT+DOWN
Selmode Change selection mode: box Unassigned
Selwindow Move to window F6
Setfile Open or change files F2
Sethelp Opens, closes, and lists help files SHIFT+CTRL+S
Setwindow Adjust file in window CTRL+]
Shell Start a shell or run a system command  SHIFT+F9
Sinsert Insert a stream of blanks or break line ~ CTRL+J
Tab Move to the next tab stop TAB
Tell Show key assignment or macro CTRL+T
definition
Unassigned Remove a function assignment from (All unassigned keys)
akey
Undo Undo and redo editing operations ALT+BKSP,
SHIFT+CTRL+BKSP
Up Move up CTRL+E, UP
Usercmd Execute a custom Run menu Unassigned
command
Window Move to next or previous window Unassigned
Winstyle Add or remove scroll bars CTRL+F6

Cursor-Movement Commands

PWB provides the following commands to navigate through text. In addition to the
commands in the PWB editor, the Source Browser provides powerful commands
to navigate through the source of your programs.
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Table 7.11 Cursor-Movement Commands

Cursor Movement Command Keys

Up one line Up UP

Down one line Down DOWN

Left one column Left LEFT

Right one column Right RIGHT
Upper-left corner of window Home GOTO

Top of window Meta Up F9 UP

Bottom of window Meta Down F9 DOWN
Leftmost column in window Meta Left F9 LEFT
Rightmost column in window Meta Right F9 RIGHT
Lower-right corner of window Meta Home F9 GOTO

Up one window Mpage PGUP

Down one window Ppage PGDN

Column one Meta Begline FO HOME

One column past window width ~ Meta Endline F9 END

Back one word Mword CTRL+LEFT
Forward one word Pword CTRL+RIGHT
Beginning of line Begline HOME

End of line Endline END

Next paragraph Ppara Unassigned
Previous paragraph Mpara Unassigned

End of paragraph Meta Ppara F9 Unassigned
End of previous paragraph Meta Mpara F9 Unassigned
Beginning of file Begfile CTRL+HOME
End of file Endfile CTRL+END

To specific line number Arg number Mark ~ ALT+A number CTRL+M
Position before last scroll Arg Mark ALT+A CTRL+M
Saved position Restcur Unassigned
Named mark Arg name Mark ALT+A name CTRL+M
Scroll window down one line Mlines CTRL+UP

Scroll window up one line Plines CTRL+DOWN
Scroll window so cursor at top Arg Plines ALT+A CTRL+DOWN
Scroll window so cursor at Arg Mlines ALT+A CTRL+UP
bottom

Scroll window so cursor at Arg Setwindow ALT+A CTRL+]

home
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Arg

Key

Examples

>

ALT+A
Arg
Begin an argument to a function or begin a selection.
After you execute Arg, PWB displays Arg[1] on the status bar. Each time you
execute Arg, PWB increments the Arg count.

PWB functions perform variations of their action depending on the Arg count and
the “Meta state.” You can use the Meta and Arg function prefixes in any order.
See: Meta.

To select text or create a function argument:
1. Execute Arg (ALT+A).
2. Execute a cursor-movement function.
Or hold down the SHIFT key and click the left mouse button.
PWRB creates a stream, box, or line selection based on the current selection mode.

A selection in each of these modes creates a function argument called “streamarg,”
“boxarg,” or “linearg,” respectively.

To create a text argument:

1. Execute Arg (ALT+A).

2. Type the text of the argument.

When you type the first character of the argument, PWB displays the Text Argu-
ment dialog box where you can enter the textarg without modifying your file. The
Text Argument dialog box does not have an OK button; instead, you execute the

function to which you are passing the text argument. Choose Cancel to save the
text and do nothing.

To “pick up” text from a window:

1. Select the text that you want to use in the Text Argument dialog box.
2. Execute Lasttext (CTRL+O).
PWB copies the selected text into the text argument dialog box.

To cancel an argument or selection:

= Execute Cancel (ESC).
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Returns

See

The return value of Arg cannot be tested.

Cancel, Lastselect, Lasttext, Meta, Prompt

Arrangewindow

Key

Returns

Unassigned

Arrangewindow
Cascades all unminimized windows on the desktop. Does not affect minimized
windows. See: _pwhbcascade.

Arg Arrangewindow (ALT+A Unassigned)
Arranges all unminimized windows on the desktop. Does not affect minimized
windows. See: _pwbarrange.

Meta Arrangewindow (F9 Unassigned)
Tiles up to 16 unminimized windows. Does not affect minimized windows.
See: _pwhtile.

Meta Arg Arrangewindow (F9 ALT+A Unassigned)
Arranges all icons (minimized windows) on the desktop.

True Windows or icons arranged.
False Nothing to arrange, or more than 16 windows open.

Assign

Key

ALT+=

The Assign function assigns a function to a keystroke, defines a macro, or sets a
PWB switch. You can also assign keys and set switches by using the commands in
the Options menu. To see the current assignment for a key or the definition of a
macro, use Options Keys Assignments or the Tell function (CTRL+T). See: Tell.

Assign
Performs the assignment using the text on the current line. If the line ends with
a line continuation, PWB uses the next line, and so on for all continued lines.

Arg Assign (ALT+A ALT+=)
Same as Assign, except uses text starting from the cursor.
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Returns

Example

Update

>

Arg textarg Assign (ALT+A fextarg ALT+=)
Performs the assignment using the specified textarg.

Arg mark Assign (ALT+A mark ALT+=)
Performs the assignment using the text from the line at the cursor to the speci-
fied mark. The mark argument can be either a line number or a previously
defined mark name. See: Mark.

Arg boxarg | linearg | streamarg Assign (ALT+A boxarg | linearg | streamarg ALT+=)
Performs the assignment using the selected text. Ignores blank and comment
lines.

True Assignment successful.
False Assignment invalid.

To set the Tabstops switch to 8:

1. Execute Arg (ALT+A).
2. Type the following switch assignment:

tabstops:8

3. Execute Assign (ALT+=).

Assign

Arg Assign
With PWB 1.x, Assign and Arg Assign do not recognize line continuations.
With PWB 2.00, they use all continued lines for the assignment.

Arg streamarg Assign
With PWB 1.x, a streamarg is not allowed. With PWB 2.00, Assign accepts a
streamarg.

Arg ? Assign
With PWB 1.x, this form of the Assign function displays the current assign-

ments for all functions, switches, and macros in the “<ASSIGN>Current As-
signments and Switch Settings” pseudofile.

With PWB 2.00, the <ASSIGN> pseudofile does not exist; therefore, this form
of the Assign function is obsolete. If you use this command or execute a macro
that executes this command, PWB issues the error:

Missing ':' in '?°'

PWB is expecting an assignment or definition using the name ?, which is a
legal macro name.
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Backtab

Key

Returns

Update

See

SHIFT+TAB
Backtab
Moves the cursor to the previous tab stop on the line.
True Cursor moved.
False Cursor is at left margin.

PWB 2.0 supports variable tab stops. PWB 1.x supports only fixed-width tab stops.

Tab, Tabstops

Begfile

Key CTRL+HOME

Begfile

Moves the cursor to the beginning of the file.

Returns True Cursor moved.

False Cursor not moved; the cursor is already at the beginning of the file.
See Endfile
Begline
Key HOME

Begline

Places the cursor on the first nonblank character in the line.

Meta Begline (F9 HOME)
Places the cursor in the first character position of the line (column one).
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Returns

Example

Example

See

True Cursor moved.
False Cursor not moved; the cursor is already at the destination.

The following macro moves the cursor to column one, then toggles between
column one and the first nonblank character of the line.

toggle_begline := Left ->x Meta :>x Begline

The result of the Left function is tested to determine if the cursor is already in
column one. If the cursor is in column one, PWB skips the Meta and executes
Begline to move to the first nonblank character. If the cursor is not in column one,
PWB executes Meta Begline to move there.

This macro mimics the behavior of the BRIEF HOME key:

bhome:= Meta Begline +> Home +> Begfile

The result of Meta Begline (go to column 1 on the line) is tested to determine if
the cursor moved. If the cursor moved, the test (+>) succeeds and the macro exits.
If the cursor did not move, the cursor is already in column 1, so the macro ad-
vances to the home position with Home. If the cursor did not move going to the
home position, the macro advances to the beginning of the file with Begfile.

Left, Meta

Cancel

Key

ESC

Cancel
Cancels the current selection, argument, or operation. If a message appears on
the status bar, the Cancel function restores the original contents of the status
bar.

If a dialog box or menu is open, Cancel closes the dialog box or menu and
takes no further action. If Help on a dialog box, menu, or message box is being
displayed, Cancel closes the Help dialog box.
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Returns

See

Cancel always returns true.

Arg

Cancelsearch

Key

Returns

See

Unassigned

Cancelsearch
Cancels a background search.

The Search Results window contains the partial results of the aborted search
and is not flushed. You can browse matches listed in the Search Results by
using the Next Match, Previous Match, and Goto Match commands from the
Search menu and by using the Nextsearch function (Unassigned).

Cancelsearch applies only to multithreaded environments.

True Background search was canceled.

False No background search in progress.

Nextsearch, _pwbnextlogmatch, _pwbpreviouslogmatch, _pwbgotomatch

Cdelete

Key

CTRLA+G

Cdelete
Deletes the previous character, excluding line breaks. If the cursor is in column
1, Cdelete moves the cursor to the end of the previous line.

In insert mode, Cdelete deletes the previous character, reducing the line length
by 1.

In overtype mode, Cdelete deletes the previous character and replaces it with a
space character. If the cursor is beyond the end of the line, the cursor moves to
the immediate right of the last character on the line.

Emacscdel is similar to Cdelete. However, in insert mode, Emacscdel deletes
line breaks; in overtype mode beyond the end of the line, it does not automat-
ically move to the end of the line.
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Returns True Cursor moved.
False Cursor not moved.
See Delete, Emacscdel, Ldelete, Sdelete
Clearmsg
Key Unassigned
Clearmsg

Clears the contents of the Build Results window.

Arg Clearmsg (ALT+A Unassigned)
Clears the current set of messages in the Build Results window.

Returns True Cleared a message set or the contents of Build Results.
False The Build Results window is empty.
See Nextmsg, _pwbnextmsg, _pwbprevimsg, _pwbsetmsg
Clearsearch
Key Unassigned
Clearsearch

Clears the contents of the Search Results window.

Arg Clearsearch (ALT+A Unassigned)
Clears the current set of matches in the Search Results window.

Returns True Cleared a match set or the contents of Search Results.
False The Search Results window is empty.
See Clearmsg, Logsearch, _pwbnextlogmatch, _pwbpreviouslogmatch,

—pwbgotomatch
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Closefile

Key

Returns

See

Unassigned

Closefile
Closes the file in the active window. If no files remain in the window’s file his-
tory, the window is also closed.

Arg Closefile (ALT+A Unassigned)
Closes the file named by the text at the cursor.

Arg linearg | boxarg | streamarg Closefile
(ALT+A linearg | boxarg | streamarg Unassigned)
Closes the file named by the selected text.

Arg textarg Closefile (ALT+A textarg Unassigned)
Closes the specified file.

True The file was closed.
False No file was closed.

Refresh, _pwhbclosefile

Compile

Key

CTRL+F3

The Compile function compiles and builds targets in the project or runs external
commands, capturing the result of the operation in the Build Results window.
Under multithreaded environments the commands run in the background.

Arg Compile (ALT+A CTRL+F3)
Compiles the current file. This is equivalent to Project Compile File. Arg
Compile fails if no project is open. See: _pwbcompile.

Arg textarg Compile (ALT+A textarg CTRL+F3)
Builds the target specified by textarg. This is equivalent to Build Target com-
mand on the Project menu. Arg textarg Compile fails if no project is open.

To build the current project, execute Arg al1 Compile.

Arg Meta textarg Compile (ALT+A textarg F9 CTRL+F3)
Rebuilds the specified target and its dependents. See: _pwbrebuild.
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Returns

This command is equivalent to specifying the NMAKE /a option. Note that you
can also include NMAKE command-line macro definitions in the text you pass
to the Compile function.

Arg Meta Compile (ALT+A F9 CTRL+F3)
Aborts the background compile after prompting for confirmation. Also clears
the queue of pending background operations (if any).

Arg Arg textarg Compile (ALT+A ALT+A fextarg CTRL+F3)
Runs the program or operating-system command specified by zextarg. The out-
put is displayed in the Compile Results window.

Under multithreaded environments, the program runs in the background, and
the Compile Results window is updated as the program executes. Several pro-
grams can be queued for background execution.

Do not use this command to execute an interactive program. The program is
able to change the display but may not receive input. To run an interactive pro-
gram, use the Shell function (SHIFT+F9).

True Operation successfully initiated.
False Operation not initiated.

Copy

Keys

Menu

CTRL+INS, SHIFT+NUM*

Edit menu, Copy command

Copy
Copies the current line to the clipboard.

Arg Copy (ALT+A CTRL+INS)
Copies text from the cursor to the end of the line. The text is copied to the clip-
board, but the line break is not included.

Arg boxarg | linearg | streamarg Copy
(ALT+A boxarg | linearg | streamarg CTRL+INS)
Copies the selected text to the clipboard.

Arg textarg Copy (ALT+A textarg CTRL+INS)
Copies the specified textarg to the clipboard.

Arg mark Copy (ALT+A mark CTRL+INS)
Copies the text from the cursor to the mark. The text is copied to the clipboard.
The mark argument can be either a line number or a previously defined mark.
See: Mark.
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Returns

See

The text is copied as a boxarg or linearg depending on the relative positions of
the cursor and the mark. If the cursor and the mark are in the same column, the
text is copied as a linearg. If the cursor and the mark are in different columns,
the text is copied as a boxarg.

Arg number Copy (ALT+A number CTRL+INS)
Copies the specified number of lines to the clipboard, starting with the current
line. For example, Arg 5 Copy copies five lines to the clipboard.

Copy always returns true.

Delete, Ldelete, Sdelete, Paste

Curdate

Key

Returns

See

Unassigned

Curdate
Types the current date at the cursor in the format day-month-year, for example:
17-Apr-1999.

True Date typed.
False Typing the date would make the line too long.

Curday, Curfile, Curfilenam, Curfileext, Curtime

Curday

Key

Unassigned

Curday
Types the three-letter abbreviation for the current day of the week, as follows:
Mon Tue Wed Thu Fri Sat Sun.



166 Environment and Tools

Returns True Day typed.
False Typing the day would make the line too long.
See Curdate, Curfile, Curfilenam, Curfileext, Curtime
Curtime
Key Unassigned
Curtime
Types the current time in the format hours:minutes:seconds, for example,
17:08:32.
Returns True Time typed.
False Typing the time would make the line too long.
See Curdate, Curday, Curfile, Curfilenam, Curfileext
Delete
Keys SHIFT+DEL, SHIFT+NUM—
Menu Edit menu, Cut command

Delete
Deletes the single character at the cursor, excluding line breaks. It does not
copy the deleted character onto the clipboard. Note that the Delete function can
delete more than one character, depending on the current selection mode.

Arg Delete (ALT+A SHIFT+DEL)
Deletes from the cursor to the end of the line. The deleted text is copied onto
the clipboard. In stream selection mode, the deletion includes the line break and
joins the current line to the next line.

Arg boxarg | linearg | streamarg Delete
(ALT+A boxarg | linearg | streamarg SHIFT+DEL)
Deletes the selected text. The text is copied on to the clipboard.
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Meta ... Delete (F9 ... SHIFT+DEL)
As above but discards the deleted text. The contents of the clipboard are not
changed.

Returns Delete always returns true.
Down
Keys DOWN, CTRL+X
Down
Moves the cursor down one line. If a selection has been started, it is extended
by one line. If this movement results in the cursor moving out of the window,
the window is adjusted downward as specified by the Vscroll switch.
Meta Down (F9 DOWN)
Moves the cursor to the bottom of the window without changing the column
position.
Returns True Cursor moved.
False Cursor did not move; the cursor is at the destination.
See Up

Emacscdel

Keys

BKSP, SHIFT+BKSP

Emacscdel
Deletes the previous character. If the cursor is in column 1, Emacscdel moves
the cursor to the end of the previous line.

In insert mode, Emacscdel deletes the previous character, reducing the length
of the line by 1. If the cursor is in column one, Emacscdel deletes the line
break, joining the current line to the previous line.

In overtype mode, Emacscdel deletes the previous character and replaces it
with a space character. If the cursor is in column 1, Emacscdel moves the cur-
sor to the end of the previous line and does not delete the line break.
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Emacscdel is similar to Cdelete, but Cdelete never deletes line breaks; in over-
type mode beyond the end of the line, Cdelete automatically moves to the end
of the line.

Returns True Cursor moved.
False Cursor not moved.

See Cdelete, Delete, Ldelete, Sdelete

Emacsnewl

Keys ENTER, NUMENTER
Emacsnewl

In insert mode, starts a new line. In overtype mode, moves the cursor to the
beginning of the next line. PWB automatically positions the cursor on the new
line, depending on the setting of the Softcr switch.

Returns Emacsnewl always returns True.

Update In PWB 1.x, PWB performs special automatic indentation for C files. In PWB
2.00, language-specific automatic indentation is handled by language extensions
if the feature is enabled. Otherwise, PWB uses its default indentation rules.

See Newline, Softcr, C_Softcr

Endfile

Key

CTRL+END

Endfile
Places the cursor at the end of the file.
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Returns True Cursor moved.
False Cursor did not move; the cursor is at the end of the file.
See Begfile
Endline
Key END
Endline
Moves the cursor to the immediate right of the last character on the line.
Meta Endline (F9 END)
Moves the cursor to the column that is one column past the active window
width.
Returns True Cursor moved.
False Cursor did not move; the cursor is at the destination.
See Begline, Traildisp, Trailspace

Environment

Key

Unassigned

Environment
Executes the current line as an environment-variable setting.

For example, if the current line contains the following text when you execute
Environment:

PATH=C:\UTIL;C:\DOS

PWB adds this setting to the current environment table. The effect is the same
as the operating-system SET command. PWB uses the new environment vari-
able for the rest of the session (including shells).

Depending on the settings of the Envcursave and Envprojsave switches,
PWB saves the environment table for PWB sessions and/or projects.
See: Envcursave, Envprojsave.
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Returns

Update

Arg textarg Environment (ALT+A fextarg Unassigned)
Executes the argument as an environment-variable setting.

Arg linearg | boxarg Environment (ALT+A linearg | boxarg Unassigned)
Executes each selected line or line fragment as an environment-variable setting.

Meta Environment (Fo Unassigned)
Performs environment-variable substitutions for all variables on the current
line, replacing each variable with its value.

The syntax for an environment variable is
$(ENV) | $ENV:
where ENV is the uppercase name of the environment variable.

Arg Meta Environment (ALT+A F9 Unassigned)
Performs environment-variable substitutions (described above) for the text
from the cursor to the end of the line.

Arg boxarg | linearg | streamarg Meta Environment
(ALT+A boxarg | linearg | streamarg F9 Unassigned)
Performs environment-variable substitutions for the selected text.

True Environment variable successfully set or substituted.
False Syntax error or line too long.

Because the <KENVIRONMENT> pseudofile no longer exists, this form of the
Environment function is obsolete; it is replaced by the Environment command
on the Options menu.

Execute

Key

F7

The Execute function executes PWB functions and macros by name. It allows you
to execute commands that are not assigned to a key or execute a sequence of com-
mands in one step.

The Execute function executes the commands by the same rules as macros. Func-
tion prompts are suppressed, and you can use the macro flow-control and macro
prompt directives. You do not need to define a macro to use these features.

Arg Execute (ALT+A F7)
Executes the text from the cursor to the end of the line as a PWB macro.
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Returns

Arg linearg | textarg Execute (ALT+A linearg | textarg ¥7)
Executes the specified text as a PWB macro.

True Last executed function returned true.

False Last executed function returned false.

Exit

Key

Returns

See

F8

Exit
If you specified multiple files on the PWB command line, PWB advances to the
next file. Otherwise, PWB quits and returns control to the operating system.

If the Autosave switch is set to yes, the file is saved if it has been modified. If
Autosave is no and the file is modified, PWB prompts for confirmation to save
the file.

Meta Exit (F9 F3)
Performs like Exit with the Autosave switch set to no, independent of the cur-
rent setting of Autosave. If you have changed any files, PWB asks for confir-
mation to save before exiting.

Arg Exit (ALT+A F8)
Like Exit, except PWB quits immediately without advancing to the next file (if
any).

Arg Meta Exit (ALT+A F9 F8)

Like Meta Exit, except PWB quits immediately without advancing to the next
file.

No return value.

—pwbquit
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Graphic

Keys Assigned to most alphanumeric and punctuation keys.
Graphic
Types the character corresponding to the key that you pressed.
Returns True The character is typed.
False Typing the character would make the line too long.
See Assign, Quote
Home
Key GoTo (Numeric-keypad 5)
Home
Places the cursor in the upper-left corner of the window.
Meta Home (F9 GOTO)
Places the cursor in the lower-right corner of the window.
Returns True Cursor moved.
False Cursor not moved; it is already at the destination.
See Begline, Endline, Left, Right
Initialize
Key SHIFT+F8
Initialize

Discards all current settings, including extension settings, then reads the state-
ments from the [PWB] section of TOOLS.INI.

Arg Initialize (ALT+A SHIFT+F8)
Reads the statements from a tagged section of TOOLS.INI. The tag name is
specified by the continuous string of nonblank characters starting at the cursor.
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Example

Example

Returns

Arg textarg Initialize (ALT+A fextarg SHIFT+ES)
Reads the statements from the TOOLS.INI tagged section specified by rextarg.

The section tagged with

[PWB-name]

is initialized by the command

Arg name Initialize

To reload the main section of TOOLS.INI without clearing other settings that
you want to remain in effect, label the main section of TOOLS.INI with the tag:

[PWB PWB-main]

then use Arg main Initialize to recover your main settings instead of using
Initialize with no arguments.

True Initialized tagged section in TOOLS.INI.
False Did not find tagged section in TOOLS.INI.

Information

Update

(obsolete)

The PWB 1.x Information function and its associated pseudofile
<INFORMATION-FILE> are obsolete; they do not exist in PWB 2.00.

Insert

Key

Unassigned

Insert
Inserts a single-space character at the cursor, independent of the insert/overtype
mode.

Arg Insert (ALT+A Unassigned)
Breaks the line at the cursor.
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Arg boxarg | linearg | streamarg Insert
(ALT+A boxarg | linearg | streamarg Unassigned)
Inserts space characters into the selected area.

Returns True Spaces or line break inserted.
False Insertion would make a line too long.
Example If paragraphs in your file consist of a sequence of lines beginning in the same

column and are separated from other paragraphs by at least one blank line, the
following macro indents a paragraph to the next tab stop:

para_indent:=_pwbboxmode Meta Mpara Down Begline Arg \
Meta Ppara Up Begline Tab Insert

This macro starts with the predefined PWB macro _pwbboxmode to set box selec-

tion mode, then creates a box selection from the beginning of the paragraph to the
end, one tab stop wide. The Insert function inserts spaces in the selection.

See Sinsert, Linsert

Insertmode

Keys INS, CTRL+V

Insertmode
Toggles between insert mode and overtype mode. If overtype mode is on, the
letter O appears on the status bar. The cursor can also change shape, depending
on the Cursormode switch. See: Cursormode.

In insert mode, each character you type is inserted at the cursor. This insertion
shifts the remainder of the line one position to the right.

In overtype mode, the character you type replaces the character at the cursor.

Returns True PWB is in insert mode.
False PWRB is in overtype mode.
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Lastselect

Key

See

CTRL+U

Lastselect
Duplicates the last selection.

The Arg count and Meta state that were previously in effect are not duplicated—
only the selection. The new Arg count is one, and the Meta state is the current
Meta state. To use a higher Arg count, execute Arg (ALT+A). To toggle the

Meta state, execute Meta (F9).

The re-created selection uses the same pair of line:column coordinates as the
previous selection. Thus, different text can be selected if you have made addi-
tions or deletions to the file since the last selection.

Arg, Lasttext, Meta

Lasttext

Key

Returns

CTRL+O

Lasttext
Displays the last text argument in the Text Argument dialog box. You can edit
the text and then execute any PWB function that accepts a text argument, or
you can cancel the dialog box.

If you edit the text and then cancel the dialog box, PWB retains the modified
text. Thus, when you execute Lasttext again, the new text appears in the dialog
box.

Arg [[Arg]... [Meta]] Lasttext (ALT+A [[ALT+A]l... [F9]] CTRL+O)
Displays the last text argument in the Text Argument dialog box with the speci-
fied Arg count and Meta state.

Arg [[Arg]l... linearg | boxarg | streamarg [Meta]| Lasttext

(ALT+A [[ALT+A]... linearg | boxarg | streamarg [[F9]] CTRL+O)
Displays the first line of the selection in the Text Argument dialog box with the
specified Arg count and Meta state.

The return value of Lasttext cannot be tested.
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Example

Example

See

The OpenInclude macro that follows opens an include file named in the next
#include directive. The macro demonstrates a technique using the Lasttext func-
tion to pick up text from the file and modify it without modifying the file or the
clipboard.

OpenInclude := \
Up Meta Begline Arg Arg "~[ \tI##[ \t]*include" Psearch -> \
Arg Arg "[<>\"]" Psearch -> Right Savecur Psearch -> \
Selcur Lasttext Begline "$INCLUDE:" Openfile <n +> \

Lastselect Openfile <

In the fourth line, Lasttext pulls the selected filename into the Text Argument
dialog box. The text argument is modified to prepend $INCLUDE: before passing
it to the Openfile function.

In some macro-programming situations, you don’t want to use the text immedi-
ately. Instead, you need to pick up some text, do some other processing, then use
the text. In this situation, use the phrase:

(make selection) Lasttext Cancel ...

This picks up the text, then cancels the Text Argument dialog box. The selected
text remains in the Lasttext buffer for later use. To reuse the text, call Lasttext
again.

Arg, Lastselect, Meta, Prompt

Ldelete

Key

CTRL+Y

Ldelete
Deletes the current line and copies it to the clipboard.

Arg Ldelete (ALT+A CTRL+Y)
Deletes text from the cursor to the end of the line and copies it to the clipboard.

Arg mark Ldelete (ALT+A mark CTRL+Y)
Deletes the text from the line at the cursor to the line specified by mark and
copies it to the clipboard. The mark cannot be a line number.

Arg number Ldelete (ALT+A number CTRL+Y)
Deletes the specified number of lines starting from the line at the cursor and
copies them to the clipboard.
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Returns

See

Arg boxarg | linearg Ldelete (ALT+A boxarg | linearg CTRL+Y)
Deletes the specified text and copies it to the clipboard. The argument is a
linearg or boxarg regardless of the current selection mode. The argument is a
linearg if the starting and ending points are in the same column.

Meta ... Ldelete (F9 ... CTRL+Y)
As above but discards the deleted text. The clipboard is not changed.

Ldelete always returns true.

Cdelete, Delete, Emacscdel, Sdelete

Left

Keys

Returns

See

LEFT, CTRL+S

Left
Moves the cursor one character to the left. If this movement results in the cur-
sor moving out of the window, the window is adjusted to the left as specified by
the Hscroll switch.

Meta Left (Fo LEFT)
Moves the cursor to the first column in the window.

True Cursor moved.
False Cursor not moved; the cursor is in column one.

Begline, Down, Endline, Home, Right, Up

Linsert

Key

CTRLAN

Linsert
Inserts one blank line above the current line.

Arg Linsert (ALT+A CTRL+N)
Inserts or deletes blanks at the beginning of a line to move the first nonblank
character to the cursor.
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Arg boxarg | linearg Linsert (ALT+A boxarg | linearg CTRL+N)
Inserts blanks within the specified area.

The argument is a linearg or boxarg regardless of the current selection mode.
The argument is a linearg if the starting and ending points are in the same
column.

Arg mark Linsert (ALT+A mark CTRL+N)
Like boxarg | linearg except the specified area is given by the cursor position
and the position of the specified mark. The mark argument must be a named
mark: it cannot be a line number. See: Mark.

Returns Linsert always returns true.
See Insert, Sinsert
Logsearch
Key Unassigned

Logsearch

Toggles the search-logging state.
The default search-logging mode when PWB starts up is determined by the

Enterlogmode switch.
Returns True Search logging turned on.
False Search logging turned off.
Mark
Key CTRL+M

The Mark function moves the cursor to a mark or specific location, defines marks,
and deletes marks. Note that you cannot set a mark at specific text in a PWB win-
dow such as Help; PWB marks only the window position.

If you want to save marks between sessions, assign a filename to the Markfile
switch or use the Set Mark File command on the Search menu.
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Mark (CTRL+M)
Moves the cursor to the beginning of the file.

Arg Mark (ALT+A CTRL+M)
Restores the cursor to its location prior to the last window scroll. Use Arg
Mark to return to your previous location after a search or other large jump.

Arg number Mark (ALT+A number CTRL+M)
Moves the cursor to the beginning of the line specified by number in the current
file. Line numbering starts at 1.

Arg textarg Mark (ALT+A textarg CTRL+M)
Moves the cursor to the specified mark.

Arg Arg textarg Mark (ALT+A ALT+A textarg CTRL+M)
Defines a mark at the cursor position. The name of the mark is specified by
textarg.

Arg Arg textarg Meta Mark (ALT+A ALT+A textarg F9 CTRL+M)
Deletes the specified mark. This form of the Mark function always returns true.

Returns True Move, definition, or deletion successful.
False Invalid argument or mark not found.
See Markfile, Restcur, Savecur, Selcur
Maximize
Key Unassigned
Maximize

Expands the window to its maximum size. If the window is already maximized,
the window is restored.

When the window is maximized and scroll bars are turned off by using the
Winstyle function, PWB turns off the window borders. This is the “clean
screen” look.

Meta Maximize (F9 Unassigned)
Restores the window to its original size.
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Returns True Window is maximized.
False Window is restored.
See Minimize, Winstyle

Menukey

Key ALT

Menukey
Activates the menu bar. Unlike other PWB functions, Menukey can be
assigned to only one key. It cannot be assigned to a combination of keys.

Returns You cannot test the return value of Menukey.
Message
Key Unassigned

Message

Clears the status bar.

Arg Message (ALT+A Unassigned)
Displays the text from the cursor to the end of the line on the status bar.

Arg textarg Message (ALT+A textarg Unassigned)
Displays textarg on the status bar.

Meta ... Message (F9 ... Unassigned)
As above and also repaints the screen.

Returns Message always returns true.
Example The following macro is useful when writing new macros (the ! is the macro
name):

I := Meta Message

With this definition you can place an exclamation point in your macros wherever
you want a screen update. If you also want to display a status-bar message at the
time of the update, use the phrase:
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... Arg "text of message"' ! ...

See Prompt
Meta
Key F9
Meta
Modifies the action of the function it prefixes.
When the Meta state is turned on, the letter A (for “Alternate”) appears in the
status bar. You can use the Meta and Arg function prefixes in any order.
Returns True Meta state turned on.
False Meta state turned off.
See Arg, Lasttext, Lastselect

Mgrep

Key

Unassigned

The Mgrep function searches all the files listed in the Mgreplist macro. PWB
places all matches in the Search Results window. Under multithreaded environ-
ments, PWB performs the search in the background.

To browse the list of matches, use _ pwbnextlogmatch (CTRL+SHIFT+F3),
_pwbpreviouslogmatch (CTRL+SHIFT+F4), and the Nextsearch function
(Unassigned).

Mgrep (Unassigned)
Searches for the previously searched string or pattern.

Arg Mgrep (ALT+A Unassigned)
Searches for the string specified by the characters from the cursor to the first
blank character.

Arg textarg Mgrep (ALT+A textarg Unassigned)
Searches for textarg.
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Arg Arg Mgrep (ALT+A ALT+A Unassigned)
Searches for the regular expression specified by the characters from the cursor
to the first blank character.

Arg Arg textarg Mgrep (ALT+A ALT+A textarg Unassigned)
Searches for the regular expression specified by textarg.

Meta ... Mgrep (9 ... Unassigned)
As above except that the value of the Case switch is reversed for the search.

Returns True
With MS-DOS, indicates that a match was found. With multithreaded environ-
ments, indicates that a background search was successfully initiated.
False
No matches, no search pattern specified, search pattern invalid, or search termi-
nated by CTRL+BREAK.

Update In PWB 2.00, search and build results and their browsing functions are separate.
A background build operation and a background search can be performed
simultaneously.

In PWB 1.x, search and build results appear in the same window, and are browsed
with the same commands. A background build operation and a multifile search
cannot be performed at the same time in PWB 1.x.

Minimize

Key Unassigned
Minimize

Shrinks the active window to an icon (a minimized window). If the window is
already minimized, restores the window.

Arg Minimize (ALT+A Unassigned)
Minimizes all open windows.

Meta Minimize (F9 Unassigned)
Restores the window to its unminimized state.
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Returns True Window minimized: the window is an icon.
False Window restored: the window is not an icon.
See Maximize

Mlines

Keys CTRL+UP, CTRL+W
Mlines
Scrolls the window down as specified by the Vscroll switch.

Arg Mlines (ALT+A CTRL+UP)
Scrolls the window so the line at the cursor moves to the bottom of the window.

Arg number Mlines (ALT+A number CTRL+UP)
Scrolls the window down by number lines.

Returns True Window scrolled.
False Invalid argument.
See Plines
Movewindow
Key Unassigned
Movewindow

Enters window-moving mode. In window-moving mode, only the following
actions are available:

Action Key
Move up one row UP
Move down one row DOWN
Move left one column LEFT
Move right one column RIGHT

Accept the new position ENTER
Cancel the move ESC
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Returns

Arg number Movewindow (ALT+A number Unassigned)
Moves the upper-left corner of the window to the screen row specified by
number.

Meta Arg number Movewindow (F9 ALT+A number Unassigned)
Moves the upper-left corner of the window to the screen column specified by
number.

True Window moved.
False Window not moved.

Mpage

Keys PGUP, CTRL+R

Mpage

Moves the cursor backward in the file by one window.

Returns True Cursor moved.

False Cursor not moved.
See Ppage
Mpara
Key Unassigned

Mpara

Moves the cursor to the beginning of the first line of the current paragraph. If
the cursor is already on the first line of the paragraph, it is moved to the begin-
ing of the first line of the preceding paragraph.

Meta Mpara (F9 Unassigned)
Moves the cursor to the first blank line preceding the current paragraph.
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Returns

See

True Cursor moved.
False Cursor not moved; no more paragraphs in the file.

Ppara

Mreplace

Key

Returns

See

Unassigned

Mreplace
Performs a find-and-replace operation across multiple files, prompting for
the find-and-replacement strings and for confirmation at each occurrence.
Mreplace searches all the files listed in the special macro Mgreplist.

Arg Arg Mreplace (ALT+A ALT+A Unassigned)
Performs the same action as Mreplace but uses regular expressions.

Meta ... Mreplace (F9 ... Unassigned)
As above except reverses the sense of the Case switch for the operation.

True At least one replacement made.

False No replacements made or operation aborted.

Mgrep, Mreplaceall, Qreplace, Replace

Mreplaceall

Key

Unassigned

Mreplaceall
Performs a find-and-replace operation across multiple files, prompting for the
find-and-replacement strings. Mreplaceall searches all the files listed in the
special macro Mgreplist.

Arg Arg Mreplaceall (ALT+A ALT+A Unassigned)
Performs the same action as Mreplaceall but uses regular expressions.

Meta ... Mreplaceall (F9 ... Unassigned)
As above except reverses the sense of the Case switch for the operation.
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Returns

See

True At least one replacement made.
False No replacements made or operation aborted.

Mgrep, Mreplace, Qreplace, Replace

Msearch

Key

Returns

See

F4
Msearch
Searches backward for the previously searched string or pattern.

Arg Msearch (ALT+A F4)
Searches backward for the string specified by the text from the cursor to the
first blank character.

Arg textarg Msearch (ALT+A textarg F4)
Searches backward for the specified text.

Arg Arg Msearch (ALT+A ALT+A F4)
Searches backward for the regular expression specified by the text from the cur-
sor to the first blank character.

Arg Arg textarg Msearch (ALT+A ALT+A textarg F4)
Searches backward for the regular expression defined by rextarg.

Meta ... Msearch (F9 ... F4)
As above except reverses the sense of the Case switch for the search.

True String found.
False Invalid argument, or string not found.

Mgrep, Psearch
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Mword

Keys CTRL+LEFT, CTRL+A
Mword
Moves the cursor to the beginning of the current word, or if the cursor is not in
a word or at the beginning of the word, moves the cursor to the beginning of the
previous word. A word is defined by the Word switch.
Meta Pword (F9 CTRL+RIGHT)
Moves the cursor to the immediate right of the previous word.
Returns True Cursor moved.
False Cursor not moved; there are no more words in the file.
See Pword
Newfile
Key Unassigned

The Newfile function creates a new pseudofile. If the Newwindow switch is set to
yes, it opens a new window for the file.

Newfile (Unassigned)
Creates a new untitled pseudofile. The new pseudofile is given a unique name
of the form:

<Untitled.nnn>Untitled.nnn

where nnn is a three-digit number starting with 001 at the beginning of each
PWB session. The window title shows Untitled.@01. Use the pseudofile name
<Untitled.001> to refer to the file in a text argument or dialog box.

Arg Newfile (ALT+A Unassigned)
Creates a new pseudofile with the name specified by the text from the cursor to
the end of the line. The resulting full pseudofile name is:

“<Text on the line>Text on the line"

Arg textarg Newfile (ALT+A textarg Unassigned)
Creates a new pseudofile with the name specified by fextarg. The resulting full
pseudofile name is:

"<textarg>textarg"
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Returns

If you want to use a different short name and window title, use the full name
as an argument to the Setfile or Openfile functions. For example, Arg
"<temp>Temporary File" Openfile opens a pseudofile in a new window that
has the title Temporary File.

True Successfully created the pseudofile.
False Unable to create the pseudofile.

Newline

Keys

Returns

Update

See

SHIFT+ENTER, SHIFT+NUMENTER

Newline
Moves the cursor to a new line.

If the Softer switch is set to yes, PWB automatically indents to an appropriate
position based on the type of file you are editing.

Meta Newline (F9 SHIFT+ENTER)
Moves the cursor to column 1 of the next line.

Newline always returns true.

In PWB 1.x, PWB performs special automatic indentation for C files. In PWB
2.00, language-specific automatic indentation is handled by language extensions
if the feature is enabled. Otherwise, PWB uses its default indentation rules.

Emacsnewl

Nextmsg

Key

Unassigned

Nextmsg
Advances to next message in the Build Results window.

Arg number Nextmsg (ALT+A number Unassigned)
Moves to the nth message in the current set of messages, where # is specified
by number.
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Returns

Update

See

To move relative to the current message, use a signed number. For example,
when number is +1, PWB moves to the next message, and when it is -1, PWB
moves to the previous message.

Arg Nextmsg (ALT+A Unassigned)
Moves to the next message in the current set of messages that does not refer to
the current file.

Meta Nextmsg (F9 Unassigned)
Advances to the next set of messages.

Arg Arg Nextmsg (ALT+A ALT+A Unassigned)
Sets the message at the cursor as the current message. This works only when
the cursor is on a message in the Build Results window.

True Message found.
False No more messages found.

In PWB 1.x, Nextmsg also browses the results of searches. In PWB 2.00, search
results are browsed with the Nextsearch function.

Meta Nextmsg
In PWB 1.x, deletes the current set of messages and advances to the next set. In
PWB 2.00, Meta Nextmsg does not delete the set. To delete sets of messages
in PWB 2.00, use the Clearmsg function.

Meta Arg Arg Nextmsg
In PWB 1.x, closes the Compile Results window. In PWB 2.00, it behaves like
Arg Arg Nextmsg.

Clearmsg

Nextsearch

Key

Unassigned

Nextsearch
Advances to the next match in the Search Results window.

Arg number Nextsearch (ALT+A number Unassigned)
Moves to the nth match in the current set of matches, where 7 is specified by
number.

To move relative to the current match, use a signed number. For example, when
number is +1, PWB moves to the next match, and when it is 1, PWB moves to
the previous match.
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Update

See

Arg Nextsearch (ALT+A Unassigned)
Moves to the next match in the current set of matches that does not refer to the
current file.

Meta Nextsearch (Fo Unassigned)
Advances to the next set of matches.

Arg Arg Nextsearch (ALT+A ALT+A Unassigned)
Sets the match at the cursor as the current match. This works only when the cur-
sor is on a match in the Search Results window.

In PWB 1.x, the results of searches are browsed using the Nextmsg function.

Clearsearch

Noedit

Key

Returns

Unassigned

The Noedit function toggles the no-edit state of PWB or the current file. When
the no-edit state is turned on, PWB displays the letter R on the status bar and dis-
allows modification of the file.

Noedit
Toggles the no-edit state. If you started PWB with the /R (read-only) option,
Noedit removes the no-edit limitation.

Meta Noedit (F9 Unassigned)
Toggles the no-edit state for the current file. This form of the Noedit command
works only for disk files and has no effect on pseudofiles.

If you have the Editreadonly switch set to no, PWB turns on the no-edit state
for files that are marked read-only on disk. This function toggles the no-edit
state for the file so that you can modify it.

True File or PWB in no-edit state; modification disallowed.
False File or PWB not in no-edit state; modification allowed.
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Openfile

Key

Returns

See

F10

The Opentfile function opens a file in a new window, ignoring the Newwindow
switch.

Arg Openfile (ALT+A F10)
Opens the file at the cursor in a new window. The name of the file is specified
by the text from the cursor to the first blank character.

Arg textarg Openfile (ALT+A fextarg F10)
Opens the specified file in a new window.

If the argument is a wildcard, PWB creates a pseudofile containing a list of files
that match the pattern. To open a file from this list, position the cursor at the
beginning of the name and use Arg Openfile or Arg Setfile.

True File and window successfully opened.
False No argument specified, or file did not exist and you did not create it.

Newfile, Setfile

Paste

Keys

SHIFT+INS, SHIFT+NUM+

Edit menu, Paste command

Paste (SHIFT+INS)
Copies the contents of the clipboard to the file at the cursor. The text is always
inserted independent of the insert/overtype mode.

If the clipboard contents were copied to the clipboard as a linearg, PWB inserts
the contents of the clipboard above the current line. Otherwise, the contents of
the clipboard are inserted at the cursor.

Arg boxarg | linearg | streamarg Paste
(ALT+A boxarg | linearg | streamarg SHIFT+INS)
Replaces the selected text with the contents of the clipboard.

Arg Paste (ALT+A SHIFT+INS)
Copies the text from the cursor to the end of the line. The text is copied to the
clipboard and inserted at the cursor.
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Returns

Example

Arg textarg Paste (ALT+A textarg SHIFT+INS)
Copies textarg to the clipboard and inserts it at the cursor.

Arg Arg filename Paste (ALT+A ALT+A filename SHIFT+INS)
Copies the contents of the file specified by fextarg to the current file above the
current line.

Arg Arg !textarg Paste (ALT+A ALT+A !filename SHIFT+INS)
Runs fextarg as an operating-system command, capturing the command’s out-
put to standard output. The output is copied to the clipboard and inserted above
the current line.

You must enter the exclamation mark as shown.

True Paste always returns true except for the following cases.

False Tried Arg Arg filename Paste and file did not exist, or the pasted text
ould make a line too long.

The following command copies a sorted copy of the file SAMPLE.TXT to the cur-
rent file: Arg Arg !SORT <SAMPLE.TXT Paste (ALT+A ALT+A !SORT <SAMPLE.TXT
SHIFT+INS).

Phal

Key

CTRLA+[

Pbal
Scans backward through the file, balancing parentheses (( )) and brackets ([ ]).
The first unmatched parenthesis or bracket is highlighted when found.

If an unbalanced parenthesis or bracket is found, it is highlighted and the corre-
sponding character is inserted at the cursor. If no unbalanced characters are
found, PWB displays a message box.

The search does not include the cursor position and looks for more opening
brackets or parentheses than closing ones.

Arg Pbal (ALT+A CTRL+)
Like Pbal except that it scans forward through the file and searches for right
brackets or parentheses lacking opening partners.

Meta Pbal (F9 CTRL+[)
Like Pbal but does not insert the unbalanced character. If no unbalanced charac-
ters are found, moves to the matching character.
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Arg Meta Pbal (ALT+A F9 CTRL+[)
Like Arg Pbal but does not insert the character. If no unbalanced characters are
found, moves to the matching character.

Update In PWB 1., the messages appear on the status bar. In PWB 2.00, they appear in a
message box.

Returns True Balance successful.
False Invalid argument, or no unbalanced characters found.

See Infodialog

Plines

Keys CTRL+DOWN, CTRL+Z
Plines

Scrolls the text up as specified by the Vseroll switch.

Arg Plines (ALT+A CTRL+DOWN)
Scrolls the text such that the line at the cursor is moved to the top of the
window.

Arg number Plines (ALT+A number CTRL+DOWN)
Scrolls the text up by number lines.

Returns True Text scrolled.
False Invalid argument.

See Mlines
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Ppage

Keys PGDN, CTRL+C
Ppage
Moves the cursor forward in the file by one window.
Returns True Cursor moved.
False Cursor not moved.
See Mpage
Ppara
Key Unassigned
Ppara
Moves the cursor to the beginning of the first line of the next paragraph.
Meta Ppara (F9 Unassigned)
Moves cursor to the beginning of the first blank line after the current paragraph.
If the cursor is not on a paragraph, moves the cursor to the first blank line after
the next paragraph.
Returns True Cursor moved.
False Cursor not moved; no more paragraphs in the file.
See Mpara
Print
Key Unassigned

The Print function prints files or selections. If the Printcmd switch is set, PWB
uses the command line given in the switch. Otherwise, PWB copies the file or
selection to PRN. Under multithreaded environments, PWB runs the print com-
mand in the background.
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Print (Unassigned)
Prints the current file.

Arg textarg Print (ALT+A textarg Unassigned)
Prints all the files listed in zextarg. Use a space to separate each name from the
preceding name. You can use environment variables to specify paths for the
files.

Arg boxarg | linearg | streamarg Print
(ALT+A boxarg | linearg | streamarg Unassigned)
Prints the selected text.

Arg Meta Print (ALT+A F9 Unassigned)
Cancels the current background print.

Returns True Print successfully submitted.
False Could not start print job.
Update In PWB 1.x there is no way to cancel a background print.
Project
Key Unassigned
Project
Open the last project.

Arg Project (ALT+A Unassigned)
Open the project makefile at the cursor as a PWB project. The name of the pro-
ject is specified by the text from the cursor to the first blank character.

Arg textarg Project (ALT+A textarg Unassigned)
Open the project makefile specified by fextarg as a PWB project.

Arg Arg Project (ALT+A ALT+A Unassigned)
Close the current project.

Arg Meta Project (ALT+A F9 Unassigned)
Open the project makefile at the cursor as a non-PWB project (foreign
makefile).

Arg textarg Meta Project (ALT+A textarg F9 Unassigned)
Open the project makefile specified by textarg as a non-PWB project.
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Returns

See

True A project is open.
False A project is not open.

Lastproject

Prompt

Key

Returns

Example

Unassigned

The Prompt function displays the Text Argument dialog box where you can enter
a text argument. You can use this function interactively, but because it is mainly
useful in macros, it is not assigned to a key by default. You usually use Lasttext
or Arg to directly enter a text argument.

Prompt
Displays the Text Argument dialog box without a title. See: Lasttext

Arg Prompt (ALT+A Unassigned)
Uses the text of the current line from the cursor to the end of the line as the title.

Arg textarg Prompt (ALT+A fextarg Unassigned)
Uses rextarg as the title.

Arg boxarg | linearg | streamarg Prompt

(ALT+A boxarg | linearg | streamarg Unassigned)
Uses the selected text as the title. If the selection spans more than one line, the
title is the first line of the selected text.

True Textarg entered; the user chose the OK button.
False The dialog box was canceled.

With the following macro, PWB prompts for a Help topic:

QueryHelp := Arg "Help Topic to Find:" Prompt -> Pwbhelp
QueryHelp : Ctr1+Q
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When you press CTRL+Q, PWB displays a dialog box with the string Help Topic
to Find: as the title and waits for a response. PWB passes your response to the
Pwbhelp function as if the command Arg textarg Pwbhelp had been executed.
If you cancel the dialog box, Prompt returns false and the macro conditional ->
terminates the macro without executing Pwbhelp.

See Assign

Psearch

Key F3
Psearch

Searches forward for the previously searched string or pattern.

Arg Psearch (ALT+A F3)
Searches forward in the file for the string specified by the text from the cursor
to the first blank character.

Arg textarg Psearch (ALT+A textarg F3)
Searches forward for the specified text.

Arg Arg Psearch (ALT+A ALT+A F3)
Searches forward in the file for the regular expression specified by the text
from the cursor to the first blank character.

Arg Arg textarg Psearch (ALT+A ALT+A textarg F3)
Searches forward for the regular expression defined by textarg.

Meta ... Psearch (r9 ... F3)
As above but reverses the value of the Case switch for one search.

Returns True String found.
False Invalid argument, or string not found.
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Pwbhelp

Key Unassigned

Pwbhelp
Displays the default Help topic.

Arg Pwbhelp (ALT+A Unassigned)
Displays Help on the topic at the cursor. Equivalent to the macro
_pwbhelp_ context (F1).

Arg textarg Pwbhelp (ALT+A textarg Unassigned)
Displays Help on the specified text argument.

Arg streamarg Pwbhelp (ALT+A streamarg Unassigned)
Displays Help on the selected text. The selection cannot include more than one
line.

Meta Pwbhelp (r9 Unassigned)
Prompts for a key, then displays Help on the function or macro assigned to the
key you press.

If you press a key that is not assigned to a function or macro, PWB displays
help on the Unassigned function. If you press a key that PWB does not recog-
nize, the prompt remains displayed until you press a key that PWB recognizes.

Returns True Help topic found.
False Help topic not found.

Pwbhelpnext

Key CTRL+F1

Pwbhelpnext
Displays the next physical topic in the current Help database.

Meta Pwbhelpnext (F9 CTRL+F1)
Displays the previous Help topic on the backtrace list. This is the Help topic
that you previously viewed. Up to 20 Help topics are retained in the backtrace
list.

Equivalent to the Back button on the Help screens and the macro
—pwbhelp_back (ALT+F1).

Arg Pwbhelpnext (ALT+A CTRL+F1)
Displays the next occurrence of the current Help topic within the Help system.
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Returns

Equivalent to the macro _pwbhelp_again (Unassigned).

Use this command when the Help topic appears several times in the set of open
Help databases.

True Help topic found.
False Help topic not found.

Pwbhelpsearch

Key

Returns

Unassigned

The Pwbhelpsearch function performs a global search of the Help system. The
search is case insensitive unless you use the Meta form of Pwbhelpsearch, which
uses the setting of the Case switch to determine case sensitivity.

Pwbhelpsearch (Unassigned)
Displays the results of the last global Help search.

Equivalent to the predefined macro _pwbhelp_searchres (Unassigned).

Arg Pwbhelpsearch (ALT+A Unassigned)
Searches Help for the word at the cursor.

Arg textarg Pwbhelpsearch (ALT+A fextarg Unassigned)
Searches Help for the selected text.

Arg Arg Pwbhelpsearch (ALT+A ALT+A Unassigned)
Searches Help using the regular expression at the cursor.

Arg Arg textarg Pwbhelpsearch (ALT+A ALT+A textarg Unassigned)
Searches Help for the selected regular expression.

Meta ... Pwbhelpsearch (F9 ... Unassigned)
As above except the search is case sensitive if the Case switch is set to yes.

True At least one match found.
False No matches found, or search canceled.
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Pwbrowse Functions

Most of the Pwbrowse... functions provided by the PWBROWSE Source Browser
extension display one of the Source Browser’s dialog boxes. The Source Browser
functions attached to Browse menu commands are listed in the following table.

Function Browse Menu Command Key
Pwbrowsecalltree Call Tree (Fwd/Rev) Unassigned
Pwbrowseclhier Class Hierarchy Unassigned
Pwbrowsecltree Class Tree (Fwd/Rev) Unassigned
Pwbrowsefuhier Function Hierarchy Unassigned
Pwbrowsegotodef ~ Goto Definition Unassigned
Pwbrowsegotoref ~ Goto Reference Unassigned
Pwbrowselistref List References Unassigned
Pwbrowsenext Next CTRL+NUM+
Pwbrowseoutline Module Outline Unassigned
Pwbrowseprev Previous CTRL+NUM-
Pwbrowseviewrel ~ View Relationship Unassigned
Pwbrowsewhref Which Reference Unassigned

The browser functions in the following table do not correspond to a Browse menu

command.

Function Description Key
Pwbrowselstdef Go to 1st definition Unassigned
Pwbrowsel stref Go to 1st reference Unassigned

Pwbrowsepop Go to previously browsed location Unassigned
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Pwbwindow

Key

Returns

Unassigned

The Pwbwindow function opens PWB windows. If the specified window is
already open, PWB switches to that window.

Arg Pwbwindow (ALT+A Unassigned)
Opens the PWB window with the name at the cursor. The name is specified
by the text from the cursor to the first blank character.

Arg textarg Pwbwindow (ALT+A textarg Unassigned)
Opens the specified PWB window.

Arg Meta Pwbwindow (ALT+A F9 Unassigned)
Closes the PWB window specified by the name at the cursor.

Arg textarg Meta Pwbwindow (ALT+A textarg Fo Unassigned)
Closes the specified PWB window.

True The specified window was opened.

False The window could not be opened.

Pword

Keys

Returns

See

CTRL+RIGHT, CTRLA+F

Pword
Moves the cursor to the beginning of the next word. A word is defined by the
Word switch.

Meta Pword (F9 CTRL+RIGHT)
Moves the cursor to the immediate right of the current word, or if the cursor i
not in a word, moves it to the right of the next word.

True Cursor moved.
False Cursor not moved; there are no more words in the file.
Mword

S
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Qreplace

Key

Returns

See

CTRLH\

The Qreplace function performs a find-and-replace operation on the current file,
prompting for find-and-replacement strings and confirmation at each occurrence.

Qreplace (CTRL+)
Performs the replacement from the cursor to the end of the file, wrapping
around the end of the file if the Searchwrap switch is set to yes.

Arg boxarg | linearg | streamarg Qreplace
(ALT+A boxarg | linearg | streamarg CTRL+\)
Performs the replacement over the selected area.

Note that PWB does not adjust the selection at each replacement for changes in
the length of the text. For boxarg and streamarg, PWB may replace text that
was not included in the original selection or miss text included in the original
selection.

Arg mark Qreplace (ALT+A mark CTRL+\)
Performs the replacement on text from the cursor to the specified mark. Re-
places over text as if it were selected, according to the current selection mode.
The mark argument cannot be a line number. See: Mark.

Arg number Qreplace (ALT+A number CTRL+\)
Performs the replacement for the specified number of lines, starting with the
line at the cursor.

Arg Arg ... Qreplace (ALT+A ALT+A ... CTRL+)
As above except using regular expressions.

Meta ... Qreplace (F9 ... CTRL+\)
As above except the sense of the Case switch is reversed for the operation.

True At least one replacement was performed.
False String not found, or invalid pattern.

Mreplace, Replace, Searchwrap
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Quote

Key

Returns

CTRL+P

Quote
Reads one key from the keyboard and types it into the file or dialog box. In a
dialog box, the key is always CTRL+P, no matter what function or macro you
may have assigned to CTRL+P for the editor.

This is useful for typing a character (such as TAB or CTRL+L) whose keystroke is
assigned to a PWB function.

True Quote always returns true except in the following case.
False Character would make line too long.

Record

Key

SHIFT+CTRL+R

The Record function toggles macro recording. While a macro is being recorded,
PWB displays the letter X on the status bar, and a bullet appears next to the Re-
cord On command from the Edit menu. If a menu command cannot be recorded, it
is disabled while recording.

When macro recording is stopped, PWB assigns the recorded commands to the
default macro name Playback. During the recording, PWB writes the name of
each command to the definition of Playback in the Record window, which can
be viewed as it is updated.

Macro recording in PWB does not record changes in cursor position accomplished
by clicking the mouse. Use the keyboard if you want to include cursor movements
in a macro.

Record (SHIFT+CTRL+R)
Toggles macro recording on and off.

Arg textarg Record (ALT+A fextarg SHIFT+CTRL4R)
Turns on recording if it is off and assigns the name specified in the text argu-
ment to the recorded macro. Turns off recording if it is turned on.

Meta Record (F9 SHIFT+CTRLA+R)
Toggles macro recording. While recording, no editing commands are executed
until recording is turned off. Use this form of the function to record a macro
without modifying your file.
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Returns

Update

Arg Record (ALT+A SHIFT+CTRL+R)

Arg Arg textarg Record (ALT+A ALT+A fextarg SHIFT+CTRL+R)

Arg Arg Meta Record (ALT+A ALT+A F9 SHIFT+CTRL+R)
As above but if the target macro already exists, the commands are appended to
the end of the macro.

True Recording turned on.

False Recording turned off.

In PWB 2.00, more menu commands can be recorded than with PWB 1.x.

Refresh

Key

SHIFT+F7

Refresh
Prompts for confirmation and then rereads the file from disk, discarding its
Undo history and all modifications to the file since the file was last saved.

Returns Condition
True File reread.
False Prompt canceled

Arg Refresh (ALT+A SHIFT+F7)
Prompts for confirmation and then removes the file from the active window and
the window’s file history. If the active window is the last window that has the
file in its history, the file is discarded from memory without saving changes,
and the file is closed.

Returns Condition
True File removed from the window.
False Prompt canceled, or bad argument. The file is not removed from

the window.
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Repeat

Key

Returns

Unassigned

Repeat
Repeats the last editing action relative to the current cursor position. The
Repeat function considers the following types of operations to be editing
actions:

= Typing a contiguous stream of characters without entering a command or
moving the cursor

= Deleting text
= Pasting from the clipboard

Repeat does not repeat macros or cursor movements.

Arg number Repeat (ALT+A number Unassigned)
Performs the last action the number of times specified by number.

True Action repeated and returned true.

False Action repeated and returned false, or no action to repeat.

Replace

Key

CTRL+L

The Replace function performs a find-and-replace operation on the current file,
prompting for find and replacement strings. Replace substitutes all matches of the
search pattern without prompting for confirmation.

Replace (CTRL+L)
Performs the replacement from the cursor to the end of the file, wrapping
around the end of the file if the Searchwrap switch is on.

Arg boxarg | linearg | streamarg Replace
(ALT+A boxarg | linearg | streamarg CTRL+L)
Performs the replacement over the selected area.

Note that PWB does not adjust the selection at each replacement for changes in
the length of the text. For boxarg and streamarg, PWB may replace text that
was not included in the original selection or miss text included in the original
selection.
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Returns

See

Example

Arg mark Replace (ALT+A mark CTRL+L)
Performs the replacement on text from the cursor to the specified mark. It
searches the range of text as if it were selected, according to the current selec-
tion mode. The mark argument cannot be a line number.

Arg number Replace (ALT+A number CTRL+L)
Performs the replacement over the specified number of lines, starting with the
current line.

Arg Arg ... Replace (ALT+A ALT+A ... CTRL+L)
As above except using regular expressions.

Meta ... Replace (F9 ... CTRL+L)
As above except the sense of the Case switch is reversed for the operation.

True At least one replacement was performed.
False String not found, or invalid pattern.

Qreplace, Searchwrap

To use the replace function in a macro, use the phrase:

...Replace "pattern” Newline "replacement” Newline +>found...

Enter the replies to the prompts as you would when executing Replace interac-
tively. This example also shows where to place the conditional to test the result
of Replace.

You can specify special characters in the find-and-replacement strings by using
escape sequences similar to those in the C language. Note that backslashes in the
macro string must be doubled.

To restore the usual prompts, use the phrase:

...Replace <

To use an empty replacement text (replace with nothing), use the following phrase:

...Replace "pattern" Newline ™ " Cdelete Newline...

If you find that you write many macros with empty replacements, the common
phrase can be placed in a macro, as follows:

nothing := " " Cdelete Newline
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In addition, macro definitions can be more readable with the following definition:

with := Newline

With these definitions, you can write:

. Replace "pattern" with nothing ...

Resize

Key Unassigned

Resize
Enters window-resizing mode. When in window-resizing mode, only the fol-
lowing actions are available:

Action Key
Shrink one row upP
Expand one row DOWN
Shrink one column LEFT
Expand one column RIGHT
Accept the new size ENTER
Cancel the resize ESC

Arg number Resize (ALT+A number Unassigned)
Resizes the window to number rows high.

Arg number Meta Resize (ALT+A number F9 Unassigned)
Resizes the window to number columns wide.

See Movewindow
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Restcur

Key

Returns

See

Unassigned

Restcur
Moves the cursor to the last position saved with the Savecur function (Unas-
signed, Set To Anchor command, Edit menu). Restcur always clears the saved
position.

True Position restored.
False No saved position to restore.
Selcur

Right

Keys

Returns

Example

See

RIGHT, CTRL+D

Right
Moves the cursor one character to the right. If this action causes the cursor to
move out of the window, PWB adjusts the window to the right according to the
Hscroll switch.

Meta Right (Fo RIGHT)
Moves the cursor to the rightmost position in the window.

True Cursor on text in the line.
False Cursor past text on the line.

In a macro, the return value of the Right function can be used to test if the cursor
is on text in the line or past the end of the line.

The following macro tests the return value to simulate the Endline function:

MyEndline := Begline :>Toop Right +>loop

Begline, Endfile, Endline, Home, Left
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Saveall

Key

Returns

Unassigned

Saveall
Saves all modified disk files. Pseudofiles are not saved.

Saveall always returns true.

Savecur

Key

Returns

Unassigned

Edit menu, Set Anchor command

Savecur
Saves the cursor position (sets an anchor).

To restore the cursor to the saved position, use the Restcur function (Unas-
signed). To select text from the current position to the saved position, use
the Select To Anchor command from the Edit menu or the Selcur function
(Unassigned).

Savecur always returns true.

Sdelete

Key

Unassigned

Sdelete
Deletes the character at the cursor. Does not copy the character to the clipboard.

Arg Sdelete (ALT+A Unassigned)
Deletes text from the cursor to the end of the line, including the line break. The
deleted text is copied to the clipboard.
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Returns

Arg streamarg | boxarg | linearg Sdelete

(ALT+A streamarg | boxarg | linearg Unassigned)
Deletes the selected stream of text from the starting point of the selection to the
cursor and copies it to the clipboard. Always deletes a stream, regardless of the
current selection mode.

Meta ... Sdelete (F9 ... Unassigned)
As above but discards the deleted text. The contents of the clipboard are
unchanged.

Sdelete always returns true.

Searchall

Key

Returns

Unassigned

Searchall
Highlights all occurrences of the previously searched string or pattern. Moves
the cursor to the first occurrence in the file.

Arg Searchall (ALT+A Unassigned)
Highlights all occurrences of the string specified by the text from the cursor to
the first blank character.

Arg textarg Searchall (ALT+A textarg Unassigned)
Highlights all occurrences of textarg.

Arg Arg Searchall (ALT+A ALT+A Unassigned)
Highlights all occurrences of the regular expression defined by the characters
from the cursor to the first blank character.

Arg streamarg Searchall (ALT+A streamarg Unassigned)
Highlights all occurrences of streamarg.

Arg Arg textarg Searchall (ALT+A ALT+A textarg Unassigned)
Highlights all occurrences of a regular expression defined by textarg.

Meta ... Searchall (79 ... Unassigned)
As above but reverses the value of the Case switch for one search.

True String or pattern found.
False No matches found.
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Key Unassigned
Menu Edit menu, Select To Anchor command
Selcur
Selects text from the cursor to the position saved using the Set Anchor com-
mand from the Edit menu or the Savecur function (Unassigned). If no position
has been saved, Selcur selects text from the cursor to the beginning of the file.
Returns Selcur always returns true.
Keys SHIFT+PGUP, SHIFT+CTRL+PGUP, SHIFT+PGDN, SHIFT+CTRL+PGDN, SHIFT+END,
SHIFT+CTRL+END, SHIFT+HOME, SHIFT+CTRL+HOME, SHIFT+LEFT, SHIFT+CTRL+LEFT,
SHIFT+UP, SHIFT+RIGHT, SHIFT+CTRL+RIGHT, SHIFT+DOWN
Select
Causes a shifted key to take on the cursor-movement function associated with
the unshifted key and begins or extends a selection.
To see the key combinations currently assigned to this function, use the Key
Assignments command from the Options menu.
Key Unassigned
Selmode

Advances the selection mode between stream, line, and box modes, starting
with the current mode.



212 Environment and Tools

Returns

See

True New mode is stream mode.
False New mode is box mode or line mode.

_pwbstreammode, _pwbboxmode, _pwblinemode

Selwindow

Key

Returns

F6
Selwindow
Moves the focus to the next window.

Arg Selwindow (ALT+A F6)
Moves the focus to the next unminimized window. Minimized windows (icons)
are skipped.

Arg number Selwindow (ALT+A number F6)
Moves the focus to the specified window.

Meta Selwindow (F9 Fe6)
Moves the focus to the previous window.

Arg Meta Selwindow (ALT+A F9 F6)
Moves the focus to the previous unminimized window.

True Focus moved to another window.
False No other windows are open.

Seftfile

Key

F2

Setfile
Switches to the first file in the active window’s file history. If there are no
files in the file history, PWB displays the message No alternate file. When
the Autosave switch is set to yes, PWB saves the current file if it has been
modified.

Setfile does not honor the Newwindow switch. To open a new window when
you open a file, use Openfile.
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Arg Setfile (ALT+A F2)
Switches to the filename that begins at the cursor and ends with the first blank
character.

Arg textarg Setfile (ALT+A textarg F2)
Switches to the file specified by fextarg. If the file is not already open, PWB
opens it. You can use environment-variable specifiers in the argument.

If the argument is a drive or directory name, PWB changes the current drive or
directory to the specified one and displays a message to confirm the change.
See: Infodialog.

Arg 'number Setfile (ALT+A 'number ¥2)
If the argument has the form !number, PWB switches to the file with that
number in the file history. The number can be from 1 to 9, inclusive. See:
_pwbfilen.

Arg wildcard Setfile (ALT+A wildcard F2)
If the argument is a wildcard, PWB creates a pseudofile containing a list of files
that match the pattern. To open a file from this list, position the cursor at the
beginning of the name and execute Arg Openfile (ALT+A F10) or Arg Setfile
(ALT+A F2).

Meta ... Setfile (F9 ... F2)
As above but does not save the changes to the current file.

Arg Arg Setfile (ALT+A ALT+A F2)
Saves the current file.

Arg Arg textarg Setfile (ALT+A ALT+A textarg F2)
Saves the current file under the name specified by textarg.

Returns True File opened successfully.
False No alternate file, the specified file does not exist, and you did not wish
to create it; or the current file needs to be saved and cannot be saved.
See Newfile
Sethelp
Key SHIFT+CTRL+S

The Sethelp function opens and closes single Help files. The Sethelp function can
also display the current list of open Help files. Sethelp affects only the current
PWB session.
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Returns

See

Arg Sethelp (ALT+A SHIFT+CTRL+S)
Opens the Help file specified by the filename at the cursor.

Arg streamarg | textarg Sethelp (ALT+A streamarg | textarg SHIFT+CTRL+S)
Opens the Help file specified by the selected filename.

Meta ... Sethelp (F9 ALT+A SHIFT+CTRL+S)
As above except the specified Help file is closed.

Arg ? Sethelp (ALT+A ? SHIFT+CTRL+S)
Lists all currently open Help files.

True Help file opened or closed, or list of Help files displayed.

False The specified file could not be opened or closed, or the list of files
could not be displayed.

Helpfiles

Setwindow

Key

Returns

CTRLA+]

Setwindow
Redisplays the contents of the active window.

Meta Setwindow (F9 CTRL+])
Redisplays the current line.

Arg Setwindow (ALT+A CTRL+])
Adjusts the window so that the cursor position becomes the home position
(upper-left corner).

Setwindow always returns true.

Shell

Key

SHIFT+F9

Shell
Runs an operating-system command shell. To return to PWB, type exit at the
operating-system prompt.
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Returns

See

Warning Do not start terminate-and-stay-resident (TSR) programs in a shell.
This causes unpredictable results.

Arg Shell (ALT+A SHIFT+F9)
Runs the text from the cursor to the end of the line as a command to the shell,
and returns to PWB.

Arg boxarg | linearg Shell (ALT+A boxarg | linearg SHIFT+F9)
Runs each selected line as a separate command to the shell, and returns to PWB.

Arg textarg Shell (ALT+A textarg SHIFT+F9)
Runs textarg as a command to the shell, and returns to PWB.

Meta ... Shell (F9 ... SHIFT+F9)
Runs a shell, ignoring the Autosave switch. Modified files are not saved to
disk, but they are retained in PWB’s virtual memory.

True Shell ran successfully.
False Invalid argument, or error starting the operating-system command
processor.

Askrtn, Restart, Savescreen

Sinsert

Key

Returns

CTRLA+J

Sinsert
Inserts a space at the cursor.

Arg Sinsert (ALT+A CTRL+)
Inserts a line break at the cursor, splitting the line.

Arg streamarg | linearg | boxarg Sinsert

(ALT+A streamarg | linearg | boxarg CTRL+J)
Inserts a stream of blanks between the starting point of the selection and the cur-
sor. The insertion is always a stream, regardless of the current selection mode.

True Spaces or line break inserted.
False Insertion would make a line too long.
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Example The following macro inserts a stream of spaces up to the next tab stop, regardless
of the current selection mode:

InsertTab := Arg Tab Sinsert

See Insert, Linsert

Tab

Key TAB

Tab
Moves the cursor to the next tab stop. If there are no tab stops to the right of the
cursor, the cursor does not move. Tab stops are defined by the Tabstops switch.

Returns True Cursor moved.
False Cursor not moved.
Update In PWB 1.x, tab stops appear at fixed intervals. In PWB 2.00, tab stops can be at

variable or fixed intervals.

See Backtab

Tell

Key CTRLAT

Tell
Displays the message Press a key to tell about and waits for a keystroke.
After you press a key or combination of keys, Tell brings up the Tell dialog
box showing the name of the key and its assigned function in TOOLS.INI key-
assignment format.

The key-assignment format is:
Sfunction:key

If the key is not assigned a function, Tell displays unassigned for the function
name. See: Unassigned.
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Returns

Update

Remarks

If you press a combination of keys, but Tell still shows the Press a key
prompt (when you press SCROLL LOCK, for example), PWB is unable to recog-
nize that combination of keys and you cannot use it as a key assignment.

Arg Tell (ALT+A CTRL+T)
Prompts for a key, then displays the name of the function or macro assigned to
the key in one of these formats:

function:zkey
macroname:=definition

Arg textarg Tell (ALT+A textarg CTRLAT)
Displays the definition of the macro named by textarg. If you specify a PWB
function, Tell displays:

Sfunction:function

Meta ... Tell (F9 ... CTRL+T)
As above except Tell types the result into the current file rather than displaying
it in a dialog box. This is how to discover the definition of any macro, including
PWB macros.

True Assignment displayed or typed.
False No assignment for the key or the specified name.

In PWB 1.x, the prompt and results appear on the status bar; in PWB 2.00, the
prompt and results appear in dialog boxes.

Meta Tell is a convenient and reliable way of writing a key assignment when you
are configuring PWB.

For example, if you want to execute the Curdate function (type today’s date)
when you press the CTRL, SHIFT, and D keys simultaneously, perform the following
steps:

1. Go to an empty line in the [PWB] section of TOOLS.INI.
2. Execute Meta Tell (F9 CTRL+T).

Tell displays the message: Press a key to tell about.
3. Press the D, SHIFT, and CTRL keys simultaneously.

If you have not already assigned a function to this combination, Tell types:
unassigned:Shift+Ctr1+D

4. Select the word unassigned and type curdate.

5. If you want the assignment to take effect immediately, move the cursor to the
line you’ve just entered and execute the Assign function (ALT+=).
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See

You can use Meta Arg textarg Tell to recover the definition of a predefined PWB
macro or a macro that you have not saved or entered into a file.

Assign, Record

Unassigned

Keys

Returns

See

Assigned to all available keys.

Unassigned
Displays a message for keys that do not have a function assignment.

All unassigned keys are actually assigned the Unassigned function. Thus, to
remove a function assignment for a key, assign the Unassigned function to the
key. The Unassigned function is not useful in macros.

The Unassigned function always returns false.

Assign, Tell

Undo

Keys

Returns

See

ALT+BKSP, SHIFT+CTRL+BKSP

Undo
Reverses the last editing operation. The maximum number of times this can be
performed for each file is set by the Undocount switch.

Meta Undo (F9 ALT+BKSP)
Performs the operation previously reversed with Undo. This action is often
called “redo.”

True Operation undone or redone.
False Nothing to undo or redo.

—pwbundo, _pwbredo, Repeat
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Keys UP, CTRL+E

Up
Moves the cursor up one line. If a selection has been started, it is extended by
one line. If this movement results in the cursor moving out of the window, the
window is adjusted upward as specified by the Vscroll switch.

Meta Up (F9 UP)
Moves the cursor to the top of the window without changing the column
position.

Returns True Cursor moved.
False Cursor not moved; the cursor is already at the destination.

See Down

Usercmd

Key Unassigned

The Usercmd function executes a custom command added to the Run menu by
using Customize command from the Run menu or setting the User switch.

Arg number Usercmd (ALT+A number Unassigned)
Executes the given custom Run menu command. The number can be in the
range 1-9.

Returns True Command exists.

False Command does not exist, or invalid argument.
See —pwbusern

See Assign, Record
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Window

Key

Update

See

Unassigned
Window
Switch to the next window.
Returns Condition
True Switched to next window.
False No next window to switch to: zero or one window open.

Arg [[Arg]] Window (ALT+A [JALT+A]] Unassigned)
Open a new window.

Returns Condition
True Opened a new window.
False Window not opened.

Meta Window (F9 Unassigned)
Close the active window.

Returns Condition
True Window closed.
False No open window to close.

Meta Arg Window (ALT+A F9 Unassigned)
Switch to the previous window.

Returns Condition
True Switched to previous window.
False No previous window to switch to: zero or one window open.

In PWB 1.x, Arg Window and Arg Arg Window split the window at the cursor.
In PWB 2.00, these forms of Window open a new window.

Selwindow, Setwindow
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Winstyle

Key CTRLA+F6
Winstyle
Advances through the following series of window styles, starting from the cur-
rent style:
Horizontal Scroll Bar Vertical Scroll Bar
No No
No Yes
Yes No
Yes Yes

When the horizontal scroll bar is not shown, a maximized window does not
show its bottom border. Similarly, when the vertical scroll bar is not shown, a
maximized window does not show its left and right borders. PWB always dis-
plays the title bar.

To get the “clean-screen” look, maximize the window and advance the window
style until the borders disappear.

Default Set the default window style with the Defwinstyle switch.

Returns True Changed window style.
False No windows open.

Update The no-border state in PWB 1.x is not available in PWB 2.00. In PWB 2.00, when
a window is maximized and no scroll bars are present, PWB displays the window
without borders.

See Maximize
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1.5 Predefined PWB Macros

PWB predefines a number of macros, most of which correspond to a command in
the PWB menus. You can define a shortcut key for a menu command by assigning
the key to the corresponding macro. Note that some menu commands such as the
Open command from the File menu do not correspond to a macro, and some mac-
ros do not correspond to a menu command.

Table 7.12 PWB Macros

Macro Description Key
Curfile Current file’s full path Unassigned
Curfileext Current file’s extension Unassigned
Curfilenam Current file’s name Unassigned
_pwbarrange Arrange command, Window menu ALT+F5
_pwbboxmode Box Mode command, Edit menu Unassigned
_pwbbuild Build command, Project menu Unassigned
_pwbcancelbuild Cancel Build command, Project menu Unassigned
_pwbcancelprint Cancel Print command, File menu Unassigned
_pwbcancelsearch Cancel Search command, Search menu Unassigned
_pwbcascade Cascade command, Window menu F5
_pwbclear Delete command, Edit menu DEL
_pwbclose Close command, Window menu CTRL+F4
_pwbcloseall Close All command, Window menu Unassigned
_pwbclosefile Close command, File menu Unassigned
_pwbcloseproject Close command, Project menu Unassigned
_pwbcompile Compile command, Project menu Unassigned
_pwhbfilen n file, File menu Unassigned
_pwbgotomatch Goto Match command, Search menu Unassigned
_pwbhelp_again Next command, Help menu Unassigned
_pwbhelp_back Previous Help topic ALT+F1
_pwbhelp_contents Contents command, Help menu SHIFT+F1
_pwbhelp_context Topic command, Help menu F1
_pwbhelp_general Help on Help command, Help menu Unassigned
_pwbhelp_index Index command, Help menu Unassigned

_pwbhelpnl

_pwbhelp_searchres

_pwblinemode
_pwblogsearch

Display the message:
Online Help Not Loaded

Search Results command, Help menu
Line Mode command, Edit menu
Log command, Search menu

F1 when Help
extension not
loaded

Unassigned
Unassigned
Unassigned
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Table 7.12 (continued)

Macro Description Key
_pwbmaximize Maximize command, Window menu CTRL+F10
_pwbminimize Minimize command, Window menu CTRL+F9
_pwbmove Move command, Window menu CTRL+F7
_pwbnewfile New command, File menu Unassigned
_pwbnewwindow New command, Window menu Unassigned
_pwbnextfile Next command, File menu Unassigned
_pwbnextlogmatch Next Match command, Search menu SHIFT+CTRL+F3
_pwbnextmatch Next Match command, Search menu Unassigned
_pwbnextmsg Next Error command, Project menu SHIFT+F3
_pwbpreviouslogmatch ~ Previous Match command, Search menu  SHIFT+CTRL+F4
_pwbpreviousmatch Previous Match command, Search menu ~ Unassigned
_pwbprevmsg Previous Error command, Project menu SHIFT+F4
_pwbprevwindow Move to previous window SHIFT+F6
_pwbquit Exit command, File menu ALT+F4
_pwbrebuild Rebuild All command, Project menu Unassigned
_pwbrecord Record command, Edit menu Unassigned
_pwbredo Redo command, Edit menu Unassigned
_pwbrepeat Repeat command, Edit menu Unassigned
_pwbresize Resize command, Window menu CTRLA+F8
_pwbrestore Restore command, Window menu CTRL+F5
_pwbsaveall Save All command, File menu Unassigned
_pwbsavefile Save command, File menu SHIFT+F2
_pwbsetmsg Goto Error command, Project menu Unassigned
_pwbshell DOS Shell command, File menu Unassigned
_pwbstreammode Stream Mode command, Edit menu Unassigned
_pwhbtile Tile command, Window menu SHIFT+F5
_pwbundo Undo command, Edit menu Unassigned
_pwbusern command n, Run menu ALT+Fn
_pwbviewbuildresults View build results button Unassigned
_pwbviewsearchresults ~ View search results button Unassigned
_pwbwindown n file, Window menu ALT+n




224 Environment and Tools

PWB continually redefines the following macros to reflect the current file’s name:

Macro Description

Curfile Full path
Curfileext File extension
Curfilenam File base name

PWB uses the following special-purpose macros:

Macro Description

Autostart Executed on startup while reading TOOLS.INI
Mgreplist List of files for logged searches, multifile replace, Mgrep, and

Mreplace
Playback Default name of recorded macros
Restart (Obsolete)

By default, these macros are undefined.

Autostart

Key

Definition

Unassigned

The special PWB macro Autostart is executed after PWB finishes all initializa-
tion at startup. If used, it must be defined in the [PWB] section of TOOLS.INI.

By default, Autostart is not defined.

Curfile

Key

Definition

Unassigned

The Curfile macro types the full path of the current file. This macro is redefined
each time you switch to a new file.

curfile := "pathname"
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Example

See

The following macro copies the full path of the current file to the clipboard for
later use:

Path2clip := Arg Curfile Copy

Arg, Copy, Curdate, Curday, Curfilenam, Curfileext, Curtime

Curfileext

Key Unassigned
The Curfileext macro types the filename extension of the current file. This macro
is redefined each time you switch to a new file.

Definition curfileext := "extension"

Example The following macro copies the base name plus the extension of the current file to
the clipboard for later use:
Filename2clip := Arg Curfilenam Curfileext Copy

See Arg, Copy, Curdate, Curday, Curfile, Curfilenam, Curtime

Curfilenam

Key Unassigned
The Curfilenam macro types the base name of the current file. This macro is rede-
fined each time you switch to a new file.

Definition curfilenam := "basename"
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Example

See

The following macro copies the base name of the current file to the clipboard for
later use:

Name2clip := Arg Curfilenam Copy

Arg, Copy, Curdate, Curday, Curfile, Curfileext, Curtime

Mgreplist

Key

Definition

See

Unassigned

The special PWB macro Mgreplist is used by the Find and Replace commands on
the Search menu, Mgrep, Mreplace, and Mreplaceall to specify the list of files to
search.

When you create a list of files to search using the Files button in either the Find or
Replace dialog box, PWB redefines the Mgreplist macro with the specified list of
files.

To see the current list of files, choose the Files button in the Replace dialog box.
You can change the list in this dialog box, and either choose OK to perform the
find-and-replace operation, or choose Cancel to cancel the replace and accept the
changes to Mgreplist.

You can also insert the definition of Mgreplist into the current file by using the
phrase: Arg Meta Mgreplist Tell (ALT+A F9 Mgreplist CTRL+T).

You can edit the macro, then redefine it by using the Assign function (ALT+=).
Mgreplist:= "list"

list Space-separated list of filenames

The filenames can use the operating-system wildcards (* and ?), and can use
environment-variable specifiers. Note that backslashes (\) must be doubled in the
macro string.

Assign, Tell, Mgrep, Mreplace, Mreplaceall
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Restart

Key

Update

Unassigned

In PWB 1.x, the special PWB macro Restart is executed whenever PWB returns
from a shell, build, or other external operation.

In PWB 2.00, the Restart macro is never executed automatically and has no
special meaning; it is an ordinary macro.

_pwbarrange

Key

Definition

ALT+F5

Window menu, Arrange command

The _pwbarrange macro arranges all unminimized windows on the desktop. The
following illustration shows a typical desktop after execution of _pwbarrange:

—[ 51— Help

—L[ 31

f[[Z]
|\

—[ 4]—— Build Results

Source C
Source B
Source A

Figure 7.1 Arranged Windows

_pwbarrange:=cancel arg arrangewindow <

Cancel
Establishes a uniform “ground state” by canceling any selection or argument.
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Arg Arrangewindow
Arranges all unminimized windows on the desktop.
<

Restores the function’s prompt (if any). By default, function prompts are
suppressed while a macro is running.

See Arrangewindow

_pwhboxmode

Key Unassigned

Menu Edit menu, Box Mode command

The _pwbboxmode macro sets the selection mode to box selection mode.

Definition _pwbboxmode := :>more selmode ->more selmode
:>more
Defines the label more.
Selmode

Advances to the next selection mode.

->more
Branches to the label more if Selmode returns false.

The Selmode function advances the selection mode from box, to stream, to line.
Selmode returns true when the mode is stream mode. The macro executes the
Selmode function until it returns true (sets stream mode), then advances the selec-
tion mode once to set box selection mode.

See Enterselmode, Selmode
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_pwbbuild

Key

Definition

See

Unassigned

Project menu, Build command

The _pwbbuild macro builds the “all” target of the current PWB project. The
“all” pseudotarget in a PWB project lists all the targets in the project.

For non-PWB projects, _pwbbuild builds the targets that were last specified
by using the Build Target command from the Project menu. PWB redefines
_pwbbuild each time you use Build Target. If no target has been specified,
NMAKE builds the first target listed in the project makefile.

_pwbbuild := cancel arg "all" compile <

Cancel

Establishes a uniform “ground state” by cancelling any selection or argument.
Arg "all" Compile

Builds the a11 pseudotarget in the current project.
<

Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.

Arg, Cancel, Compile

_ pwhbcancelbuild

Key

Definition

Unassigned

Project menu, Cancel Build command

The _pwbcancelbuild macro terminates the current background build or compile
and flushes any queued build operations.
_pwhbcancelbuild := cancel arg meta compile

Cancel
Establishes a uniform “ground state” by canceling any selection or argument.
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See

Arg Meta Compile
Terminates the background build process.

Arg, Cancel, Compile, Meta

_pwhcancelprint

Key

Definition

See

Unassigned

The _pwbcancelprint macro terminates all background print operations.

_pwbcancelprint := cancel arg meta print

Cancel
Establishes a uniform “ground state” by canceling any selection or argument.

Arg Meta Print
Terminate background print operations.

Arg, Cancel, Meta, Print

_pwhcancelsearch

Key

Menu

Definition

Unassigned

Search menu, Cancel Search command

The _pwbcancelsearch macro cancels the current background search. PWB per-
forms logged searches in the background under multithreaded environments.

_pwbcancelsearch := cancel cancelsearch <

Cancel
Establishes a uniform “ground state” by canceling any selection or argument.

Cancelsearch
Cancels the current background search.
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See

<

Restores the function’s prompt (if any). By default, function prompts are
suppressed while a macro is running.

Cancel, Cancelsearch, Logsearch

_pwhcascade

Key

Definition

F5

Window menu, Cascade command

The _pwbcascade macro arranges all unminimized windows in cascaded fashion
so that all of their titles are visible. Up to 16 unminimized windows can be
cascaded.

—[ 31— D:\C70A\SOURCENSAMPLES\PWBTUTORNCOUNTCH.C —————
—[ 21— D:\C?0\SOURCENSAMPLES\NPWBTUTORNCOUNTBUF .C ———————
1=[ 1]=————— D:\C7OO\SOURCENSAMPLESN\PWBTUTORNCOUNT.C ==|1|T
/7 COUNT.C - Generate text statistics for text file. 1}

File Edit Search Project Run Options Browse Window Help

s7 Multimodule example program used in the PWB tutorial.
Ve

#tinclude <stdio.h>
ttinclude <string.h>
#tinclude “count.h"

/s Conditional operator prevents divide by zero
#tdef ine NONZERO(wal) (val 7 val : 1)

ss Vowels per syllable in typical English text
#tdef ine FACTOR 1.1

char Buffer[BUFFSIZE]:

long Bytes =0
long Characters = O;
long uurds = 0;

Fi

gure 7.2 Cascaded Windows

_pwbcascade := cancel arrangewindow <

Cancel

Establishes a uniform “ground state” by canceling any selection or argument.
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Arrangewindow
Cascades all unminimized windows.

<
Restores the function’s prompt (if any). By default, function prompts are
suppressed while a macro is running.

See Arrangewindow, Cancel
_pwhclear
Key DEL
Menu Edit menu, Delete command
The _pwbclear macro removes the selected text from the file. If there is no selec-
tion, PWB removes the current line.
The selection or line is not copied to the clipboard. It can be recovered only by
using the Undo command from the Edit menu or Undo (ALT+BKSP).
Definition _pwbclear := meta delete
Meta Delete
Removes the selection or the current line from the file without modifying the
clipboard.
See Delete, Meta
_pwhcloseall
Key Unassigned
Menu ‘Window menu, Close All command
The _pwbcloseall macro closes all open windows.
Definition _pwbcloseall := cancel arg arg meta window <
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See

Cancel
Establishes a uniform “ground state” by canceling any selection or argument.

Arg Arg Meta Window
Closes all windows.

<
Restores the function’s prompt (if any). By default, function prompts are
suppressed while a macro is running.

Arg, Cancel, Meta, Window

_pwhbclosefile

Key

Menu

Definition

See

Unassigned

File menu, Close command

The _pwbclosefile macro closes the current file. If no files remain in the win-
dow’s file history, the window is closed.

_pwbclosefile := cancel closefile <
Cancel
Establishes a uniform “ground state” by canceling any selection or argument.

Closefile
Closes the current file.

<
Restores the function’s prompt (if any). By default, function prompts are
suppressed while a macro is running.

Cancel, Closefile

_pwhbcloseproject

Key

Unassigned

Project menu, Close Project command
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Definition

See

The _ pwbcloseproject macro closes the current project.

_pwbcloseproject := cancel arg arg project <

Cancel

Establishes a uniform “ground state” by canceling any selection or argument.
Arg Arg Project

Closes the current project.
<

Restores the function’s prompt (if any). By default, function prompts are sup-
pressed within a macro.

Arg, Cancel, Project

_pwbcompile

Key

Definition

See

Unassigned

Project menu, Compile File command

The _pwbcompile macro compiles the current file.

_pwbcompile := cancel arg compile <
Cancel
Establishes a uniform “ground state” by canceling any selection or argument.
Arg Compile
Compiles the current file.
<
Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.

Arg, Cancel, Compile
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_ pwhgotomatch

Key Unassigned

Menu Search menu, Goto Match command

The _pwbgotomatch macro sets the match listed at the current location in the
Search Results pseudofile as the current match and moves the cursor to the loca-
tion specified by that match.

Definition _pwbgotomatch := cancel arg arg nextsearch <
Cancel
Establishes a uniform “ground state” by canceling any selection or argument.

Arg Arg Nextsearch
Goes to the current match.

<
Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.

See Arg, Cancel, Nextsearch

_pwbhelpnl

The _ pwbhelpnl macro displays a message indicating the Help extension is not
loaded. The Help keys are assigned this macro until the Help extension is loaded.

Definition _pwbhelpnl := cancel arg "OnLine Help Not Loaded" message

Cancel
Establishes a uniform “ground state” by canceling any selection or argument.

Arg "OnLine Help Not Loaded" Message
Displays the message on the status bar.

See Arg, Cancel, Load, Message
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_pwhbhelp_again

Key

Definition

See

Unassigned

Help menu, Next command

The _pwbhelp_again displays the next occurrence of the last topic for which you
requested Help. If no other occurrences of the topic are defined in the open files,
PWB redisplays the current topic.

The topic that PWB looks up when you use this command is displayed after the
Next command on the Help menu, as follows:

Next: ropic key

topic  Topic string used for the command.
key  Current key assignment for _pwbhelp_again (if any).

_pwbhelp_again:=cancel arg pwbhelp.pwbhelpnext <
Cancel

Establishes a uniform “ground state” by canceling any selection or argument.
Arg

Sets the Arg prefix for the Pwbhelpnext function.

Pwbhelp.
Specifies that the function is the PWBHELP extension function.

Pwbhelpnext
Displays the next occurrence of the previously requested topic.

<
Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.

Pwbhelpnext
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_pwbhelp_back

Key

Definition

See

ALT+F1

The _pwbhelp_back macro displays the previously viewed Help topic. Up to 20
topics are kept in the Help backtrace list.

_pwbhelp_back:=cancel meta pwbhelp.pwbhelpnext <

Cancel
Establishes a uniform “ground state” by canceling any selection or argument.

Meta
Sets the meta prefix for the function.

Pwbhelp.
Specifies that the function is the PWBHELP extension function.

Pwbhelpnext
Displays the previously viewed Help topic.

<
Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.

Pwbhelpnext

_pwbhelp_contents

Key

Definition

SHIFT+F1

Help menu, Contents command

The _pwbhelp_ contents macro opens the Help window and displays the top-
level contents of the Help system.

Within the Help system, most Help topics have a Contents button at the top of the
window. This button also takes you to the top-level contents.
_pwbhelp_contents:=cancel arg "advisor.hlp'h.contents" pwbhelp.pwbhelp <

Cancel
Establishes a uniform “ground state” by canceling any selection or argument.
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Arg "advisor.hlp'h.contents"
Defines a text argument with the topic name for the general table of contents.

Pwbhelp.
Specifies that the function is the PWBHELP extension function.

Pwbhelp
Looks up the topic h.contents inthe ADVISOR.HLP Help file.

<
Restores the function’s prompt (if any). By default, function prompts are
suppressed while a macro is running.

See Pwbhelp

_pwbhelp_context
Key F1

Menu Help menu, Topic command

The _pwbhelp_ context macro looks up Help on the topic at the cursor, the cur-
rent selection, or the specified text argument.

Definition _pwbhelp_context:=arg pwbhelp.pwbhelp <

Arg
Sets the Arg prefix for the Pwbhelp function.

Pwbhelp.
Specifies that the function is the PWBHELP extension function.

Pwbhelp
Displays Help on the topic at the cursor. When text is selected, displays Help
on the selected text. When you have entered an argument in the Text Argument
dialog box, displays Help on the topic specified by the text argument.

<

Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.

See Pwbhelp
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_pwbhelp_general

Key Unassigned

Menu Help menu, Help on Help command

The _pwbhelp_general macro opens the Help window and displays information
about using the Help system.

Definition _pwbhelp_general:=cancel arg "advisor.hlp'h.default" pwbhelp.pwbhelp <

Cancel
Establishes a uniform “ground state” by canceling any selection or argument.

Arg "advisor.hlp'h.default"
Defines a text argument with the topic name for default Help.

Pwbhelp.
Specifies that the function is the PWBHELP extension function.

Pwbhelp
Looks up the topic “h.default” in the ADVISOR.HLP Help file.

<
Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.

See Pwbhelp

_pwhbhelp_index
Key Unassigned

Menu Help menu, Index command

The _pwbhelp_index macro opens the Help window and displays the top-level
table of indexes in the Help system.

Within the Help system, most Help topics have an Index button at the top of the
window. This button also takes you to the top-level table of indexes.

Definition _pwbhelp_index:=cancel arg "advisor.hlp!h.index" pwbhelp.pwbhelp <
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See

Cancel
Establishes a uniform “ground state” by canceling any selection or argument.

Arg "advisor.hlp'h.index"
Defines a text argument with the topic name for the Help index.

Pwbhelp.
Specifies that the function is the PWBHELP extension function.

Pwbhelp
Looks up the topic “h.index” in the ADVISOR.HLP Help file.

<
Restores the function’s prompt (if any). By default, function prompts are
suppressed while a macro is running.

Pwbhelp

_pwbhelp_searchres

Key

Definition

See

Unassigned

Help menu, Search Results command

The _pwbhelp_searchres macro opens the Help window and displays the list of
matches found during the last global Help search.

_pwbhelp_searchres:=cancel pwbhelp.pwbhelpsearch <
Cancel
Establishes a uniform “ground state” by canceling any selection or argument.

Pwbhelp.
Specifies that the function is the PWBHELP extension function.

Pwbhelpsearch
Opens the Help window and displays the results of the last global Help search.

<
Restores the function’s prompt (if any). By default, function prompts are
suppressed while a macro is running.

Pwbhelpsearch
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_pwblinemode

Key

Menu

Definition

See

Unassigned

Edit menu, Line Mode command

The _pwblinemode macro sets the selection mode to line selection mode.

_pwblinemode := :>more selmode ->more selmode selmode

:>more
Defines the label more.

Selmode
Advances to the next selection mode.

->more
Branches to the label more if Selmode returns false.

The Selmode function advances the selection mode from box, to stream, to line.
Selmode returns true when the mode is stream mode. The macro executes the
Selmode function until it returns true (sets stream mode), then advances the selec-
tion mode twice to set line selection mode.

Enterselmode, Selmode

_pwblogsearch

Key

Definition

Unassigned

Search menu, Log command
The _pwblogsearch macro toggles search logging on and off.

When search logging is turned on, PWB displays a bullet next to the Log
command on the Search menu. The Next Match command executes the
_pwbnextlogmatch macro, and the Previous Match command executes
the _pwbpreviouslogmatch macro. When search logging is turned off, no
bullet appears and the Next Match and Previous Match commands execute
_pwbnextmatch and _pwbpreviousmatch.

_pwblogsearch := cancel logsearch <
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See

Cancel
Establishes a uniform “ground state” by canceling any selection or argument.

Logsearch
Toggles the logging of search results on and off.

<
Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.

Cancel, Logsearch

_ pwbmaximize

Key

Definition

See

CTRL+F10

Window menu, Maximize command

The _pwbmaximize macro enlarges the active window to its largest possible size,
showing only the window, the menu bar, and the status bar on the PWB screen.

_pwbmaximize := cancel maximize <

Cancel
Establishes a uniform “ground state” by canceling any selection or argument.

Maximize
Enlarges the active window to full size.

<
Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.

Cancel, Minimize
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_ pwbminimize

Key

Menu

Definition

CTRL+F9

Window menu, Minimize command

The _pwbminimize macro minimizes the active window, reducing the window to
an icon. The following illustration shows an open Source window and two icons:

File Edit Search Project Run Options Browse Window Help

a=[ 1]=———— D:\C?00\SOURCENSAMPLES\PWBTUTORNCOUNT.C
s7 COUNT.C - Generate text statistics for text file.

s Multimodule example program used in the PWB tutorial.
v’/

ttinclude <stdio.h>
t#tinclude <string.h>
ttinclude “count.h”

/s Conditional operator prevents divide by zero
fidef ine NONZERD(val) (val 7 val : 1)

»s7 Uowels per syllable in typical English text
#def ine FACTOR 1.1

2 H

OUNTBUF . CREICOUNTCH . Cj
<F1=Help> <Alt=Menu> <F6=Window>

N 00001 .003,

To restore a window to its original size, double-click in the box or use the Restore

command (CTRL+F5) on the Window menu.

_pwbminimize := cancel minimize <

Cancel

Establishes a uniform “ground state” by canceling any selection or argument.

Minimize
Shrinks the window to an icon.
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See

<
Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.

Cancel, Maximize, Minimize

_pwbmove

Key

Menu

Definition

See

CTRL+F7

Window menu, Move command

The _pwbmeove macro starts window-moving mode for the active window. In
window-moving mode, you can only do the following:

Action Key
Move up one row UP
Move down one row DOWN
Move left one column LEFT
Move right one column RIGHT
Accept the new position ENTER
Cancel the move ESC

To move the window in larger increments, you can use a numeric argument with
the Movewindow function.

_pwbmove := cancel movewindow <
Cancel
Establishes a uniform “ground state” by canceling any selection or argument.

Movewindow
Starts window-moving mode.

<
Restores the function’s prompt (if any). By default, function prompts are
suppressed while a macro is running.

Arrangewindow, Cancel, Maximize, Minimize, Resize
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_pwbnewfile

Key

Definition

See

Unassigned

File menu, New command

The _pwbnewfile macro creates a new pseudofile.
New pseudofiles are given a unique name of the form:
<Untitled.nnn>Untitled.nnn

where <nnn> is a three-digit number starting with 001 at the beginning of each
PWB session. The window title shows Untitled.nnn. The file may be referred to
by the name <Untitled.nnn>.

When the Newwindow switch is set to yes, or the active window is a PWB win-
dow, a new window is opened for the file. Otherwise, the file is opened in the
active window, and the previous file is placed in the window’s file history.

_pwbnewfile := cancel newfile <
Cancel
Establishes a uniform “ground state” by canceling any selection or argument.

Newfile
Creates a new untitled pseudofile.

<
Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.

Cancel, Setfile

_ pwbnewwindow

Key

Unassigned

Window menu, New command

The _pwbnewwindow macro opens a new window, which shows the current file.
The new window has the complete file history as the original window.
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Definition

See

_pwbnewwindow := cancel arg window

Cancel
Establishes a uniform “ground state” by canceling any selection or argument.

Arg Window
Opens a new window on the current file

Arg, Cancel, Window

_pwhnextfile

Key

Definition

See

Unassigned

File menu, Next command

The _ pwbnextfile macro moves to the next file in the list of files specified on the
PWB command line. If no more files remain in the list, this macro ends the PWB
session.

When the Newwindow switch is set to yes, or the active window is a PWB win-
dow, a new window is opened for the file. Otherwise, the file is opened in the
active window, and the previous file is placed in the window’s file history.

_pwbnextfile := cancel exit <
Cancel

Establishes a uniform “ground state” by canceling any selection or argument.
Exit

Moves to the next file specified on the command line.

<
Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.

Exit, Askexit, Cancel, PWB Command Line
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_pwhbnextlogmatch

Key

Definition

See

SHIFT+CTRL+F3

Search menu, Next Match command

The _pwbnextlogmatch macro advances the cursor to the next match listed in the
Search Results pseudofile.

The Next Match command on the Search menu executes this macro when search
logzing is turned on. When search logging is turned off, Next Match executes the
_pwbnextmatch macro.

_pwbnextlogmatch := cancel nextsearch <

Cancel
Establishes a uniform “ground state” by canceling any selection or argument.

Nextsearch
Advances to the next match in Search Results.

<
Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.

Cancel, Nextsearch

_ pwbnextmatch

Key

Definition

Unassigned

Search menu, Next Match command

The _pwbnextmatch macro searches forward in the file using the last search pat-
tern and options. The search options are Match Case, Wrap Around, and Regular
Expression.

The Next Match command on the Search menu executes this macro when search
logging is turned off. When search logging is turned on, Next Match executes the
_pwbnextlogmatch macro.

_pwbnextmatch := cancel psearch <
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Cancel
Establishes a uniform “ground state” by canceling any selection or argument.

Psearch
Searches forward in the file for the next occurrence of the last search string or
pattern.

<

Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.

See Cancel, Psearch

_pwbnextmsg

Key SHIFT+F3

Menu Project menu, Next Error command

The _pwbnextmsg macro moves the cursor to the next message in Build Results.

Definition _pwbnextmsg := cancel nextmsg <
Cancel
Establishes a uniform “ground state” by canceling any selection or argument.
Nextmsg

Goes to the next message in Build Results.

<

Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.

See Cancel, Nextmsg

_pwbpreviouslogmatch

Key SHIFT+CTRL+F4

Menu Search menu, Previous Match command
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The _pwbpreviouslogmatch macro moves the cursor to the previous match listed
in the Search Results pseudofile.

The Previous Match command on the Search menu executes this macro when
search logging is turned on. When search logging is turned off, Previous Match
executes the _ pwbpreviousmatch macro.

Definition _pwbpreviouslogmatch := cancel arg "-1" nextsearch <
Cancel
Establishes a uniform “ground state” by canceling any selection or argument.

Arg "-1" Nextsearch
Moves to the previous match listed in Search Results.

<
Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.

See Arg, Cancel, Nextsearch

_ pwbpreviousmatch

Key Unassigned

Menu Search menu, Previous Match command

The _pwbpreviousmatch macro searches backward in the file, using the last
search pattern and options. The search options are Match Case, Wrap Around,
and Regular Expression.

The Previous Match command on the Search menu executes this macro when
search logging is turned off. When search logging is turned on, Previous Match
executes the _ pwbpreviouslogmatch macro.

Definition _pwbpreviousmatch := cancel msearch <

Cancel
Establishes a uniform “ground state” by canceling any selection or argument.

Msearch
Searches backward in the file for the last search string or pattern.
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See

<
Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.

Cancel, Msearch

_pwhbprevmsg

Key

Definition

See

SHIFT+F4

Project menu, Previous Error command

The _pwbprevmsg macro moves the cursor to the previous message in the Build
Results pseudofile.

_pwbprevmsg := cancel arg "-1" nextmsg <
Cancel
Establishes a uniform “ground state” by canceling any selection or argument.

Arg "-1" Nextmsg
Goes to the previous message in Build Results.

<
Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.

Arg, Cancel, Nextmsg

_pwbprevwindow

Key

Definition

SHIFT+F6
The _pwbprevwindow macro moves the focus to the previous window. That is,

PWB sets the previously active window as the active window. This action moves
among the open windows in the reverse order of Selwindow (F6).

_pwbprevwindow:=cancel meta selwindow <
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See

Cancel
Establishes a uniform “ground state” by canceling any selection or argument.

Meta Selwindow
Moves the focus to the previous window.

<
Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.

Cancel, Meta, Selwindow

_pwbquit
Key

Definition

See

ALT+F4

File menu, Exit command

The _pwbquit macro leaves PWB immediately. Any specified files on the PWB
command line that have not been opened are ignored.

_pwbquit := cancel arg exit <
Cancel

Establishes a uniform “ground state” by canceling any selection or argument.
Arg Exit

Leaves PWB.

<
Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.

Arg, Askexit, Cancel, Exit, Savescreen
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_pwbrebuild

Key

Definition

See

Unassigned

Project menu, Rebuild All command
The _pwbrebuild macro forces a rebuild of everything in the current project.

For non-PWB projects, _ pwbrebuild rebuilds the targets that were last specified
by using the Build Target command on the Project menu. PWB redefines
_pwbrebuild each time you use Build Target. If no target has been specified,
NMAKE rebuilds the first target listed in the project makefile.

_pwbrebuild := cancel arg meta "all" compile <
Cancel

Establishes a uniform “ground state” by canceling any selection or argument.
Arg Meta "all" Compile

Rebuilds the a11 pseudotarget.

<
Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running. ’

Arg, Cancel, Compile, Meta

_pwbrecord

Key

Menu

Definition

Unassigned

Edit menu, Record On command

The _pwbrecord macro toggles macro recording on and off. If you have not set
the recorded macro name and key, PWB displays the Set Macro Record dialog
box so you can set them. Execute _ pwbrecord again to start recording.

_pwbrecord := cancel record <

Cancel
Establishes a uniform “ground state” by canceling any selection or argument.
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Record
Toggles macro recording on and off.

<
Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.

See Cancel, Record
_pwhbredo
Key Unassigned
Menu Edit menu, Redo command
The _pwbredo macro restores the last modification that was reversed using Edit
Undo or Undo (ALT+BKSP).
Definition _pwbredo := cancel meta undo <
Cancel
Establishes a uniform “ground state” by canceling any selection or argument.
Meta Undo
Restores the last “undone” modification.
<
Restores the function’s prompt (if any). By default, function prompts are sup-
pressed while a macro is running.
See Cancel, Meta, Undo
_pwhrepeat
Key Unassigned
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